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Introduction
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Topics covered in this help file
Getting Started

Installing BreezeBrowser Pro

Reference section
e Main View
Thumbnail View
Slideshow
Comparing images
Web galleries
Printing
Proofs
Summary of keyboard shortcuts
Release Notes

Where to find more information
If you are having problems please read the relevant section in these help pages. Many of the dialogs in
BreezeBrowser Pro have context sensitive help which you can display by pressing the F1 key.

Often a problem has already been reported and has been fixed in the latest version. Please check that
you are running the latest version by selecting "Check for updates” from the "Help" menu.

Please also check the support pages and FAQs (frequently asked questions) on our website.

You can also send questions to our email support: support@breezesys.com
Please include as much detail as possible about your problem including the version of BreezeBrowser
Pro and the version of Windows you are using.

Viewing HEIF images from mobile devices

The following Microsoft extensions to Windows need to be installed in order to view HEIF images from
mobile devices:

1. HEIF Image Extensions - this is free and can be downloaded from the Microsoft Store
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2. HEVC Video Extensions - this can be purchased for a small fee (approx US $1) from the Microsoft
Store

Please note that only 8-bit HEIF images with a .heif or .heic file extension are currently supported by
the Microsoft HEIF and HEIC extensions.

10-bit HEIF images from some recent cameras (e.g. Canon EOS R5 and Canon EOS 1DX Mark III)
are not supported.

1.1 Installing and registering BreezeBrowser Pro

1.1.1 Installing

The latest copy of BreezeBrowser Pro can be downloaded from www.breezesys.com. If you are
upgrading your copy of BreezeBrowser Pro please uninstall the old version first and then install the
new version. You shouldn't need to re-enter your registration code, but it is a good idea to keep a copy
just in case. Please remember to take a copy of your HTML templates if you have edited them or
added new ones.

To install BreezeBrowser Pro simply run the setup program and follow the on-screen instructions.
BreezeBrowser Pro can be uninstalled using the standard Windows "Add/Remove Programs" dialog
available from "Control Panel".

1.1.2 Registering
Evaluation Period
The unregistered version of BreezeBrowser Pro can be evaluated for up to 15 days and is fully
functional during the evaluation period. At the end of the evaluation period only the first 12 images in a

directory will be loaded and you must purchase a license from the Breeze System's website in order to
continue using BreezeBrowser Pro.

Entering your registration code

If you have already purchased BreezeBrowser Pro and have received your registration email please
run BreezeBrowser Pro and enter your name and registration code when the registration dialog is
displayed. Then press the "Register" button.

Please enter both your name and registration code exactly as they appear in your registration email.
You may find it easier to avoid mistakes by cutting and pasting your details from the registration email.
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BreezeBrowser Pro Registration ['5__<|

Evaluation copy, 15 days remaining.

[f you have already purchased BreezeBrowser Pro and have received
yaLr registration detailz pleaze enter them below and press the
"Reaqizter'’ buttan.

M ame:
|Ehris Breeze |

Code:
| kM 1BFR-Dw/0AE C-AY QU 3w -FOVT 40 -0FFECR-347 3ES-TAL-NC |

Fleaze press the "Bup Onling' button ta wizit the Breeze Systems
webzite to purchaze a copy of BreezeBrowser Pro.

[ Buy Online ][ Help ] [ R eqister l [ Evaluate ]

To purchase a licence for BreezeBrowser Pro please visit our website:
http://www.breezesys.com/BreezeBrowser or press the "Buy Online" button to go directly to the online
ordering web page. You will be sent an email containing your registration details when your payment
has been received.

You can also display the registration dialog above by clicking on the "Help" menu and selecting
"Register..." from the menu:

X3 BreezeBrowser Pro - H:320013200105 Bath\CR'
File Edit Mew Tools

oy ggg Ea i Contents
|7 Gee Ml (B ceing starked

Wisit website
Check For updates
Buy anline

Abouk BreezeBrowser Pra.,..,

Click on "About BreezeBrowser Pro..." to display the version of BreezeBrowser you are running, your
registration status and the date your registration key was purchased.
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1.1.3 Upgrading to the latest version

Getting the latest release

The latest copy of BreezeBrowser Pro can be downloaded from www.breezesys.com. You can check
to see if you are running the latest version by running BreezeBrowser Pro and selecting "Check for
updates” from the help menu.

Please note: Your purchase entitles you to free upgrades to any version of BreezeBrowser Pro
released within one year of your original purchase. If you wish to use a version released more than one
year after your original purchase you will need to purchase an upgrade license from the Breeze
Systems' website.

Click on the Help menu and select "About BreezeBrowser Pro..." to display the version of
BreezeBrowser you are running, your registration status and the date your registration key was
purchased.

Upgrading

If you are upgrading your copy of BreezeBrowser Pro please uninstall the old version first and then
install the new version. You shouldn't need to re-enter your registration code, but it is a good idea to
keep a copy just in case.

1.2  Getting Started
Viewing files
BreezeBrowser Pro can display large images in main view, a series of smaller thumbnails in thumbnail
view or a combination of both in filmstrip view.

T frecestrrener Fra - 00100 G Sel HOHW OSEDLCHW - [JE a1 18/] BT
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Main View

You can also display your images full screen using slideshowor view them actual size in the View
Actual Image window.

Up to four images can be displayed together to help select the best shot in the Image Comparison
Window.

Right click on an image and select "Image Properties" to display a summary of the camera settings
used to take the picture.

Rotating images and adding comments
Click on the "rotate left" or "rotate right" buttons in the toolbar to rotate your images. BreezeBrowser
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Pro rotates JPEG images with no loss of image quality.

Right click on an image and select "Edit comments" to add a comment to an image. More detailed
captions can be added using the IPTC editor (IPTC is a standard used by press photographers to
store information like location, copyright and headlines in images).

Organizing files

Drag and drop images in the thumbnail view to organize them into different folders.

Use the batch rename function to rename your images using shooting data stored in each image such
as the date the picture was taken.

Creating web galleries

Select some images by clicking on them in the thumbnail view. Hold the Ctrl key down to select more
than one image or the shift key to select a group of images. Then right click on one of the selected
images and select "HTML..." from the menu to create HTML galleries of your pictures for your website.
BreezeBrowser Pro comes with many predefined gallery styles which you can use or you can write
your own templates.

Support for raw files

Versions of BreezeBrowser Pro up to version 1.9.8.10 support raw conversion for a number of different
camera models. More recent versions of BreezeBrowser Pro don't support raw conversion because
camera manufacturers no longer supply libraries for converting raw files from their cameras.
BreezeBrowser Pro displays raw files using the JPEG preview image embedded in the raw file when
available.

If you wish to continue using BreezeBrowser Pro to convert raw files from older camera models you
can install BreezeBrowser Pro v1.9.8.10 in a separate folder and run it alongside the latest release.
BreezeBrowser Pro v1.9.8.10 can be downloaded from the upgrades page. This will install
BreezeBrowser Pro v1.9.8.10 in a separate folder (C:\Program Files
(x86)\BreezeSys\BreezeBrowserPro v1.9.8.10) so that it can be run alongside the latest version of
BreezeBrowser Pro.

You can still use BreezeBrowser Pro to view and organize your raw files and then convert them in your
favorite image editor.

Printing contact sheets

Print attractive contact sheets straight to your printer or print to file and get them printed by your photo
lab.

Use page setup to define the layout of the contact sheet and to add captions under each thumbnail.

Creating proofs

The proofs function lets you batch process groups of files and automatically resize, level, sharpen, add
watermarks or captions etc. Use proofs to prepare sets of images for printing or to convert from one
image format to another.

Reference section

This section contains more detailed information about how to use and setup BreezeBrowser Pro
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2.1

Main View

3 BreezeBrowser Pro - H:120011200105 Bath\CRW_0180.CRW - [78 of 167] HQ M=
File Edit View Tools Help

2 W & e ok G T—

i ol kal : " [ Convert... | |Thumbrails]

i ' s [ Previous ][ Mext ]
; - i []1Tagged

(i,
J I I TR
Heont b e Summar_l,l Full Details
: BN

A : 2001:052912:2900
I o e e L O ] 13-35rmrm =2 35mm
.'Tﬁ'fﬁ' = % __:.: == T B T 1490 zec, (435
= ) B T e ,h!h S Mode: Manual
B TETE 2= Metering:

-',a =1 " & ' Al g A Centerweighted average
S Ly |50: 100
= X s AF mode: &l Servo AF

| ! Dirive: Continuous: frame
o 1
5 White balance: &uto

Flazh: OIff

File size: 3,27 3kKE

Image zize; 2160 % 1440

| Pultney Bridge, Bath

EIIIEII,I'IZIS,I'29 12:29:00, 19 ko 35mm @ 35mm, 1/90sec F9.5, Exp:Manual, 150 100, AF:AL Servo AF, RGE: 166,130,209

The Main View shows the current image together with an EXIF summary, histogram display and
comments. Buttons are provided for the most common commands and these can also be accessed
using the menus, the toolbar or by right clicking on the image. The window can be resized and the
image is automatically resized to make the best use of the display area. Right-clicking on the image
will display an pop menu of commands. Double-clicking on the image switches to the Thumbnail View.

You can also change the display using one of the following keyboard shortcuts:

Ctrl+M - switch to thumbnail mode using the currently selected thumbnail size

Ctrl+X - switch to thumbnail mode and display extra large thumbnails

Ctrl+L - switch to thumbnail mode and display large thumbnails

Ctrl+T - switch to thumbnail mode and display small thumbnails

Ctrl+Tab - toggle between displaying the image filling the main view and the display shown above
Escape - toggles between main view and thumbnail view

Right click on the histogram to select display options and to switch between linear and logarithmic
display.
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211

212

2.1.3

214

Navigation

Click on the 'Next' and 'Previous' buttons or the left and right arrows on the toolbar to display the next
or previous image. The filename of the image being displayed is shown in the drop-down list on the
toolbar and also in the window's title bar. You can go to an image directly by selecting it from the
drop-down list.

You can also step backwards and forwards through the images using the mouse wheel or the
keyboard cursor keys. Holding the SHIFT key down and turning the mouse wheel steps forwards and
backwards twenty images.

A slideshow which automatically cycles through the images can be selected from the 'View' menu

Rotating images

Click on the '-' button with the red arrow to rotate the image anti-clockwise and the '+' button with the
green arrow to rotate clockwise. All images are rotated without loss of picture data and all EXIF
information is preserved. This includes JPEG images and the small JPEG thumbnails embedded in
the EXIF data of some images.

You can also rotate images by pressing the Ctrl key and using the mouse wheel, the keyboard cursor
keys or clicking on the rotate buttons in the toolbar.

NOTES:

1. If you have a large number of images to rotate you can rotate them all in one go using the
Thumbnail View.

2. TIFFs are rotated by reading in the image data, rotating it and writing it back as an uncompressed
TIFF even if the original image was compressed. Any EXIF data in the TIFF file will be preserved
where possible, but additional information may be lost.

3. The rotation of PSD, PNG and JPEG 2000 images is not supported in this version

Auto rotate JPEGs

Some digital cameras have a sensor which detects the orientation of the camera when the picture is
taken and stores this information in the EXIF data contained in the image. Use the "Auto Rotate
JPEGSs" option under the "Tools" menu to automatically rotate JPEG images to match the EXIF
orientation information. JPEG images are rotated losslessly and there is no loss of image quality when
using this function.

BreezeBrowser Pro is also able to view and rotate JPEGs using the orientation information contained
in the EXIF data (this feature can be enabled in Preferences). Rotating JPEGs using the EXIF
orientation information is much faster than rotating the image data.

Please Note: Not all image editors can read the EXIF orientation and so images rotated this way in
BreezeBrowser Pro may appear in their original, unrotated orientation when edited.

IPTC data

BreezeBrowser Pro can edit or add IPTC data to the following types of images: JPEG, TIFF, AVI
(movie files), JPEG 2000, PNG, Photoshop PSD, Nikon raw files and Canon Raw files.

Please see the section on IPTC data for more details.
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2.1.5 Comments

The comments stored in the image are shown at the bottom of the Main View window. Select 'Edit
Comments...' from the 'Edit' menu to add or edit the comments. The same comment can be applied to
all images in the directory by clicking on the 'Apply to all' button in the 'Edit Comments' dialog. In
thumbnail mode the comment is applied to the selected images.

Tokens can be used to add information from the shooting data or IPTC data to a comment e.g. use
@time@ to insert the time the image was token, @iso@ for the 1SO setting, @model@ for the camera
model name, @IPTC_caption@ for the IPTC caption. This is particularly useful if you need to add
information from the shooting data to a batch of images. The tokens are the same as used for HTML
generation.

Note: To add data to an existing comment use @caption@ to copy the existing comment e.g. to prefix
existing comments with the time you could use "@time@: @caption@".

The default behavior is for BreezeBrowser Pro to use the EXIF UserComment tag to store comments,
but there is also an option to use the IPTC caption instead. This has the advantage that comments can
be added to any JPEG, TIFF or Canon raw file and are not limited to 256 characters. To select IPTC
captions in preference to EXIF comments see preference settings.

NOTES:

1. BreezeBrowser Pro does not use a database and all comments are stored within the images
themselves (in the EXIF data for JPEGs and the CIFF data for Canon raw files).

2. Comments in Canon images are limited to 256 characters. Images from other digital cameras
may only allow fewer characters e.g. Olympus images are limited to 118 characters.

3. BreezeBrowser Pro uses the EXIF UserComment tag to store comments. Some digital cameras
use the ImageDescription tag instead and BreezeBrowser Pro can use this if the UserComment
tag is not present.

4. BreezeBrowser Pro will only write comments to an image if it already contains an EXIF
UserComment or ImageDescription tag. This is in contrast to other applications which create a
new tag if necessary but this often has the side-effect of corrupting the MakerNote section of the
EXIF data. Comments can be added to any JPEG, TIFF or Canon raw file if IPTC captions are
selected in preference to EXIF comments.

5. BreezeBrowser Pro always writes comments using ASCII, but it is also able to read UNICODE
comments provided they consist of 16-bit ASCII characters.

2.1.6 Deleting images

Click on the 'Delete’ button to delete the current image. Depending on your preference settings the file
will either be moved to the Windows Recycle bin or to a subdirectory named 'Deleted’ under the
current directory.

NOTES:

1. A confirmation dialog is displayed before deleting images to avoid accidentally deleting important
images. The confirmation dialog can be disabled in the preference settings if required.

2. Hold the SHIFT key down and press Delete to delete images permanently. A confirmation dialog
will always be displayed because it is not possible to recover files once they have been
permanently deleted.

2.1.7 High quality display

Select "High Quality" from the "View" menu or type Ctrl+Q to switch to high quality display mode.
When this option is selected "HQ" is appended to the name of the file when it is displayed on the title
bar.

This uses high quality interpolation and sharpening to give a higher quality image. The sharpening is
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2.1.8

2.1.9

2.1.10

2.1.11

only applied to the displayed image and does not affect the original image.

The amount of sharpening applied in HQ mode can be set in preferences.

Focus point overlay

Right click on the image and select "Show Focus Points" to overlay the focus points used when the
picture was taken. Alternatively select "Show Focus Points" from the "View" menu. Active focus points
are shown in red and inactive ones in black.

Please note: This feature is available with images from Canon EOS DSLR cameras and some Nikon
DSLR cameras only (e.g. D3, D300, D200, D2X, D2Xs, D2H, D2Hs, D80). The focus points may not
be displayed correctly with images that have been edited as the size, cropping or orientation of the
image may have been changed and the focus point information may not be available in the shooting
data of the edited image.

Flashing highlights

Select "Show flashing highlights” from the "View" menu to display over-exposed areas by highlighting
them flashing on and off in black. The method of calculating the highlight values and the threshold at
which to start flashing them can be specified in the preference settings.

Black and white display

Select "View in Black and White" from the "View" menu or type Ctrl+W to toggle between normal color
display and black and white (grayscale) display. When this option is selected "B&W" is appended to
the name of the file displayed on the title bar.

When "Black and White" mode is selected images are displayed in grayscale in main view, view actual
image, slideshow and HTML page generation. The normal color image is used for thumbnail display
and printed output.

Timestamps

The "Tools->Timestamp" menu option changes the modification date and time of all images in a
directory to the date and time contained in the EXIF data. This option can also be used to make files
read-only to prevent accidentally overwriting original files when using an image editor.

NOTE: By default BreezeBrowser Pro preserves the file's modification date and time when rotating or
adding comments. It can also rotate, delete or comment read-only files (it makes them read/write,
modifies the file, restores the read-only flag and restores the modification date and time).

BreezeBrowser Pro can also edit the image capture time stored in the shooting data of JPEGs, TIFFs,
Canon raw files and Nikon raw files. This is useful if the camera's clock has been set incorrectly (or
you forgot to change it when daylight saving time changed) or when shooting with two cameras whose
clocks aren't accurately synchronized. To edit the image capture time select "Adjust Image
Date/Time..." from the tools menu and the dialog below will be displayed:
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x)

Adjust Image DatefTime

File: [MG_3342.PG
Current date and time: | 2004:10:24 22:12:51

Mew date; | 24/10/2004

Mew time: | 21:12:51 :

Adjuztment;
Back 0 days, 07:00:00

Ilpdate file timestamp with new date and time

|Ipdate ][ Cancel

Select the new date and time and the dialog will show the amount the capture time will be adjusted.
Click on the "Update" button to update just the current image. Click on the "Update All" image to adjust
all the images in the current folder by the same amount e.g. if the adjustment selected for the current
image is 5 minutes the capture times for all images in the folder will be advanced by 5 minutes. (In
thumbnail view this function will only update the currently selected images).

Select "Update file timestamp with new date and time" if you would like the file's creation time and
modification time to be updated in line with the new capture time.

Please take care when adjusting capture time of images because it isn't possible to undo this
operation.

Example: Two images were taken using a camera with the clock set one hour fast because the
photographer forgot to change the clock at the end of daylight saving time. The first image was taken
at 21:12:51 and the second at 21:15:05. The shooting data for the two images show they were taken at
22:12:51 and 22:15:05 respectively. To correct this select the two images in thumbnail view and select
"Adjust Image Date/Time..." from the tools menu. This will display the dialog above and show the
current date and time according to the shooting data for the first image. Change the "New time:" field
to the time the picture was actually taken, 21:12:51, and then press the "Update Selected" button. This
will adjust the shooting time back one hour for the two selected images. Image 1 will have its time
adjusted back one hour from 22:12:51 to 21:12:51. Image 2 will also have its time adjusted back one
hour from its current value of 22:15:05 to 21:15:05.

BreezeBrowser Pro only updates the date/time for images containing EXIF DateTime,
DateTimeOriginal or DateTimeDigitized tags. If the image contains two or more EXIF date/time tags
the oldest one i sused as the reference time. The new date/time is written to whichever EXIF data/time
tags are in the file (DateTime, DateTimeOriginal or DateTimeDigitized).

Please note: the timestamps of files which do not contain an EXIF date/time tag are not changed.

2.1.12 Slideshow

Select the View menu and click on Slideshow to display a full screen slideshow of your images. Press
the escape key or close the window to exit the slideshow.

Right click on the slideshow window to display a menu of options including: the interval between shots
and selecting high quality mode. The next and previous shots can also be selected using the cursor
keys or the mouse wheel. When 2-button mouse operation is selected the menu can be displayed by
holding down the Shift key when pressing the right mouse button.
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2.1.13

2.1.14

2.1.15

NOTE: The slideshow will automatically pause if you use the cursor keys or mouse wheel to select the
next or previous shot. To restart the slide show right click on the window and select "Play" from the
menu.

Please see the Slideshow page for more detalils.

View actual image

Select "View Actual Image" from the View menu to display the image full size. If the image is a raw
image it will be displayed using the JPEG preview image embedded in the raw file.

The image can be scrolled by moving the scroll bars or by pressing the mouse button over the image
and dragging it. The image may be zoomed out be pressing function key F8 and zoomed in using F9.
Right click on the image to display a menu of the viewing options.

NOTE: When viewing raw files using the JPEG preview image stored in the raw file the size and
quality of JPEG preview may vary depending on the camera used. Recent Nikon DSLRs and Canon
DSLRs have full resolution, high quality previews, some older Canon DSLRs have medium resolution
previews and some cameras such as Sony DSLRs have lower resolution previews.

Edit image

Select "Edit Image" from the Tools menu to edit your image in an image editor. For this feature to work
you need to tell BreezeBrowser Pro how to run the image editor in the preference settings.

NOTES:

1. If "Edit Image" is selected on a raw file BreezeBrowser Pro will search for a TIFF, JPEG, PNG or
JPEG 2000 image of the same name in the directory you normally use to store converted images.
If no matching file is found you will be asked whether you wish to convert the file first.

Moving and copying images to another folder
Moving images to another folder

To move the currently displayed image to another folder right click on the image and select the "Move
to Folder..." menu option (or select "Move to Folder..." from the File menu). A folder browser will be
displayed to specify the destination folder - this can be an existing folder or you can enter the name of
a new folder. If the folder does not exist you will be asked whether you wish to create it.

Copying images to another folder

To copy the currently displayed image to another folder right click on the image and select the "Copy to
Folder..." menu option (or select "Copy to Folder..." from the File menu). A folder browser will be
displayed to specify the destination folder - this can be an existing folder or you can enter the name of
a new folder. If the folder does not exist you will be asked whether you wish to create it.

Note: If the images are shortcuts the shortcuts will be copied to the destination folder, not the original
images that the shortcuts point to. The actual images rather than the shortcuts can be copied by
switching to thumbnail view, selecting the required images and then right clicking on one of the images
and selecting the "Copy Actual Images to Folder..." option.
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2.1.16 Extracting embedded JPEGs

Use this option to extract the JPEG preview image embedded in Canon, Nikon, Fuji and Pentax raw
files. This JPEG is 1440x960 pixels for EOS D30 raw files, 2048x1360 for EOS D60 raw files, variable
size depending on custom function settings for EOS 10D and 20D raw files and 640x480 pixels for
other camera models (e.g. G1, G2, Pro90, S30 and S40). You will be prompted for the output directory
and whether to rotate images and include EXIF information.

Selecting the option to rotate images will rotate images so that they match the display in
BreezeBrowser Pro. Only the images that need to be rotated will be rotated and the rotation is
lossless. JPEG extraction is faster if you do not select this option but all the images will be extracted in
landscape orientation.

Canon EOS 1D and 1Ds raw files: The "Extract Embedded JPEGs..." option can also be used to
copy Canon EOS 1D and 1Ds viewing JPEGs to a different directory to make it easier to use them for
quick proofing operations. Select the "Copy Canon EOS 1D/1Ds viewing JPEGSs to output dir"
checkbox if you wish to use this option. Please note: EOS 1D and 1Ds raw files do not contain
embedded JPEGs and this operation only copies viewing JPEGs to another directory if they already
exist i.e. if you shoot in Raw+JPEG mode or have previously created the viewing JPEGs.

2.1.17 Regenerate embedded JPEGs

Canon CRW raw files contain an embedded JPEG which is displayed when viewing images in main
view. With Canon PowerShot cameras this image is only 640x480 pixels in size and isn't really large
enough for proper viewing. The embedded JPEG can be replaced with a larger JPEG using the
"Regenerate embedded JPEGs..." option under the "Tools" menu. This option will convert the raw file
using the "As Shot" settings and replace the embedded JPEG with the converted image. The following
dialog is displayed when this is selected:

Regenerate Embedded JPEGs &]

Replace the embedded IPEG in Canon raw files with new
ones using the size and quality specified below,

The raw File is converted using the "As shot" conversion
patamekers,

Maximum image width: | 1000

JPE quality (0 ko 100} | 75

l Regenerate All ] [ Cancel

The image size can be set between 100 and 3500 and is used to specify the size of the new
embedded JPEG (the maximum size is limited to the resolution of the camera even if a larger value is
entered here). Use the JPEG quality setting to specify the JPEG quality. A higher value gives better
quality (and a larger file size).

2.1.18 Viewing EXIF data

EXIF data is information stored in the image about how and when the picture was taken. The Main
View shows a summary of the main settings. Click on the 'Full Details' button or right click on an image
and select "Image properties” to display the full EXIF and IPTC/XMP details.
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7 EXIF Data

Shooting Data | |PTCA<MP Data

File: *OBOBO327.CR2

File zize: 14.6MB

Irmage Senial Mumber: 000-0327
Image counter: 352

Camera Model Canon EQS-10 Mark 11
Camera zenial number: Q000500230
Firrmiare: Firrmsare YWerzion 5.3.1
Date/Time: 2007:02:23 18:51:26
Shutter zpeed: 1200 sec

Aperture: 5.6

E xposure mode: Manual

Flazh: Cff

tetering mode: Spot

Cirive mode: Continuous [low]: frame 1
I50: 100

Lens: EFS0mm £41.8

Focal length: 50nmm

AF mode: One-shaot AF

Image size: 3888 » 2592

Irmage quality: Raw

“White balance: &uto

Ficture style: Standard

Color zpace; z:RGE

S aturation; Mormal

Sharphess: 3

Contrazt: Mormal

Tone: Marmal

Cuztom Functions:

CFrl-3: 150 range enabled

CFrlll-3: Selectable AF point: outer 9 points

Please note: Custom functions from Canon EOS cameras are not displayed when they are set to their
default values

Copying EXIF data

EXIF data can be copied from images in the current directory to similarly named JPEG or TIFF files in
another directory. This is useful if you start with a raw file, convert it to TIFF and edit it before finally
saving it as a JPEG. It can also be used to add EXIF info to the JPEGs used for HTML pages. Select

"EXIF copy..." from the Tools menu to copy EXIF data.

NOTES:
1.
2.
base as the source files
3.
4. IPTC data is copied with the EXIF data

Normally EXIF data is only copied to similarly named files e.g. CRW_0001.CRW to

CRW_0001.JPG. To allow EXIF data to be copied to HTML images it will also copy the data to

files with the _std suffix e.g. CRW_0001.CRW to crw_0001_std.jpg.
Select the option to "Allow partial file name matches" to match any file name which has the same

e.g. the source file IMG_1234.JPG will copy EXIF data to IMG_1234.JPG, IMG_1234 proof.JPG

and IMG_1234 edited.JPG in the destination directory

Please use the option to copy EXIF data to TIFF files with caution. The TIFF file is rewritten as an

uncompressed TIFF and any additional information than was held in the original file may be lost.

NOTE: The copying of EXIF data from TIFF files other than Canon EOS 1D raw files is not supported
in this version.
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Copying EXIF from a single file

It is also possible to copy EXIF data from one file to another. The destination file is the currently
displayed file (or the one which has focus in thumbnail mode) and must be either a JPEG or a TIFF.
The source file can be a JPEG, TIFF, CRW or THM file.

Select "Copy EXIF data from..." from the "Tools" menu to copy EXIF data from another image to the
current image. A file browser will be displayed to select the source file and when a suitable file has
been selected you will be presented with a confirmation dialog.

Please use this feature with caution because the EXIF data in the current file will be overwritten and
the operation cannot be undone.

2.1.20 Exporting EXIF data

To export EXIF data select the "Tools->Export EXIF Data..." menu item. EXIF data can be exported to
separate text files describing each image or to a single file suitable for importing to a spreadsheet of
database.

Export EXIF Data E|

JE—

() One EXIF data file per image

Ewxport EXIF data to text filez, one per image. The test file iz given the zame name az the
image file, but with a "' tat" extenzion. e.q. The ExIF data for image IMG_001.jpg iz stored
irn the ket file AG_O007 bt

(%) Stare EXIF in a single file, one line per image

Ewmport EXIF data to a single test file with one line per image uzing the delimiter specified
below or define pour own custom format sthing.

[ ] Output heading names Delirmiter: . [rust be: Lo ;or [ar 7t

Ilze the custom format string below:
(Ffile@Edate Time & EmonthE ) Ed awE

Output Filenarme;
H:A5 amplesiCanon EDS 100%nko. et E]

E:-:pu:urtSeIeu:tedl[ Carnicel ]

When "One EXIF data file per image" is selected the EXIF data is stored in separate text file for each
image with the same name as the image file but with a ".txt" extension. e.g. The image IMG_0001.crw
would have its EXIF data stored in the text file IMG_0001.txt. The EXIF data exported to separate files
is identical to the full EXIF data displayed by BreezeBrowser Pro.

When "Store EXIF in a single file, one line per image" is selected the EXIF data is stored in a single file
specified by "Output Filename" and defaults to the file info.txt in the same directory as the images.

When "Output heading names" is selected the first line of the file will contain heading names for each
EXIF fields being exported.

Fields may be delimited by , or ; or | or *t (TAB character) .
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2.1.21

2.1.22

Select "Use the custom format string below" to define what EXIF data should be exported. The format
string uses the same tokens as the HTML generator (see HTML Page Generation for a list of tokens)
e.g. use @file@ for the image filename, @date@ for the date the image was taken etc. Type "t for
tabs and \n for line breaks.

When "Use the custom format string below" is not selected the EXIF data is output in the following
order:

Image filename

File size

Camera model

Camera body id

Firmware version

Owner string

Date and time

Copyright

Shutter speed

10. Aperture

11. Exposure mode

12. Exposure compensation

13. Auto exposure bracketing sequence number
14. Auto exposure bracketing exposure compensation
15. Flash setting

16. Flash EF guide number

17. Flash Exposure compensation
18. Metering mode

19. Shooting mode

20. Self-timer delay

21. 1SO

22. Lens focal length range

23. Focal length used

24. Subject distance in meters

25. Macro on/off

CoNoU~wWNE

Please note: not all EXIF data is available for all camera models. Also the original EXIF data may be
lost or corrupted after editing images with some image editors. It is a good idea always to keep a copy
of the original unedited image to preserve the EXIF data and in case you wish to edit the image in a
different way in the future.

Adding a "Browse with BreezeBrowser Pro™ option to Windows Explorer

Select "Shortcut..." from the File menu in BreezeBrowser Pro to add a "Browser with BreezeBrowser
Pro" option when you right click on a folder in Windows Explorer.

You can remove the menu item by selecting "Shortcut..." again.

Grid Overlay

Select "Show Grid Overlay" from the view menu to display a grid on images viewed in main and
thumbnail views. The color and spacing of the grid lines can be specified using the dialog below which
can be displayed by selecting "Grid settings..." from the View menu:
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Grid Settings

Mumber af haorizantal divisions: | 3

Mumber of vertical divisions:

4k 4

[ 1show print area
Print aspect ratio (2.9, 10 x B]I:| 10 | ¥ | a |

Line calar: - m

Enable grid display

L Ok J [ Cancel J

Select the show print area checkbox to show the extent of a particular print size. For example most
digital SLRs shoot images with an aspect ratio of 3:1 which fits perfectly on a 6"x4" print but needs to
be cropped if it is printed on 10"x8" paper. You can display extent of a 10"x8" print by setting the print
aspect ratio to 10 x 8.

2.1.23 Image Magnifier

Use the image magnifier to magnify an image displayed in main view or filmstrip view. The magnifier
can be displayed by selecting "Magnifier" from the View menu. A floating window will appear next to
the mouse cursor showing an enlarged view of the area under the cursor.

The magnifier can be turned off by deselecting it from the View menu, by pressing the Esc key or by
switching view mode or displaying a different image. The size of the magnifier window can be specified
in Preferences.

The magnifier defaults to 1x magnification. This can be increased to 2x, 3x or 4x by typing Ctrl+cursor
up and decreased down again by typing Ctrl+cursor down.

Please note
There may be a short delay while the full size image is loaded before the magnifier window is
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2.2

displayed.

The magnifier displays the preview image embedded in raw files when used to view a raw file and this
may be smaller than the converted image e.g. the preview image in Canon EOS 20D raw files is
1536x1024 pixels whereas the raw data is 3456x2304 pixels. If you shoot in raw+JPEG mode and
have setup BreezeBrowser Pro to link the raw and JPEG images (see Preferences) the magnifier will
use the JPEG image.

Thumbnail View

B8l BreezeBrowser Pro - [\photos\2008,2008-10-30 - (22 files, 1 tagged) [EENEER S

File Edit View Tools Help
ERE| = r S W fric) | [ f

SEHEHEA v X am e Pomn X

----- | 20080813 - | CR2 CR2 CR2
| 20080815
| 20080817
| 20030818
| 20080821
| 20080822
| 2008-08-23 IMG_0381.CR2 | IMG_0382 CR2
| 2008-03-02 CR2 CR2 CR2
| 20080311

----- |, 20080813 |_
}
¥
}
’
’
!
’
}
¥

b

IMG_0387.CR2
CRZ

m

, 2008-03-26
- 20031003
- 2008-10-07
, 20081013
| 2008-10-26
- 2008-10-27
, 2008-10-28
, 2008-10-23
- 2008-10-30

IMG_0391.CRZ | IMG_0332.CRZ | IMG_0395.CR2

|

Tl

Lo200810-31 7 :
] il 3 It 0400 .CR2

T

_ IMG_0403 CR2
2008/10/30 16:06:34, 17 to 85mm @ 70mm, 1/20sec £/6.7, Exp:Av, IS0 200, AF:One-shot AF 4 of 22 selected

The Thumbnail View shows the thumbnails of all the images in the directory. The background color for
the thumbnail window and the size of the thumbnails can be set using the preferences settings dialog.
Select a single image by clicking on it, a range of images by clicking on the first image and then click
on the last image while holding the SHIFT key down. Individual images can be added to or removed
from the selection by clicking on them with the CTRL key held down. Selected images are highlighted
as shown in the screenshot above where images IMG_0397 through to IMG_401 are selected.

CRz &N Ev

G058 CR2 Ik
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The thumbnail above shows all the various captions and icons that can be displayed. The filename of
the image is displayed and the bottom and its file extension is displayed in the top left hand corner.
Images shot in raw+JPEG mode will have a raw+JPEG icon displayed in the top left corner instead of
the file extension. At the top in the middle is GPS icon showing that the image contains GPS latitude
and longitude data, the shortcut icon indicating this is a shortcut to a file (see Shortcuts/links to files for
more details) and the musical note icon indicating that this image has a sound annotation file
associated with it (press on the musical note button in the toolbar or right click and select "Play sound
annotation” to play the sound file). In the top right hand corner is the number "5" indicating that this
image has a ranking of 5 (see Image Ranking for more details) and a blue tick indicating that this
image has been tagged (see Tagging for more details).

Thumbnails can also be shown with shooting data as in the thumbnail above. The thumbnail shooting
data display can be edited by selecting "Thumbnail Shooting Data..." from the View menu and the
dialog below will be displayed:
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Thumbnail Shooting Data Settings [ﬂ]

Display shooting data with thumbnails
The thumbnail shooting data display can also be toggled on and off in thumbnail mode by
typing the keyboard shortout: Crl+Aalt+C

Caption width in pixels: 135

Caption format string:

EdateTime@

@lens3@

@shutter @sec @ f/@aperture@, IS0 @iso@
Exposure mode: @exposureMode @

White balance: @whiteBalance @

Camera: @model@

The caption can use the tokens (e.q. @dateTime@ for the date and time
the photo was taken) which are expanded to show the data for each

image. Click on the 'Show tokens...' button to see a list of available :
bl Default caption

Display GPS icon if image contains GPS location data

Display Adobe Ratings and Labels

[ oK ][ Cancel ]

The display of shooting data with thumbnails can be enabled by selecting the "Display shooting data
with thumbnails" checkbox. It can also be toggled on and off from the thumbnail view in the main
window using the keyboard shortcut: Ctrl+Alt+C.

When the "Display Adobe Ratings and Labels" checkbox is selected BreezeBrowser Pro will read the
rating and label information from the XMP shooting data associated with the image and display it
above the thumbnail. Click on the "Settings..." button to edit the label names associated with each
color:

© 2004 to 2023 Breeze Systems Ltd



Reference section 23

[ Adobe Label Display Settings [&J
Color  Label Shortcut
@ seec & or Cirl+6
O second 7or Ctrl+7
O Approved 8 or Ctrl+8
. Review 9 or Cirl+9

ToDo Cirl+U
O

Select the option to "Also store ranking as Adobe
Rating® in the main preferences to enable to
keyboard shortouts for setting Adobe Labels

Defaults J [ Ok ll Cancel

The size of the area for displaying the shooting data to the right of the thumbnail can be specified
using the "Caption width in pixels" setting.

The caption format string specifies what information is displayed with the thumbnail. This format string
uses the same tokens to specify the settings to be displayed as the HTML generator (see HTML
Generation) and these are expanded to show the values of the actual data from the image e.g.
@model@ in the format string is expanded to show "Canon EOS 50D" in the thumbnail example
above.

The display of the GPS icon can also be turned on or off using this dialog.

Please Note: The thumbnail shooting data and GPS icon display may result in the thumbnail display
taking slightly longer to display than when these options are turned off. This is because BreezeBrowser
Pro has to read the shooting data for each thumbnail before it is displayed. The shooting data display
may not be automatically updated when an image is modified. Please press F5 to refresh the display if
this happens.

In thumbnail mode most actions apply to the selected images e.g. rotate, delete, HTML, proofs. Some
actions only apply to one image e.g. rename image. Actions applying to a single image are performed
on the image which has focus. Focus is set when you click on an image and the focused image is
displayed with a different text color. The focused image in the screenshot is IMG_401 and a summary
of its EXIF data is displayed in the status line at the bottom of the window.

Each thumbnail shows the image with the image filename underneath and the image type (the same
as its file extension) in the top left hand corner. Long filenames may be truncated to fit in the available
space and will have "..." appended to them e.g. "a_very_long_name.jpg" might be displayed as
"a_very_long...". The image type is color coded to make it easier to identify the different types. JPEGs
are displayed in blue, Canon raw files in red, AVI files in green and all other types are displayed in
black.

If the image has been tagged a blue tick will be displayed in the top right hand corner. In the
screenshot above image CRW_0179 is tagged.

Double-click on an image to switch to the Main View with the image displayed.

You can also change the display using one of the following keyboard shortcuts:
e Ctrl+M - switch to main view
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Escape - switch to main view or thumbnail view depending on the double-click options set in

preferences

Shift+Escape - switch to filmstrip view
Ctrl+X - display extra large thumbnails
Ctrl+L - display large thumbnails
Ctrl+T - display small thumbnails

Right click on an image to display a menu of the operations that can be performed on the selected
image or images:

1. Main View - switch from Thumbnail View to Main View

2. Tag Image - add or remove the tag on the focused image

3. Play Sound - play the sound annotation file associated with the image (only displayed if the image
has a corresponding WAV file)

4. Play Video - play the video clip using the default Windows viewer (only displayed for AVI files)

5. View Actual Image - display the image under the mouse cursor full size in a separate window

6. Edit Image - edit the image under the mouse cursor in the editor specified in your preference
settings

7. Slideshow - display the currently selected images in the slideshow window

8. Extract embedded JPEGs - extracts embedded JPEGs from raw files

9. Proofs - display the proofs dialog. When you press the 'Proof All' button only the currently selected
images will be proofed

10. HTML - display the HTML page generation dialog. When you press the 'Generate HTML' button
HTML pages will only be generated for the currently selected images

11. Rotate Left (CCW) - rotate the selected images 90 degrees counter-clockwise

12. Rotate Right (CW) - rotate the selected images 90 degrees clockwise

13. Edit Comments - display the 'Edit Comments' dialog for the image. If you press the 'Apply to All'
button the comments will be added to the currently selected images

14. Edit IPTC Data - add or edit IPTC data in the focused image (see IPTC Data)

15. Rename the focused image

16. Batch rename the selected images

17. Move To Folder - move the selected images to a new directory

18. Email Images - email one or more images with the option to resize them for easy viewing on a PC
screen and to reduce file size

19. Delete - delete the selected images by moving them to the Windows Recycle Bin or the 'Deleted'
sub-directory according to your preferences settings

NOTES:

1. If animage file has become corrupted the thumbnail will be displayed as a red cross.

2. Extra large thumbnails use a lot of memory and can affect system performance on machines with
limited RAM. BreezeBrowser Pro can handle directories with very large numbers of images and
has been tested with a directory containing 2500 raw files and 1500 JPEGs

3. To email images the default email client installed on the computer must be a 32-bit app that is

MAPI compliant e.g. Mozilla Thunderbird or 32-bit versions of Microsoft Outlook.

Regenerate JPEG thumbnails

JPEG images from digital cameras often contain small thumbnail images in their EXIF data and
BreezeBrowser Pro will use these when available. Some applications do not update the EXIF
thumbnail when modifying the image and this can result in the thumbnail and main displays in
BreezeBrowser Pro becoming out of sync. Use the "Regenerate JPEG Thumbnails" option under the
"Tools" menu to regenerate the thumbnails be replacing the old thumbnail with a new one derived from
the main image.
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2.2.3

NOTE: This option will add a thumbnail to a JPEG image if it doesn't already contain one provided the
JPEG contains EXIF shooting data.

Regenerate 16-bit TIFF thumbnails

Some third party raw converters do not write the thumbnails correctly when creating 16-bit TIFF
images resulting in black or scrambled thumbnails being displayed in BreezeBrowser Pro. The
thumbnails can be repaired by selecting them in thumbnail view, right clicking and selecting
"Regenerating 16-bit TIFF thumbnails...". The main image data is read from each TIFF image and is
resized and copied back to the TIFF file to replace the bad thumbnail image. This operation takes a
few seconds per image and is only performed on 16-bit TIFF images where the thumbnail is stored in
the 2nd IFD.

Image display order

BreezeBrowser Pro can sort thumbnail images in a variety of different orders. To change the order in
which thumbnails are displayed select "Image Order" from the "View" menu.

The available sort methods are:

1. Sort Alphabetically - Images are sorted alphabetically using their filenames. Use this option if you
use Zoombrowser to transfer you images from your camera.

2. Sort Numerically - Images are sorted numerically using the first group of numbers found in the
filename. If duplicate numbers are found the images are sorted alphabetically. Use this option if
you use Downloader or a cardreader to transfer you images from your camera.

3. Sort by File Type - Images are sorted alphabetically using their type followed by their name. Use
this option if you would like images of the same type to be grouped together.

4. Sort by Timestamp - Images are sorted according to their EXIF date and time (or file creation time
if the EXIF date and time aren't available). If images have the same timestamp they are sorted
alphabetically. Use this option if you use a filenaming scheme which doesn't lend itself to sorting
by filename or if the directory contains images from more than one camera.

5. Custom Order - the image order can be changed by dragging and dropping thumbnails in
thumbnail view. This is useful if you wish to change the order in which images are displayed in
HTML pages or on contact sheets.

In addition there is an option to reverse the order in which images are sorted. One use for this is to sort
images so that the most recent ones appear first.

To enable custom order simply drag one or more thumbnails and drop them in their new positions. The

image order and sort method is saved when you leave a directory and restored when the directory is
revisited.

Sort by shooting data

Select "Sort by shooting data..." from the View menu or type Shift+Ctrl+7 to sort images using their
shooting data. The dialog below will be displayed:
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224

2.25

Sort by Shooting Data @

Apply a cusktom sort order using shooking data read
From the image. Please select the atkribute to sort by
From the list below.

Attribute: | Orientation b

|:| Reverse sort order

[ 0K H Cancel ]

Select the attribute you wish to sort by from the drop down list. When the images are sorted the

selected attribute is compared first. If two images have the same attribute (e.g. they are both

landscape orientation when sorting by orientation) they will be sorted alphabetically.

Notes:

1. Sorting by shooting data has the same effect as a custom order and needs to be run again if new
images are added to the folder or their attributes change.

2. Sorting by latitude will sort the images by decreasing order of latitude i.e. most northerly images first

3. Sorting by longitude will sort the images by increasing order of longitude i.e. most westerly images
first

Tagging

Tags are a way of marking files in a more permanent way than just selecting them in the thumbnail
view. The list of tagged files is automatically saved when BreezeBrowser Pro exits (or a new directory
is loaded) and are restored next time the directory is browsed.

Tags are automatically saved in a file called "tagged_files.txt" in the same directory as the images and
are restored next time the directory is browsed (this only works on read/write drives and won't work on
CDs). Use the "Edit" menu to tag the currently selected files or to select the currently tagged files.

The list of tagged images can also be saved to a separate file by selecting "Save Tags..." from the
"File" menu. This will save the full pathname of each tagged image (i.e. drive, directory and filename)
to a simple text file. Previously saved lists of tagged images can be loaded by selecting "Load Tags..."
or "Merge Tags..." from the "File" menu. The tags will be removed from any currently tagged image
and new tags added for each image listed in the tag file.

Tags can also be loaded by dragging a file with a .txt of .tag extension and dropping it on the
BreezeBrowser Pro window. A dialog will be displayed asking you whether you wish to replace the
existing tags with the ones listed in the file being dropped.

NOTE: Only the filename is checked when loading a list of tags. This is to allow lists of tagged files to
work even if the directory has been moved.

Shortcuts/links to files

BreezeBrowser Pro can display shortcuts to images in a folder using the standard Windows shortcut
files. When an image is displayed in thumbnail view which is a shortcut (or link) to another image it is
displayed with the shortcut icon at the top of the thumbnail as shown below:
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A red cross is displayed in the thumbnail if the image the shortcut is pointing to is not available e.qg. it
has been renamed, moved or deleted.

When an image is a shortcut the certain operations only apply to the shortcut and don't affect the
image it links to. Copy, move and delete operations only affect the shortcut. Renaming, selecting,
tagging and ranking also only affect the shortcut.

Other operations which modify the image are applied to actual image and not the shortcut. These
include rotating, adding user comments and editing the IPTC data.

A shortcut can be created in Windows Explorer in the normal way (right click on the file and drag and
drop to its new location then select "Create Shortcuts Here"). You can also create a shortcut in
BreezeBrowser Pro by selecting one or more images in thumbnail or filmstrip view then click on one
image in the selection and hold the left button down and start dragging. Then press the Shift key and
drop the files in the destination directory in the directory tree view. You can cancel the drag operation
by pressing the Esc key.

Note: When using the "Copy Images to Folder..." right click option shortcuts to images will be copied
to the destination folder as shortcuts, not the original images that the shortcuts point to. The actual
images rather than the shortcuts can be copied by switching to thumbnail view, selecting the required
images and then right clicking on one of the images and selecting the "Copy Actual Images to
Folder..." option.

2.3  Filmstrip view
The filmstrip view shows thumbnails and a larger view of the currently selected image. To switch to
filmstrip view type Shift+Escape or select it from the "View" menu. Typing Shift+Escape toggles
between the filmstrip + EXIF and the filmstrip + folder views shown below.

In filmstrip view the controls and keyboard shortcuts are similar to those in thumbnail view.

Filmstrip view can also display an EXIF summary as in the screenshot below:
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The information displayed in the EXIF summary window can be specified in Preferences. Type
Ctrl+Tab to toggle the display of the EXIF summary on and off.

Filmstrip view can also display the directory tree as shown in the following screenshot:
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Type Ctrl+Tab to toggle the folder display on and off.

Kiosk Mode

Kiosk mode provides a simplified view of the images in a folder with a touch screen interface to allow
users to perform simple actions such as printing and emailing images. It is aimed at event
photographers who want to be able to offer users the ability to print or email images taken during an
event. The display fills the screen and is similar to the film strip view with the thumbnails down the left
hand side and a larger image displayed in the main area. It is designed to be used with a touchscreen
monitor and to only allow users to perform a simple set of actions. The touchscreen actions for
browsing images work best on a computer running Windows 7 or later (because newer versions of
Windows have better support for touchscreens than older versions of Windows) but can also be used
on computers running Windows Vista.

Please note: The email examples use the email_image.exe utility from our Hotfolder Prints software
which needs to be purchased separately.

The kiosk mode display can be selected by from the View menu (View->Kiosk Mode->Switch to kiosk
mode). For best results before entering kiosk mode it is recommended that display background color
is set to white (see Preferences) and film strip mode is selected so that the desired thumbnail size can
be selected and the window panes adjusted to fit the thumbnail size. To update the thumbnail list
automatically when new images are added to the folder select the "Monitor folder for changes and
update display automatically” option in BreezeBrowser Pro's preferences.
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Example kiosk mode display showing a menu

In kiosk mode the user can touch a thumbnail on the left to display the image in the main part of the
window and press and drag their finder on the thumbnails to scroll up and down. A menu of available
actions is displayed when the touches the main image. An optional touchscreen keyboard can be
displayed (e.g. to enter their email address) when the user selects a menu item.

To exit kiosk mode and return to the normal BreezeBrowser Pro display press the escape key on the
keyboard. It is recommended that the keyboard is hidden away during use to prevent users from
exiting the software or gaining access to the Windows desktop.

Setting up
The menu items and actions available to users can be defined by selecting "Kiosk mode settings..."

from the "Kiosk mode" menu item in the View menu. This will display the kiosk mode menu settings
dialog:
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Kiosk Mode Menu Settings @
Print - Your image is being printed... Add...
Email - Emailing your image...
Cancel Edit...
Delete...
Mowve up
Move down

o

New menu entries can be added by pressing the "Add..." button and existing entries can be edited by
selecting the item from the list on the left and pressing the "Edit..." button. Menu items can be deleted
by selecting them from the list and pressing the "Delete" button. The order of the menu items can be

changed by selecting the menu item and clicking on the "Move up" or "Move down" buttons.

When the "Add..." or "Edit..." button is pressed the kiosk mode menu item editor is displayed:

Kiosk Mode Menu Item Editor ﬁ

Menu legend:

Cancel

Menu action: | Do nothing -

Description shown when performing the action:

Command to execute;

Display touchscreen keyboard | Test keyboard...

Folder containing keyboard. xml file and images:

Enter the text to displayed to the user in the "Menu legend" text edit box and select the menu action
from the dropdown list. The available actions are "Do nothing", "Print" and "Run command". The "Do
nothing" option, shown in the screenshot above, does nothing other than hide the menu.
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The "Print" option, shown in the screenshot below, resizes the image to fit the page and then prints it
using the current printer settings. The text entered for the "Description shown when performing the

action" is displayed for a few seconds to confirm the user's selection.

r

Kiosk Mode Menu Item Editor

||

Menu legend:
Print

Menu action: |Print =

Description shown when performing the action:

Your image is being printed...

Command to execute:

Display touchscreen keyboard Test keyboard...

Folder containing keyboard, xml file and images:

The "Run command" option, shown below, will run a program or batch file to perform an action. An
optional touchscreen keyboard can be displayed to the user allowing them to enter information such as
their email address before performing the action. The appearance and behavior of the touchscreen
keyboard can be defined using an XML file and keyboard image files stored in the folder specified.

Please see the section on the touchscreen keyboard for details.
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Kiosk Mode Menu Item Editor lﬁ

Menu legend:

Email

Menu action: | Run command i

Description shown when performing the action:

Emailing your image...

Command to execute:

“C:\Program Files\BreezeSys\HotFolder Prints‘email_image.exe” +{user 1} -osales@breezesys.com “{parentDi

Display touchscreen keyboard

Folder containing keyboard, xml file and images:

C:\¥eyboardLayouts\Email E]

oK ][ Cancel ]

Tokens can be used as placeholders in the command and are replaced with data entered by the user
or information read from the image when the command is executed. Most of the tokens used by the
HTML generator can be used but not all of them will necessarily return useful values. The following
tokens are probably the most useful:

{userl} to {user2} - information entered by the user using the touchscreen keyboard

{file} - the filename of the image selected in the kiosk mode window e.g. IMG_0123.JPG

{dir} - the full pathname of the folder containing the image selected in the kiosk mode window e.g. C:
\Photos\20110515\Prints

{parentDir} - C:\Photos\20110515

The full pathname of the selected image in the examples above is C:\Photos\20110515
\Prints\IMG_0123.JPG

Note: Tokens can be enclosed by curly braces e.g. {file}, or by @ characters e.g. @file@

Please see the "Photobooth event example" for an example of how to define a command to email an
image.

2.4.1 Touchscreen Keyboard

An optional touchscreen keyboard can be displayed to allow users to enter information such as their
email address. To enable the keyboard select "Display touchscreen keyboard" in the kiosk mode menu
item editor:
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Kiosk Mode Menu Item Editor Iﬁ

Menu legend:

Email

Menu action: | Run command i

Description shown when performing the action:

Emailing your image...

Command to execute:

“C:\Program Files\BreezeSys\HotFolder Prints‘email_image.exe” +{user 1} -osales@breezesys.com “{parentDi

[¥] Display touchscreen keyboard | Test keyboard. ..

Folder containing keyboard, xml file and images:

C:\¥eyboardLayouts\Email CI

oK ][ Cancel I

The touchscreen keyboard can be tested by pressing the "Test keyboard..." button. The default
keyboard layout will fill the screen and look similar to the screenshot below:

Please enter your email address:

sales@breezesys.com

Delete

Send email No thanks!

The text entered by the user is saved in the {userl} token (and the {user2} token if two text fields are
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defined) and can be used in the command run after selecting a menu item. The checkbox status, if
defined, is stored in the {chkbox1}, {chkbox2} etc. tokens. For example the command to email an
image using the email_image.exe utility from Breeze Systems' Hotfolder Prints software might look
something like:

"C:\Program Files\BreezeSys\HotFolder Prints\email_image.exe" -r{userl} -osales@breezesys.com
-s"Photos from John and Sue®"s Wedding" "{parentDir}\HFP\{File}"

Customizing the keyboard

The layout of the keyboard can be customized by creating an XML settings file called keyboard.xml
and putting this in the keyboard settings folder. This gives control over the size and position of the
keys, the background color etc. A series of keyboard images can also be used if you need more
control of the appearance of the keyboard.

The easiest way to customize the keyboard is to save a copy of the XML file and TIFF screen images
used to define the default keyboard layout and then edit them as required. The files can be saved by
first displaying the keyboard by pressing the "Test keyboard..." button and then holding down both the
Shift and Ctrl keys and pressing the left mouse button. The keyboard.xml file will look something like
this:

<?xml version="1.0" ?>
<breeze_systems_photobooth version="2_2">
<photobooth_settings>
<keyboard>
<text_point_size>480</text_point_size>
<promptl>Please enter your email address:</promptl>
<textl y>411</textl_y>
<textl x>50</textl_ x>
<textl w>300</textl_w>
<background_color>0x000080</background_color>
<transparent_color>0x000080</transparent_color>
<text_color>0xFFFFFF</text_color>
<show_cursor>0</show_cursor>
<key>
<left>58</left>
<top>630</top>
<width>112</width>
<height>89</height>
<legend>q</legend>
<shifted_legend>Q</shifted_legend>
<code>q</code>
<shifted_code>Q</shifted_code>
</key>
<key>
<left>186</left>
<top>630</top>
<width>112</width>
<height>89</height>
<legend>w</legend>
<shifted_legend>W</shifted_legend>
<code>w</code>
</key>
<key>
<left>1296</left>
<top>840</top>
<width>160</width>
<height>89</height>
<legend>Shift</legend>
<shifted_legend>Shift</shifted_legend>
<code>Shift</code>
<shifted_code>Shift</shifted_code>
</key>
<key>
<left>400</left>
<top>945</top>
<width>368</width>
<height>89</height>
<legend>Send email</legend>
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<shifted_legend>Send email</shifted_legend>
<code>0K</code>
<shifted_code>0K</shifted_code>
</key>
<key>
<left>784</left>
<top>945</top>
<width>368</width>
<height>89</height>
<legend>No thanks!</legend>
<shifted_legend>No thanks!</shifted_legend>
<code>Cancel</code>
<shifted_code>Cancel</shifted_code>
</key>
</keyboard>
</photobooth_settings>
</breeze_systems_photobooth>

The <promptl> tag defines the text that is displayed above the user input area and defaults to "Please
enter your email address:". The <textl x> and <textl y> tags specify the position of the user input
area. This is specified as the number of pixels down from the top, left corner of the screen. The width
in pixels of the user input area can be specified using the <textl w> tag.

Additional prompts can be added by including <prompt2>, <text2_x>, <text2_y>, <text2_w> etc. tags
up to a maximum of 10 user input areas. The prompt tags can have an optional password field which if
set to "1" will display the text in the user input area as * characters e.g. <promptl
password="1">Please enter your password:</prompt1>.

When more than one user input area is defined users can switch between the input areas by touching
them. The currently selected input area is highlighted in red.

The optional <text_point_size> tag defines the size of the text font used in the user input area. This is
specified in tenths of a point and defaults to 480 (a point size of 48).

Up to 10 checkboxes can be added using the <chkbox1 prompt>, <chkbox1l x>, <chkbox1 y>,
<chkbox2_prompt>, <chkbox2_x>, <chkbox2_y> etc. tags. The <chkbox1_ prompt> tag specifies the
text displayed to the right of the text box and can include a value attribute to specify whether the
checkbox is initially checked or not e.g. <chkbox1_prompt value="0">Checkbox prompt (default off)</
chkbox1 prompt> or <chkbox1_ prompt value="1">Checkbox prompt (default on)</chkbox1_prompt>.
The <chkbox1 x> and <chkbox2_y> tags specify the position of the checkbox.

The checkbox status is stored in the <chkbox1>, <chkbox2> etc. fields in the XML file saved with the
photos.

The <background_color> tag specifies the background color of the window and the <key text color>
specifies the color for the prompt text and key legends.

The optional <text_foreground_color> tag specifies the foreground color for text displayed in the user
input areas. The default value if this tag is omitted is black (0x000000).

The optional <text_background_color> tag specifies the background color for the user input areas. The
default value if this tag is omitted is white (OXFFFFFF).

The optional <transparent_color> tag specifies a color which will be made transparent when the
keyboard is displayed.

All colors should be hexadecimal RGB values e.g. 0x000000 for black, OxFF0000 for red, OXO0OFF00
for green, OXO000FF for blue, OXFFFFFF for white.

The <show_cursor> tag specifies whether a gray cursor is shown in the user input area. Set thisto 1 to
display the cursor or 0 to hide it. The cursor display is useful if the keyboard allows the entry of spaces.

The <key> tag specifies the size and position of each key, its legends and what should be typed when
it is pressed. The top left corner of the key is defined using the <left> and <top> tags and the width and
height are specified using the <width> and <height> tags (all values are in pixels). The
<shifted_legend> tag specifies what is displayed on the key when the shift key is pressed and the
<legend> specifies the key legend when shift is not pressed.

The <shifted_code> tag specifies what is typed when the key is pressed when shift is pressed and the
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<code> tag specifies what is typed when the shift key is not pressed. The following codes have special
values:

"Shift" - puts the keyboard into shifted mode (i.e. upper case) when pressed

"OK" - closes the keyboard window and returns the user input if at least one text input field contains
text

"OK all" - closes the keyboard window and returns the user input only if all the text input fields contain
text

"OK none" - closes the keyboard window and returns the user input even if none of the input fields
contain text

"Cancel" - closes the keyboard window and cancels the user input

Keyboard images

Separate keyboard screen images can be defined if you need more control over the appearance of the
keyboard. These images should be TIFF images the same size as the resolution of the screen and
should be placed in the keyboard settings folder. The keyboard images should be named as follows:

keyboard_uppercase.tif - keyboard image showing upper case key legends
keyboard_uppercase_pressed.tif - keyboard image showing upper case key legends with the keys
pressed

keyboard_lowercase.tif - keyboard image showing lower case key legends
keyboard_lowercase_pressed.tif - keyboard image showing lower case key legends with the keys
pressed

If TIFF keyboard images aren't found the software will attempt to load JPEG images instead
(keyboard_uppercase.jpg, keyboard_uppercase_pressed.jpg, keyboard_lowercase.jpg and
keyboard_lowercase_pressed.jpg).

Please take care that the keys are in the same positions in each of the keyboard images and that
these also correspond to the values in the keyboard.xml file. The <background_color>, <text_color>,
<prompt>, <legend> and <shifted_legend> tags in the keyboard.xml file are ignored when keyboard
images are used to define the appearance of the keyboard.

Note: If you only need to change the keyboard layout and are happy with the default keyboard display
you only need to create a keyboard.xml file in the photo booth images folder and can delete the
keyboard screen images (keyboard_uppercase.tif, keyboard_uppercase_pressed.tif,
keyboard_lowercase.tif and keyboard_lowercase_pressed.tif). If keyboard images are defined the
<prompt> tags in the keyboard.xml file will be ignored.

2.4.2 Photobooth event example

This example shows how BreezeBrowser Pro's kiosk mode can be used together with our Hotfolder
Prints and photobooth software to allow users to select photos for reprinting or emailing.

In this example let's assume that the photobooth software is setup to save the photos in the folder C:
\Photos\2011-05-17. The output mode in the photobooth software should be set to "Print and save
JPEG copy" or "JPEG copy only" so that a JPEG copy of the printed layout is saved. The JPEG copy
of the printed layout will be saved in a subfolder named "Prints" i.e. the folder C:\Photos\2011-05-17
\Prints. The filename of the JPEG copy of the printed layout is the date and time that the first photo in
the sequence was taken e.g. 20110517-195032.JPG.

The photobooth software should be setup so that the JPEG copy of the printed output is formatted
correctly for printing (this will normally be the case if the photobooth software's output option is set to
"Print and save JPEG copy"). BreezeBrowser Pro should be setup to display images in this folder, C:
\Photos\2011-05-17\Prints, so that when the print menu option is selected the JPEG copy of the
printed output is sent to the printer.

The JPEG copy of the printed output isn't really suitable for emailing to users. The files tend to be very
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large and formatted for printing (e.g. a traditional vertical strip of four photos) rather than screen
display. Our Hotfolder Prints software will monitor the folder where the photos are downloaded and
saved from the camera and save them in a layout suitable for emailing to users e.g. a 2 x 2 grid of
photos at a typical screen resolution of 1024x768 pixels together with your company logo and contact
details. To set this up the output mode in Hotfolder Prints should be set to "JPEG copy only" so that a
JPEG copy of the print layout is saved. The filename of the JPEG copy uses the same method as our
photobooth software and is generated using the date and time of the first photo in the sequence. The
filename prefix should be left blank and the subfolder should be set to "email". The Hotfolder Prints
preference will look something like:

HotFolder Prints Preferences w

Folder to monitor for new images:

C:\Photos\2011-05-17 B
[ Match filename {regular expression):
Mumber of images [1 to 10]: 4 Delay before processing images (sec): 1
Output Options
Output: [JPEG copy only v] [¥] Custom size: 1024 ¥ 758 pixels
Filename prefisx: Subfolder:  email

[] Run command after saving JFEG copy of output: | Edit email settings..

[¥] custom layout Rows [1to 10]: | 4 Columns [1to 10]: | 2

Image border {mm): | 1 Mumber of copies to print [1to 8] | 1
Folder containing header, footer, badiground and overlay images:

C:'\Photobooth'\Layout Images E]
Repeat images to fill empty columns [#] Sharpen images, amount: &5
Rotate image to maximize size [T] Print photos in B&W
Crop image if required to fit printable area  [¥] Captions

Load... ] [ Save... [ K ] [ Cancel

This will make sure that the photobooth software creates a JPEG copy of the printed output in the
"Prints" subfolder and Hotfolder Prints creates a JPEG of the same name suitable for emailing in the
"email" subfolder.

Summary of the different folders being used:

C: folder where individual photos from the photobooth are saved e.g IMG_0001.JPG,
\Photos\2011- IMG_0002.JPG, IMG_0003.JPG and IMG_0004.JPG

05-17

C: folder where a copy of the printed layout is saved by the photobooth software e.g.

\Photos\2011- 20110517-195032.JPG
05-17\Prints  BreezeBrowser Pro's kiosk mode displays the contents of this folder
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C: folder where a copy photos formatted for emailing is saved by Hotfolder Prints e.g.
\Photos\2011- 20110517-195032.JPG
05-17\email

BreezeBrowser Pro should set to monitor the "Prints” folder and a kiosk mode menu entry created to
print the photos. A second kiosk mode menu entry can then be created to email the images stored in
the "email" subfolder. The Kiosk menu menu item editor dialog should look something like this:

Kiosk Mode Menu Item Editar lﬁ

Menu legend:

Email

Menu action: | Run command =i

Description shown when performing the action:
Emailing your image. ..

Command to execute:

“C:'\Program Files\BreezeSysHotFolder Prints‘email_image.exe” +{user1} -osales@breezesys.com “{parentDi

Display touchscreen keyboard

Folder containing keyboard. xml file and images:

C:\¥eyboardLayouts\Email [I]

Ok ][ Cancel I

The command to execute should call the Hotfolder Prints email_image.exe command and pass it the
JPEG image that has been formatted for emailing (which is in the "email" subfolder. To do this the
image pathname is defined as {parentDirf\email\{file}. This is because BreezeBrowser Pro is viewing
images in the "Prints" folder: C:\Photos\2011-05-17\Prints and we need to email the image in the
"email" folder C:\Photos\2011-05-17\email. The token {parentDir} returns the path C:\Photos\2011-05-
17 and so {parentDirf\email gives the correct folder: C:\Photos\2011-05-17\email and we just need to
add the filename using the token {file}. The command will look something like this:

"C:\Program Files\BreezeSys\HotFolder Prints\email_image.exe" -r{userl} -osales@breezesys.com
-s""Photos from John®"s Birthday" "{parentDir}P\email\{file}"

When kiosk mode is selected the user will see a screen similar to the one below. As more photo booth
images are taken during the course of the event they are added to the list of thumbnails down the left
hand side. The user can print an image by touching the main image and selecting "Print" from the
menu.
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The user can email an image by touching the image and selecting "Email" from the menu. When the
user selects "Email" the touchscreen keyboard is displayed so that they can enter their email address.
The screenshot below shows the default keyboard layout which can be customized if required (please
see the section on the_touchscreen keyboard for details).

Please enter your email address:

sales@breezesys.com

Delete

Send email No thanks!

If the user enters their email address and then the "Send email" key the touchscreen keyboard is
dismissed and the email address can be passed to the command using the {user1} token:

"C:\Program Files\BreezeSys\HotFolder Prints\email_image.exe" -r{userl} -osales@breezesys.com
-s"Photos from John®"s Birthday" "{parentDir}\email\{file}"
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2.5 Slideshow

The slideshow is a convenient way to present images to people in a simple, uncluttered way. It is also
a useful way to get a quick overview of a set of images and for selecting the best images from a shoot
using the tagging options (described in more detail below).

The slideshow mode can be entered from main view or from one of the thumbnail views. If it is run
from main view the slideshow will display all of the images in the current folder starting with the first
image. If slideshow is entered from one of the thumbnail views it will only display the currently selected
images. A menu of the available options can be displayed by right clicking the mouse in the slideshow
window.

The slideshow window fills the display and by default has a black background. Images are resized to fit
the screen and there is an optional caption displayed above or below the image. A small blue tick mark
is displayed if the image is tagged.

When the slideshow is started it will automatically advance to the next image using the currently
selected time interval. The slideshow can be paused by typing Ctrl+S or by using cursor keys to select
the next or previous image. Press the Esc key to exit slideshow mode or press the right mouse button
to display a menu of options.

Images can be rotated and tagged using the menu options or keyboard shortcuts.

If the option to monitor the folder for changes is selected in Preferences the slideshow will be updated
automatically when images are added, deleted or modified in the current folder. This is useful for
applications such as event photography where a slideshow is left running and is automatically updated
to show new images as they are added.

The mouse cursor will automatically disappear if the mouse is not moved for 1 or 2 seconds. Simply
move the mouse to make the cursor reappear.

2.5.1 Display options

Images can be displayed in color or in black and white. To toggle between color and black and white
display type Ctrl+W or right click the mouse and select "Black and White" from the menu.

High quality mode sharpens the image before displaying it (the original image isn't affected). This gives
a sharp clear image which is a good indication of how the image will look after it has been enhanced in
an image editor such as Photoshop.

Select "View Actual Image..." to display the image full size in a separate window. The image can then
be zoomed and panned to examine it in more detail.

The image caption can be displayed above or below the image or disabled by right clicking the mouse
and selecting the appropriate option from the menu.

The caption and other display attributes such as frames can be edited by running the slideshow and
then right clicking the mouse and selecting "Slideshow display options..." from the menu. The dialog
below will be displayed:
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Slideshow Display Options @

Caption
Pleaze enter the shideshow caption farmat zting [use hn for line breaks):

EdirEEE [@imageumben@ of @numberlfimages@]

The format gtring can uze the zame tokens az the HT ML generatar to extract
information from the EXIF data e.g. (@dated@ to extract the date and @filed
for the filename.

Fant: ..-’-'-.rial,1EI point, bold [:] Font colar: E]

B ackground
Background colar; [:]

Enable picture frames
Frame image:
drop zhadow &0 E]

Restore Defaults] [ 0k, ][ Cancel

The slideshow caption is defined by a format string which uses tokens to display information about the
current image. Most of the tokens available to the HTML generator can be used in the slideshow
caption (please see HTML Tokens page for a complete list of the tokens). The default format string is:
@dir@@file@ [@imageNumber@ of @numberOfimages@]

This displays the directory and filename of the image followed by the image number and the total
number of images in the slideshow.

Additional information extracted from the shooting data in the image can be added by using the
appropriate tokens. For example the following format string would display the image filename with the
date the image was taken and a summary of the camera settings on separate lines:

@file@ [@imageNumber@ of @numberOfimages@]\n@date@\n@model@, @shutter@sec @
f@aperture@, 1SO @iso@

This would produce a three line caption like:
GR5F5159.CR2 [9 of 74]
12 May 2006
Canon EOS-1D Mark II, 1/200sec @ 5.6, ISO 200

The font type, style and color can also be selected by clicking on the "..." buttons in the dialog.

The slideshow background color and an image file to use to frame the image can be selected in the
"Background" section of the dialog. Click on the "..." button after the background color box to define a
new background color.

When picture frames are enabled you can select a frame by clicking on the "..." button to the right of
the text box showing the current frame name. A selection of frames can be found in the "frames" folder
where BreezeBrowser Pro is installed. Please see the section on Guidelines for creating border
images for information on how to define your own picture frames.
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2.5.2 Automatically displaying images

When the slideshow is started it automatically advances to the next image using the current interval
setting. The slideshow interval can be changed by right clicking the mouse and selecting "Interval”
from the menu. The interval can be set from "As fast as possible" up to 10 minutes per picture.

If the option to "Monitor folder for changes and update display automatically” is set in preferences the
slideshow will be updated automatically to include files that have been added to, deleted from or
renamed in the current folder.

When the last image is displayed the slideshow will stop unless the "Loop" option is selected from the
right click menu. When the "Loop" option is selected the slideshow will continue playing from the first
image after it has displayed the last image.

Normally the images are displayed in sequential order but they can be displayed in random order by
right clicking and selecting "Play in random order" from the menu. To ensure each image is displayed
each loop of the slideshow this works in a similar way to shuffling a deck of cards then dealing each
card in turn before shuffling again and repeating the process. When the "Monitor folder for changes
and update display automatically" option is used with the random display order option newly added
images will be displayed next. This is useful when displaying a slideshow of images from an event
because it allows all the images from the event to be displayed in random order but also displays
newly added files next.

2.5.3 Manual navigation

Use the cursor right and left keys or the mouse wheel to select the next or previous image. The
slideshow will automatically pause if it was running. The slideshow can be resumed by typing Ctrl+P or
by selecting "Play" from the right click menu.

The slideshow caches the last few images displayed and pre-loads the next image to allow faster
stepping between images. The slideshow cache size can be set in Preferences.

Two-button mouse operation is useful when giving presentations. When this is selected the left mouse
button advances the display to the next image and the right button displays the previous image. Hold
the Shift key down when clicking the right mouse button to display the right click menu. Alternatively
type Ctrl+M to turn off two-button mouse operation.

2.5.4 Ranking images in the slideshow

The ranking of an image can be set by pressing the number keys 1 to 5. Pressing the 0 key will set the
ranking to none. If "Advance after ranking/tagging" is selected (by typing Ctrl+R or by right clicking and
selecting it from the slideshow menu) the next image will be displayed after pressing one of the
ranking keys (1 to 5 or 0) or when tagging/untagging an image. This option is useful if you wish to rank
a large number of images.

You can also increase the ranking by holding down the Ctrl key and pressing cursor up and decrease it
by holding down the Ctrl key and pressing cursor down. You may also use the Shift key to avoid
accidentally rotating images when you move to the next image (Ctrl+Cursor Right rotates an image).
Please see the section on Image Ranking for more details on ranking images.

Tip: Edit the slideshow caption to include @ranking@ to display the ranking for the image. To do this
right click the mouse and select "Edit caption text, font and color..." from the menu (See Display
options for details)
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2.6
2.6.1

Using tags

One of the display options in slideshow is "View tagged images only" and this can be very useful for
selecting the best images from a shoot e.g. selecting 100 images for a preview album from a raw take
of 1000 images from a wedding.

To start the selection process first switch to one of the thumbnail views, select and tag all the images,
enter the slideshow, pause it and select the "View tagged images only" option. This may sound
complicated but can be selected very quickly by typing the following sequence:

Ctrl+A

Ctrl+Shift+T

Ctrl+S

Ctrl+S

Ctrl+T

Now use the cursor left and right keys to step through the images. Reject unwanted images by using
the cursor down key to untag the image. The image will be automatically removed from the slideshow
and the number of images remaining will be displayed in the caption. Quickly step through the images
using the left and right keys removing the obvious rejects using the cursor down key. If an image is
accidentally rejected and it can be reinstated by typing Ctrl+Z to undo the untagging.

When you've finished press the Esc key to exit the slideshow and all the "keepers" will be tagged ready
for the next step in your workflow. Press F6 to select only the tagged images ready for the next
operation.

Image comparison

Overview

The image comparison window can be used to compare two, three or four images together. To display
the image comparison window first switch to the thumbnail or filmstrip view and select the images to
be compared. Then right click on one of the images and select "Compare images..." from the menu. If
two images are compared the window will be split horizontally with the first image displayed at the top
and the second image at the bottom. The images can be displayed side by side by right clicking the
mouse and selecting "View side by side" from the menu or by pressing the TAB key. If three images
are compared they will be displayed side by side. If four or more images are selected they will be
displayed in a 2x2 grid as shown below:
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K] BreezeBrowser Pro - Compare Images (6 images selected, 4 displayed) |Z“E|fz|
[ | GREF5173.CR2 [1024x1536 & 37%] [ GREF5175.CR2 [1024:1536 & 373

| < | £ i
GR5F517E.CR2Z [1024x1536 (& 37%] [ ] GREF5180.CR2 [1024:1536 (& 37%]

|

The filename of each image is displayed above or below the image together with the image
dimensions followed by the magnification expressed as a percentage of the actual size. The checkbox
to the left of the caption shows whether the image is tagged. Images can be tagged and untagged by
clicking on the checkbox or by pressing F1 for the first image, F2 for the second image, F3 for the third
image or F4 for the fourth image.

Use the scrollbars to scroll individual images or move all the images together by holding down the left
mouse button and moving the mouse. Zoom in and out using the mouse wheel or the numberpad +
and - keys. Right click the mouse to display a menu of the available options.

When more than four images are selected

Only the first four images are displayed when more than four images are selected. Right click the
mouse and select "Next" or "Previous" from the menu to view the other images. When "Next" is
selected images two, three and four move to the previous pane and image five is displayed in the
bottom, right hand pane.

Right click on an image and select "Hold image" to hold it. When an image is held it will remain
displayed when next or previous images are displayed. This is useful when sorting through a set of
similar images trying to select the best one. Start off by holding the best image in the first screen and
using next/previous page to compare it with the other images, holding other images which are worth
shortlisting. The held images can be arranged so that they are displayed first by selecting "Arrange
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2.7

2.7.1

held images" from the right click menu or by typing Ctrl+A.

Using the mouse and keyboard shortcuts

Using the mouse

Use the mouse wheel to zoom in and out (all images will zoom at the same time). Press the left mouse
button and move the mouse to scroll all the images together. To pan one image on its own either use

the scrollbars for that image or hold the Shift key down, press the left mouse button and move the
mouse. Right click the mouse to display a menu of the available options.

Keyboard shortcuts
The following keyboard shortcuts can be used:

Cursor left/right  Pan the images horizontally
Cursor up/down  Pan the images vertically

Keypad - Zoom out

KeyPad + Zoom in

F7 Zoom to actual size

F8 Zoom out

F9 Zoom in

Home Center images

Ctrl+A Arrange images so that held images are displayed first

Ctrl+N Next image (when displaying more than 4 images)

Ctrl+P Previous image (when displaying more than 4 images)

Ctri+T Tag held images (doesn't untag images which are not held)

PageDown Next page of images (when displaying more than 4 images)

PageUp Previous page of images (when displaying more than 4 images)

F1 Tag/untag the first image

F2 Tag/untag the second image

F3 Tag/untag the third image

F4 Tag/untag the fourth image

Ctrl+F1 Hold/release first image

Ctrl+F2 Hold/release second image

Ctrl+F3 Hold/release third image

Ctrl+F4 Hold/release fourth image

TAB Toggle between side by side and one above the other display (when comparing two
images)

Printing contact sheets

To print contact sheets, switch to thumbnail view and select the thumbnails to be printed. To print full
size images switch to main view.

Page and Printer setup

First use the Print Setup dialog to select the printer, paper size and orientation. Then use the Page
Setup dialog (shown below) to control how images are printed. The units for the various
measurements will be shown in mm or inches depending on your computer settings.
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Page Setup g|
Fage karging and Backaround
Top:  [10mm 2| Left  (Smm 2|
Battarn: {10mm 5| Right: | 5 mm

w |

] Swap left and right marginz when printing even pages

B ackground: | Calor 1 . D

Fullzize Imagez
Output DP; | 240
Fezsize image to fit page Fotate image to fit page
Crop image ba fit printable area

Image placement: | Center on page w |

Contact Sheet [Thumbnailz)]

Fs
N 1

“ | Thumbrail rows: | 4

w |

T hurnbnail columns: .3

£

Spacing bebween thumbnails: _.3 i .v &dd border

Fiatate thumbnails: _EI FF w

b ake portrait and landzcape thumbnails the zame size

Thurnbnail caption [uze Yy for line breakz):
| @fileMoE k@ '

Footer text [uze n far line breaks]: Footer Fort...

| (@dintz, F'agie (Tpagee of GEnumPages(@

[ Load... ] [ Save... ] [ 1] ][ Cancel ]

The page margins section defines the size of the printing area on the page for both contact sheet
printing and for printing full size images. To use the full printing area available set the margins to 0. Set
the left margin to a larger value (e.g. 15mm) if you intend to punch holes in the paper to store it in a
ring binder.

Most printers cannot print right to the edge of the paper and when the page margins are outside the
printing area BreezeBrowser Pro will adjust them to fit automatically.

The "Swap left and right margins when printing even pages" option is useful when printing on double
sided paper with a duplex printer when you want have a larger margin on one side of the page for
binding e.g. If the left margin is set to 25mm and the right margin is set to 5mm the first page will have
a 25mm left margin, the second page will have a 5mm margin etc.

Use the "Background" dropdown list to specify the page background. The default setting is "None".
When the background is set to "Color" the page will be filled with the selected color. Click on the "..."
button to select a different color. The background can also be set to a background image. The
background image is assumed to be 240dpi (i.e. a 240x240 pixel image will be output as a 1 inch
square) and is tiled to fill the page.

Please note: The default color for the caption and footer text is black. If you select a dark background
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for the page you may need to change the text color for it to be visible. To do this click on the "Caption
Font..." or "Footer Font..." button and select a new text color.

Contact sheets

To print contact sheets you must first switch to thumbnail view and select the images you want to be
printed. Then select Print Preview to preview the printed pages or Print to print the pages.

Use the Page Setup dialog to adjust the layout of the contact sheet. The "Thumbnail columns" and
"Thumbnail rows" settings control the number of thumbnails that are printed on each page and
"Spacing between thumbnails" specifies the gap between each thumbnail.

Select "Add border" if to add a thin black border around the images. Normally images look better with a
border, but if the images have been prepared with a border or frame already (e.g. a drop shadow
effect) the border added during printing can be turned off.

The thumbnail images can be rotated so that they fit the page better by selecting one of the following
options from the "Rotate Thumbnails:" dropdown list:

1. OFF - The thumbnails are not rotated and are printed as they appear in BreezeBrowser Pro

2. To match page orientation - When the page orientation is landscape portrait thumbnails are
rotated to landscape and landscape thumbnails are unchanged. When the page orientation is
portrait landscape thumbnails are rotated to portrait and portrait thumbnails are unchanged.

3. To landscape orientation - Portrait thumbnails are rotated to landscape and landscape thumbnails
are unchanged.

4. To portrait orientation - Landscape thumbnails are rotated to portrait and portrait thumbnails are
unchanged.

Thumbnail images will be resized to fill the area available to them. This can result in portrait and
landscape (vertical and horizontal format) images being different sizes. Click on the "Make portrait and
landscape thumbnails the same size" to prevent this happening. e.g. if the area available for printing
the thumbnail is a rectangle 600 pixels wide by 400 pixels high and landscape thumbnail would fill this
area whereas a portrait thumbnail would be resized to 267 x 400 pixels. If "Make portrait and
landscape thumbnails the same size" is selected the landscape thumbnail would be resized to 400 x
267 pixels to match the size of the portrait thumbnail.

Each thumbnail can have an optional caption printed below it. The default setting is "@file@" which
prints the filename of the image. You can use any of the tokens defined in the HTML Page Generation
section to caption the image using EXIF shooting data extracted from the image. You can also insert
"\n" to add a line break so that the caption is printed on more than one line.

Examples:

To print the image filename with the date the picture was taken on the line below:
@fle@\n@date@

To print the image filename, shutter speed, aperture and 1SO setting:
@file@\n@shutter@ sec @ f/@aperture@, ISO @iso@

To print the image filename and the lens focal length:
@file@\n@lens@mm @ @focalLength@mm

To print the image filename with a one blank line before the caption and two after (the @empty@
token is required otherwise the leading and trailing "\n" new lines will be ignored):
@empty@\n@file@\n@empty@\n@empty@

Captions will automatically word wrap onto the next line if they are wider than the available space.
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When "Make portrait and landscape thumbnails the same size" is selected in "Page Setup" the
thumbnails are top justified and vertically centered within the area available to them and as many lines
of the caption as possible are printed.

When "Make portrait and landscape thumbnails the same size" is not selected the the thumbnails are
vertically centered within the area available to them unless the caption is too long in which case the
thumbnail is moved up and if necessary made smaller to make space for the caption. The thumbnail
won't be resized less than 1/3 than the height available to it in order to make space for the caption. If
the caption contains more lines than the available space the extra lines won't be printed.

The font used for thumbnail captions can be changed by clicking on the "Caption Font..." button.

Each page can have an optional footer that is printed at the bottom of the page. If this is left blank no
footer is printed and the space is made available for printing the thumbnails. The footer may contain
the following tokens:

@dir@ - the full pathname of the directory containing the images e.g. C:\Photos\2003-09-28
@parent@ - then name of the directory containing the images e.g. 2003-09-28

@date@ - the date the contact sheet is printed (i.e. today's date)

@time@ - the time the contact sheet is printed

@page@ - the current page number

@numPages@ - the total number of pages necessary to print all the selected images
@volumeName@ - the name of the disk drive

The font used for footer text can be changed by clicking on the "Footer Font..." button.

2.7.3 Full size images

To print an image full size you must first switch to main view and display the image to be printed. Then
select Print Preview to preview the printed output or Print to print the image.

Use the Page Setup dialog to adjust the layout of the page. The output DPI setting specifies the
number of dots (i.e. pixels) per inch output to the printer. For most inkjet printers a value of around
240dpi should produce good results. This value should not be confused with the resolution of the
printer which may be between 1200 and 2880dpi (inkjet printers output different colors by "dithering"
several ink dots and need many ink dots to accurately render the color of each pixel).

The "Resize image to fit page" checkbox tells BreezeBrowser Pro what to do if the image is smaller
than the printable area on the paper. If this value is unchecked the image will not be resized and its
size will be determined by the size of the image and the output DPI setting e.g.

An image 1200x720 pixels with an output DPI setting of 240dpi will be printed as 5 inches (1200 pixels
/ 240dpi) by 3 inches (720 pixels / 240dpi).

If the "Resize image to fit page" checkbox is checked the image will be resized using high quality
interpolation so that it fits the printable area at the specified output DPI. Taking the same image as the
example above and printing on paper which has a printable area of 10 inches by 8 inches the image
would be scaled by 200% to fit the page. The printed image will be 10 inches by 6 inches, printed at
240dpi (2400 pixels x 1440 pixels).

The "Crop image to fit printable area" checkbox will crop the image top and bottom or left and right so
that it fits the printable area of the page. This option is normally intended to be used when printing
borderless prints when it is necessary to crop the image so that it fills the page.

Use the "Image Placement" dropdown list to specify where the image will be printed on the page. "Top,
left justified" will place the image in the top left corner of the printable area of the page. "Top justified"
places the image at the top of the printable area and centers it between the left and right margins.

To print the image as large as possible set the image placement to "Center in printable area" and
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select "Resize image to fit page" and "rotate image to fit page".

Many printers have a maximum printing area which has larger margins at the top and bottom than at
the left and right. If the maximum printing area is used (i.e. fit image to page is selected) this can result
in an uneven margin around the image. To avoid this set the image placement to "Center on page" and
BreezeBrowser Pro will ensure that the top, bottom, left and right borders are all the same size.

Select "Rotate image to fit page" to fill the page with the image. When this option is selected
BreezeBrowser Pro will rotate the image if required so that it fills the page. e.g. when printing an image
with landscape orientation when the printer is set to portrait orientation BreezeBrowser Pro will rotate
the image to portrait to make best use of the printable area.

For more control over the printed image use proofs to create images sharpened and resized as
required.

Color management

If a monitor and printer color profile are selected in Preferences BreezeBrowser Pro will use these
when displaying print preview and printing images. Color profiles can help to get consistent color
displayed on screen and in printed output. It may be necessary to experiment with different printer
settings to get the best results. For example, if you are using an Epson printer the Color Management
in the driver settings should probably be set to "No Color Adjustment”. A detailed description of color
profiles is beyond the scope of these help pages. lan Lyon's site http://www.computer-darkroom.com
has some excellent information on the use of color profiles.

Printing to file

Select "Print to File..." from the File menu to print individual images or contact sheets and output them
to JPEG, PNG or TIFF images. In main view this option will output individual images and in the
thumbnail or filmstrip views it will output a contact sheet of the selected images. It uses the same
settings as Page Setup to format the output.

The following dialog is displayed when "Print to File..." is selected:
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Print to File

Page Size

Size: | A4 w DPI: | 200
Cuskam Size: | x [ pixels

Orientation: (%) Portrait () Landscape
1653 x 2338 pixels (210mm x 297mm @ 200 DPT

Outpuk Settings

Format: | JPEG v | Quality (0ta 100): | 75

Filename prefix: [ pane | e.]. pagedlZ.ijpg

Outpuk Directary:

H:\20041,2004-08-1 4\prints ' B
Prink l [ Cancel ]

Select the page size from the Size drop down list. You can either select one of the predefined page
sizes or select a custom size and enter its dimensions in pixels. Use the DPI setting to select the
number of dots per inch - this is used to calculate the page size in pixels when using the preset page
sizes.

Use the output settings section to specify the output image type (and quality for JPEGs), how the
images will be named and where they will be stored. The default filename prefix is "page" which will
name page 1 as "page001.jpg", page 2 as "page002.jpg" etc.

The default output folder is a folder called "prints” created in the same folder as the images.

The preset page sizes are stored in a data file called "page_sizes.dat" in the "print settings" folder in
the BreezeBrowser Pro installation folder. This file can be edited using a normal text editor (e.g.
wordpad) to add your own custom sizes. To add a new page size simply add a new <page...> line to
the file:

<?xml version="1.0" ?>
<breezebrowser version="3.0">
<page_sizes>
<I-- widths and heights are in 1/10mm -->
<page width=""2100" height="2970"">A4</page>
<page width=""1000" height=""1500"">10x15cm</page>
<page width=""3048" height="4064"">12x16</page>
<page width=""2540" height="2032">8x10</page>
<page width="1270" height="1778">5x7</page>
<page width=""1016" height="1524">4x6</page>
<page_sizes>
</breezebrowser>

The <page...> tag defines the page width in height in units of 1/10mm (1 inch is exactly 25.4mm or 254
tenths of a mm). The portion between the <page> and </page> tags is the value that will be displayed
in the Size drop down list in the "Print to File" dialog.

e.g. A4 paper is 21cm wide and 29.7cm high (2100x2970 in tenths of a mm) and so the line defining it
is: <page width="2100" height="2970">A4</page>
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Batch Renaming

The 'Batch Rename' dialog allows all the images in a directory to be renamed using a number of
different naming schemes. Seven predefined naming schemes are provided together with three
custom settings for defining your own schemes. The predefined schemes are:

1. Standard - follows Canon's naming scheme of CRW_ or IMG_ followed by four digits e.g.
CRW_0002.crw and IMG_0001.jpg

2. Enhanced - similar to 'Standard' but has five digits instead of four digits and allows numbers up to
99,999.

3. Numbered - similar to 'Standard' but has the number first. This has the advantage of numeric
order being the same as alphabetical order.

4. Date - uses the date in the form YYMMDD followed by a three digit sequence number

5. Date + Type - similar to 'Date’ but adds the file type (e.g. CRW3 for raw or IMG for JPEG) to the
end of the filename

6. Date/Time - uses the date in the form YYMMDD followed by the time in the form HHMMSS and a
one digit sequence number (to distinguish shots taken at 3fps)

7. ZoomBrowser-style - uses the same naming scheme as ZoomBrowser: fff-nnnn_ttt.ext where
fff=folder, nnnn=image number, ttt=type (e.g. CR3 for raw, IMG for JPEGs, STx for stitch assist)

Batch Rename g|

Filenarme Shyle:
: Special characters [Press F1 far more);

%d date e.g. 010729

. Ettime e.g. 103506 for 10:35:06am

Style: | DateTime M| %fimage format e.g. CRW or IMG

%n zequence number

#d_E_Fu

Upper/lower case converzsion: | Unchanged w
Sort By Sequence Mumbers:
(%) Image Mumber Continue numbering fram last time
O Alphabstical Firzt Murnber:
" Image Time and Date
) A5 Displaved Mumber of digitz: |1
GREFA158 CR2 --» 040808_162150_1.CR2 A

GREF5159.CRE --» 040808 _162152_1.CR2
GREFE1E2.CRZ --» 040808 _162326_1.CR2
GRE5F5165.CRZ --» 040805_162426_1.CR2
GREFE1EI.CRZ --» 040808 _162517_1.CR2
GREF5171.CRZ --» 040808 _162611_1.CR2
GRESF5172.CRE --» 040808_162622_1.CRZ
GR5F5173.CRZ --» 040808 _162633 1.CR2
GR5F5175.CRZ --» 040808_162637_1.CR2
GREF517E.CRZ --» 040808 _162633 1.CR2
GREFE180.CRZ --» 040808 _162717_1.CR2
GREF5182JPG --» 040808_162745 1.JPG
GREFE124.0PG --» 040303 162748 1.0PG »

R ename Selected] [ Cancel

The 'Example Filenames' display at the bottom of the dialog shows the current names and new names
of all the images in the directory. The size of the example filenames display can be increased by
resizing the dialog.
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The 'Sort By' option defines the order in which the files are listed (using their current names):

¢ Image Number - sorts the images according to the image's number e.g. CRW_0002.crw has a
value of 2 and would come after IMG_0001.jpg which has a value of 1.

¢ Alphabetical - sorts the images alphabetically. In this case CRW_0002.crw would come before
IMG_0001.jpg.

¢ Image Time and Date - sorts images in chronological order using the EXIF date and time or the

file creation time if the EXIF date and time are not available.

e As Displayed - uses the same order the images are displayed in thumbnail view.

By default sequence numbers start from 1, but you can specify any starting number you like. Select the
"Continue numbering from last time" if you would like BreezeBrowser Pro to continue humbering from
the last sequence number next time you batch rename images.

Use the "Upper/lower case conversion:" drop down list to select whether the case of filenames is
changed when they are renamed. This can be useful for images which are to be used in HTML pages.
(Web pages are case-sensitive whereas the Windows filing system is not and this can lead to
problems when publishing web pages). The options are:

filename is preserved e.g. Test.JPG becomes Test.jpg

becomes test.jpg

becomes TEST.JPG

Unchanged - the case of the filename and its extension are preserved
Convert extension to lower case - the file extension is converted to lower case and the rest of the

Convert filename to lower case - the whole filename is converted to lower case e.g. Test.JPG

Convert filename to upper case - the whole filename is converted to upper case e.g. Test.JPG

Select the Custom style for more control over how files are renamed e.g.

1. Prefix the filename with the subject: Jones Wedding %0
2. Prefix the filename with the ISO (useful for sorting images by ISO when using noise reduction

software): %i_%0
3. Rename as the date and time the picture was taken plus the image number: %d%t_%r

The special characters below can be used for extracting information from the image:

Character |[Meaning Example
%d Date in the form YYMMDD 010930 for 30 Sept 2001
%t Time in the form HHMMSS 223415 for 10:34:15pm
%f Image file type e.g. CR3 for Canon raw files, IMG
for JPEGs, STx for panoramic
images
%X The file extension jpg for IMG_0123.jpg
%n Sequence number (incremented for each file) 0001, 0002, 0003 etc.
%N Canon sequence number in the form dddnnnn 4010123 for image 0123 in folder
where ddd is the original image folder and nnnnis [401
the image number (read from EXIF data in JPG or
THM file)
%e Frame number when shooting in continuous drive |01, 02, 03 etc.
mode
%q Canon folder number (not available with Canon 1D |401 for image 0123 in folder 401
series cameras or the EOS 5D)
%r Canon image number (this info is stored in the 0123 for image 0123 in folder 401
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shooting data for Canon PowerShot cameras and
most EOS cameras except the 1D series). For
cameras which don't store this information in the
shooting data %r extracts the last 4 digits of the
filename or reverts to %n if the filename doesn't
end in 4 digits)

%cC Camera serial number (Canon EOS cameras only) 10230200987

%C Canon EOS 1D/1DS style serial number - takes the |[4FA
last three hexadecimal digits of the serial number

%T Camera model name. This extracts the first word |10D for "Canon EOS 10D",
containing numbers from the camera model name |EOS-1DS for "Canon EOS-1DS"

%V Similar to %T, but treats '-' characters as spaces |1DS for "Canon EOS-1DS"
when extracting the camera model

%u Lowest number to give a unique name. Useful 1, 2, 3 etc.
when using %t and camera takes shots at more
than 1 fps

%U Lowest number prefixed with _ to give a unique <empty>, 1, 2, 3etc.
name or empty string if there are no duplicates.

%0 Original filename CRW_0001

%F Focal length in mm 28

%A Aperture 5.6

%S Shutter speed 125 for 1/125 sec

%i ISO 100

%Y Year with century 2001

%y Year without century 01

%m Month (01 to 12) 09 for September

%W Week number (00-53) 38 for last week in Sept 2001

%D Day of month (01-31) 29

%a Abbreviated day name (note: may vary with locale) [Sat for Saturday

%b Abbreviated month name (note: may vary with Sep for September
locale)

%H Hour (00-23) 23 for 11pm

%I Hour (00-12) 11 for 11pm

%M Minute (00-59) 53

%S Second (00-59) 07

%[n] Extracts the n'th character from the original %[3] extracts G from IMG_1234
filename

%[n-] Extracts characters from original filename starting |%[2-] extracts MG_1234 from
with the n'th character to the end of the name IMG_1234

%[Nn-m] Extracts characters from the n'th to the m'th %[3-5] extracts G_1 from
characters from the original filename IMG_1234

%][-n] Extracts the last n characters of the original %][-4] extracts 1234 from IMG_1234
filename

%![n] Extracts everything except the n'th character from |%![3] extracts IM_1234 from
the original filename IMG_1234

%![Nn-] Extracts characters before the n'th character from |%![3-] extracts IM from IMG_1234

original filename
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token except ones starting with '{’).

%![n-m] Extracts everything except characters from the n'th |%![3-5] extracts IM234 from
to the m'th characters from the original filename IMG_1234
%![-n] Extracts everything except the last n characters of |%![-3] extracts IMG_1 from
the original filename IMG_1234
{left,n,str} |Extracts the first n characters from str (which can |{left,4,@model@} for an image
be a string or any token except ones starting with  |taken with a Nikon D300 will give:
‘. Niko
{mid,n,m,st |Extracts m characters starting from the n'th {right,1,4,@model@} for an image
r} character from str (which can be a string or any taken with a Nikon D300 will give:

ikon

{right,n,str}

Extracts the last n characters from str (which can
be a string or any token except ones starting with

1).

{right,3,@model@} for an image
taken with a Nikon D300 will give:
300

string or any token except ones starting with '{’).

{first,str} Extracts the first word from str (which can be a {first, @model@} for an image taken
string or any token except ones starting with '{’). with a Nikon D300 will give: Nikon
{last,str} Extracts the last word from str (which can be a {last,@model@} for an image taken

with a Nikon D300 will give: D300

Additional tokens

The HTML tokens (e.g. @caption@) may also be used to rename images. Any characters unsuitable
for Windows filenames (e.g. \/:*? <>|" or new line characters) are converted to underscores to
avoid illegal filenames. Repeated underscores are replaced by a single underscore.

Please take care that the filenames don't become excessively long when using the HTML tokens.

NOTES:

1. Dates and times are taken from the EXIF date time information in the image file. If the EXIF
information is not present the file's timestamp is used instead.

2. Allimages are renamed in the main view. You can rename selected images by switching to
thumbnail view

3. The following characters are not allowed in Windows filenames: \/:*? <> | "

2.9

Overview

GPS Support

Location data stored in images (latitude and longitude) can be displayed in BreezeBrowser Pro by right
clicking on an image and selecting "Image Properties”. The location where a photo was taken can be
viewed using an online map site by right clicking on the image and selecting "View map". The location
can also be displayed automatically in Google Earth as images are browsed using BreezeBrowser Pro.

A web gallery containing a map showing thumbnails and image locations can be generated using
BreezeBrowser Pro's GPS template (please see below for details).
Example gallery generated using the GPS template

Latitude and longitude information is normally gathered using a GPS receiver which stores location
data in the form of a track log (a list of positions and timestamps). There are two common standard
formats for track log files: GPX and NMEA. Most modern GPS receivers can store track logs in GPX
or NMEA format. The free utility GPSBabel can be used to convert between a wide range of formats if

required.
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A few cameras can connect directly to a GPS receiver and automatically store the location data in the
image as it is taken but most cameras need to have the location data added after the shots are taken.

The process of copying location data to an image is known as "geo-tagging". Location data is normally
stored in the form of EXIF shooting data in JPEG or TIFF files or as Adobe XMP data in an XMP
sidecar file for raw files. (An XMP sidecar file is a file of the same name as the main image but with a
file extension of .XMP e.g. the XMP sidecar file for the Canon raw file IMG_1234.CR3 would be called
IMG_1234.XMP). BreezeBrowser Pro is able to read location data in either format.

BreezeBrowser can geo-tag images automatically using GPS track logs or manually using Google
Earth. Breeze Systems' Downloader Pro software can also be used to automatically read a track log
file and geo-tag images as they are downloaded. Other geo-tagging applications are available but they
usually only support the geo-tagging of JPEG and TIFF files and require the images to be downloaded
first. Downloader Pro has the advantage that it automates the process of downloading and geo-tagging
images and supports the geo-tagging of both JPEG and raw files. Once the images are geo-tagged
the location data can be viewed using BreezeBrowser Pro or displayed automatically in Google Earth
while browsing in BreezeBrowser Pro.

Automatically displaying image locations in Google Earth when browsing
images

Please note: Google Earth no longer supports the API used by BreezeBrowser Pro
and so this feature has been removed in BreezeBrowser Pro v1.9.10 onwards.

BreezeBrowser Pro can automatically display where an image was taken in Google Earth using the
GPS data from the image. To enable this select the "Auto Display in Google Earth" option from the
Tools menu. With this option selected each time an image containing GPS data is selected in
BreezeBrowser Pro's thumbnail view or displayed in the main view the location will be displayed in
Google Earth. If Google Earth is not already running it will be started automatically.

Please note:

1. Google Earth needs to be installed on your computer and it must have an internet connection in
order to geo-tag images. Google Earth can be downloaded free from http://earth.google.com

2. The "Auto Display in Google Earth" option is automatically disabled when you exit BreezeBrowser
Pro and has to be re-enabled if required each time BreezeBrowser Pro is run

Generating Web Galleries

The GPS HTML template (see HTML Page Generation) generates a web gallery which displays
thumbnail images on a map or using a conventional thumbnail display similar to the drop shadow
template.

Example gallery generated using the GPS template

Please note that you need to obtain a Google Maps API key if you wish to upload the gallery to your
website. The map key should be entered in the HTML preferences so that it can be automatically
added to the gallery when it is generated.

GPS data in images can be accessed in other captions, watermarks and HTML templates using the
following tokens:

@latitude@, @longitude@ Latitude and longitude in the form degrees°minutes'seconds"N/S/E/
W
e.g. 50°15'49.283"N or 4°47'10.427"W
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@latitudeAsDecimal@, Latitude and longitude expressed as the number of degrees
@longitudeAsDecimal@ e.9. 50.263690,-4.786230

Note: always uses . (period/full stop) for the decimal separator
irrespective of the locale

@latitudeAsDecimalLocalized@, [Similar to @latitudeAsDecimal@ and @longitudeAsDecimal@ but
@longitudeAsDecimalLocalized Juses the decimal separator for the computer's locale e.g. , (comma)

@ for most European countries except the UK
@altitude@ Altitude (usually in meters)
@mapKey@ The map key entered in HTML preferences

Suggested Workflow

1. Before taking any pictures it is a good idea to check that the camera's clock is set correctly
The time and date when the pictures are taken are stored in the image files and this is later used to
determine the position from the GPS track log. Making sure your camera's clock is set accurately
will make it much simpler to geo-tag your images later.

2. Turn on a suitable GPS receiver and take take the photos
Any GPS receiver capable of storing track logs with position and time data should be suitable.

3. Download your images and automatically geo-tag them using Downloader Pro
If your GPS receiver has a mass storage mode and stores track logs in NMEA format or GPX format
you can simply connect it to your PC using a USB cable and tell Downloader Pro to read the track
logs automatically.
Track logs from GPS receivers that don't have a mass storage mode need to be downloaded
separately to a folder on the computer's hard disk. If the track log format is not GPX or NMEA it will
be necessary to convert it to GPX or NMEA using a tool such as GPSBabel

4. View the images in BreezeBrowser Pro
If an image contains GPS data the latitude, longitude and altitude can be displayed in
BreezeBrowser Pro by right clicking on the image and selecting "Image Properties". (Please note
that altitude information is not always available and is often less accurate than latitude and longitude
data).
The location where a picture was taken can be displayed in an online map by right clicking on the
image and selecting "View map" (only available for images containing GPS data). The URL used
specify the mapping service can be defined in BreezeBrowser Pro's preferences.
Generate web galleries containing map a location to share with others e.g. using the GPS HTML
template

Useful links

Downloader Pro - a tool for downloading images to your computer and optionally geo-tagging them
automatically as they are downloaded

GPSBabel - a free tool for downloading and converting track logs from a wide range of GPS devices
RoboGeo - a tool for geo-tagging images after they have been downloaded

Google Maps API - information about putting Google maps on your web site

Microsoft Live Search - Microsoft's "Live Search" maps website

Yahoo! Maps - Yahoo! Maps website

2.9.1 GPS Geo-Tagging

Geo-tagging is the writing of geographical information in image files. BreezeBrowser Pro can
automatically geo-tag JPEG and raw files by storing positional information in the form of latitude and
longitude read from track log data from a GPS device. This information is written to the standard EXIF
GPS shooting data stored in JPEG files and in the XMP sidecar file for other image types.

Many handheld GPS devices can store a track log which can be downloaded to a PC. The track log
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contains both positional data in the form of latitude and longitude and the time in UTC (aka GMT).
BreezeBrowser Pro is able to read the track log data and the time each picture was taken and use this
to calculate where the picture was taken. It is important that the camera's clock is set accurately in
order for this to work.

Some GPS devices such as the Sony GPS-CS1 GPS Tracker are designed specifically for
photography and are very convenient to use with BreezeBrowser Pro. The Sony device is simply
turned on before you start taking pictures and automatically logs your position every 15 seconds.
BreezeBrowser Pro can read the GPS track logs and store the latitude and longitude in your files by
comparing the timestamps of the GPS fixes with the timestamps stored in the shooting data of the
images. It can also optionally create a track log file which can be viewed in Google Earth or Google
Maps.

With other GPS devices it may be necessary to download the track logs to your PC before geo-tagging
your images. BreezeBrowser Pro is able to read track log files in NMEA format with a .log or .nmea file
extension. Please consult the manual for your GPS device for information on how to download the
track log to your PC.

Adding GPS data to images from GPS track log files

In BreezeBrowser Pro's thumbnail views first select the images to be geo-tagged and the select "Geo-
Tag Images using GPS data..." from the Tools menu and the dialog below will be displayed. You can
also select this option from BreezeBrowser Pro's main window and the "Tag Selected Images" button
will be replaced with "Tag All Images".
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GPS Geo-Tagging

Time Settings

Local Time: | 15:28:47 GMT: | 14:28:47

Camera is set to lacal time
Offset From GMT (-12 ko 13 hours): |

Camera clock error (-3600 to 3600 secs); [ ]
Camera Time: | 13128147
GRS i window (minutes); | 5 (default=5 minutes)

Track Log Settings

%) Search removable drives or GPS devices
Check...

) Read track log Folder:

Create Google Maps track log Create Google Earth track log
Cutpuk Folder:

[n4GPS Track Logs E]

Google Maps key (not required For local viewing of track logs):

[ Taq Selected Images ” Taq Image ” Cancel

Time Settings

It is important that BreezeBrowser Pro is told what time the camera'’s clock is set to so that it can use
the timestamps of the images to read the location data from the GPS track log. Normally both the
camera and the computer are both set to local time and you only need to select "Camera is set to local
time". If your camera is set to a different time zone from local time "Camera is set to local time" should
be unchecked and the time zone offset wrt to GMT should be entered e.g. New York in the summer
time (during DST) is four hours behind GMT and so a value of -4 for should be entered for the offset
from GMT.

If your camera clock is out by a few minutes you can compensate for this by entering a value in the
"Camera clock error" field.

If you are unsure that the time settings have been set correctly you can check them by comparing the
"Camera time" display with the current time displayed in the setup menus on your camera.

The "GPS fix window" setting specifies how close the time of a GPS fix in the track log needs to be to
the time the picture was taken for it to be accepted. Setting a large value will increase the chances that
a GPS fix will be found in the track log but it may not be very accurate if the GPS track log has gaps in
its data e.g. if you turn the GPS on, take some pictures in one location for a while then turn the GPS
off, drive to a new location and forget to turn the GPS on again before taking more pictures
BreezeBrowser Pro will record the first location for the second set of pictures if the "GPS fix window" is
set to a large value. If the "GPS fix window" is set to a small value (smaller than the time to drive from
the first location to the second location) it won't find a suitable GPS fix in the track log.

Please note: Setting a large value for the "GPS fix window" only affects the accuracy of the GPS data
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stored in the image if there are gaps in the GPS track log. If the GPS track log contains a fix within a
few seconds of when the picture was taken an accurate position will be stored in the shooting data of
the image even if the "GPS fix window" is set to a large value.

Track Log Settings
BreezeBrowser Pro also needs to know where to find the GPS track log files and this is specified in the
"Track log settings" section.

Some GPS devices such as the Sony GPS-CS1 simply need to be connected to the PC using a USB
cable and they will appear as a removable drive. With these types of devices BreezeBrowser Pro will
be able to find the track log files when the "Search removable drives" option is selected.

GPS receivers such as the Garmin etrex Venture CX can also be used in this way provided the track
logs are stored on a data card and the USB Mass Storage interface option is selected (please see the
GPS receiver's manual for details).

Many other GPS devices can't be connected directly to a PC as a removable drive and it is necessary
to download the track log files to the PC. With this type of device you need to download the track log
files to your PC and enter the location of the track log folder in the GPS settings dialog before geo-
tagging your photos.

A summary of the track log files showing the number of GPS fixes they contain and their start and end
times can be displayed by pressing the "Check..." button.

BreezeBrowser Pro reads standard NMEA track log files with a .log or .nmea file extension and GPX
or Garmin ForeTrex XML files with a .gpx or .xml file extension.

BreezeBrowser Pro can generate a track log file that can be viewed using Google Earth or online using
Google Maps. To do this simply select the type of track log files you require and specify an output
folder where BreezeBrowser Pro should write the files. Google Earth track log files have a .kml file
extension and can be viewed by double clicking on the file in Windows Explorer. Google Maps track
log files are web pages and have a .htm file extension. They can be viewed in a web browser by
double clicking on the file in Windows Explorer.

Please note: Google Earth needs to be installed on your computer in order to view Google Earth track
log files. A free download is available on the Google Earth web site. If you wish to display Google Maps
on your website you will need to obtain a Google Maps API key from http://www.google.com/apis/
maps/ (this is free for consumer use) and enter this in the "Google Maps Key" field in the GPS Settings
dialog.

GPS Accuracy

GPS devices are typically accurate to around 10 or 20 meters and usually write track log data at
regular intervals e.g. every 15 secs. Some GPS devices also store altitude data in the track log file but
this tends to be less accurate the the positional data (latitude and longitude). BreezeBrowser Pro reads
the time the picture was taken using the shooting data stored in the image and uses this to interpolate
the position using the location data stored in the track log file.

Please note: Track log data usually isn't written if there is no GPS signal which can happen in built up
areas with tall buildings, in tunnels or inside buildings. When this happens BreezeBrowser Pro will
interpolate between the nearest GPS location data from when a picture was taken and this may result
in an inaccurate position.

Manually adding GPS data using Google Earth

Please note: Google Earth no longer supports the API used by BreezeBrowser Pro
and so this feature has been removed in BreezeBrowser Pro v1.9.10 onwards.
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BreezeBrowser Pro can also read latitude and longitude data from Google Earth and store this in the
shooting data of the files. To do this simply select the "Geo-Tag Images using Google Earth" from the
Tools menu and the main BreezeBrowser Pro window will be replaced by the Geo-Tagging window
below and Google Earth will be started if it is not running already.

Geo-Tagging Image 4 of 7 rg|
IMG_0559,.CR2

[ < Prew ] [ ze0-Tag ] [Tag Al ] [ Mexk = ]

Aukamnatically show in GE Shaw in GE

Image: | 36,0574 M, 12,1409 W, 2086m |

GE:| 36,0574 N, 112,140 W, 2086m |

The geo-tagging window will stay on top of other windows to make it easier to use in conjunction with
Google Earth.

Use the "< Prev" and "Next >" buttons to step through the images to be geo-tagged. Then move the
cursor in the Google Earth window over the position where the photo was taken and press the "Geo-
Tag" button in the geo-tagging window. The latitude, longitude and altitude data read from the Google
Earth window will be written to image and the next image will be automatically displayed. Press the
"Tag All" button to add the current GPS data to all images (overwriting any GPS data which may
already be stored in the images).

The latitude, longitude and altitude of the view currently displayed in the Google Earth window is
displayed at the bottom of the geo-tagging window (labeled "GE:"). If the image already contains GPS
data this will be displayed in the "Image:" line and the "Show in GE" button will be enabled. Clicking on
the "Show in GE" button will update Google Earth to display the position to show the image's latitude
and longitude. If the "Automatically show in GE" check box is selected the Google Earth window will be
automatically updated to show the image latitude and longitude when the "< Prev" and "Next >" buttons
are pressed.

A larger image can be displayed by clicking on the thumbnail image in the geo-tagging window.

Press the escape key or click on the red close box to exit the geo-tagging window and display the main
BreezeBrowser Pro window again.

Please note:

1. Google Earth needs to be installed on your computer and it must have an internet connection in
order to geo-tag images. Google Earth can be downloaded free from http://earth.google.com

2. Altitude data may not be available for all locations and is only displayed when the "Terrain" layer is
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2.10

2.10.1

selected in Google Earth (the Geo-Tagging dialog will select the "Terrain" layer automatically when it
starts up).

IPTC data

IPTC data is a method of storing textual information in images defined by the International Press
Telecommunications Council (http://www.iptc.org). It was developed for press photographers who
need to attach information to images when they are submitting them electronically but it is useful for all
photographers. It provides a standard way of storing information such as captions, keywords, location
and captions. Because the information is stored in the image in a standard way this information can be
accessed by other IPTC aware applications.

Originally IPTC data was stored in a format known as IPTC IIM format but this has now been
superceded by an XML based standard called XMP which has been developed by Adobe Systems Inc.
The IPTC have adopted this standard and defined the "IPTC Core" schema for XMP.

BreezeBrowser Pro now supports XMP format for storing IPTC and XMP data in the following types of
images: JPEG, TIFF, Photoshop PSD, PNG, DNG and raw files. XMP data for raw files is stored in a
sidecar file which has the same filename as the raw file and a file extension of .xmp.

BreezeBrowser Pro always writes IPTC data using the new XMP format and can optionally write the
data in IPTC IIM format to enable legacy applications which don't support XMP to read the IPTC data.
The writing of IPTC data in 1IM format can be enabled in preferences.

The following IPTC IIM datasets do not have equivalents in XMP format and cannot be displayed by
BreezeBrowser Pro: Edit status (7), Object cycle (75), Job id (22) and Program (65). Many of the new
XMP fields do not have equivalent representations in IPTC IIM format and can only be read by XMP
aware applications. You can copy data from the old IPTC IIM fields to XMP using the legacy IPTC IIM
tokens e.g. the token @IPTC_IIM_joblD@ can be used to copy the IPTC IIM job id field into a suitable
XMP field. You can use the "Show tokens" window to display a list of tokens and their values for an
image.

Adding or editing IPTC data does not affect the image quality. The IPTC data fields can be extracted
from images and used in HTML pages (see HTML Page Generation).

References

Information about XMP from Adobe Systems Inc: http://www.adobe.com/products/xmp

Information about the IPTC Core schema (aka IPTC4XMP) http://www.iptc.org/IPTC4XMP

Information about the IPTC IIM standard for data stored in images files can be obtained from the
IPTC's web site: http://www.iptc.org/[IM

A list of NAA/IPTC header codes can be found here:
http://www.ap.org/apserver/userguide/codes.htm

Editing IPTC data

Select a suitable image in main view or thumbnail mode and either right click on the image and select
"Edit IPTC/XMP Data..." from the menu or select the "Edit IPTC/XMP Data..." option from the Edit
menu. These options will be grayed out if the image doesn't support IPTC data.

The IPTC Data dialog is divided up into six different sections: Description, Keywords, Categories,
Contact, Origin and Image. Click on the tabs along the top of the dialog to select the required section.

© 2004 to 2023 Breeze Systems Ltd


http://www.iptc.org
http://www.adobe.com/products/xmp
http://www.iptc.org/IPTC4XMP
http://www.iptc.org/IIM
http://www.ap.org/apserver/userguide/codes.htm

Reference section 63

Tokens can be used to insert information from the image properties and shooting data e.g. use
@time@ to insert the time the image was taken, @iso@ for the 1SO setting, @model@ for the camera
model name. This is particularly useful if you need to add information from the shooting data to a batch
of images. The tokens are the same as used for HTML generation. Press the "Show tokens..." to
display a list of tokens and their values.

Note: Please don't use the tokens for IPTC data (e.g. @IPTC_caption@) as you may get unexpected
results.

The "Load..." and "Merge..." buttons displayed under the image thumbnail can be used to load
previously saved IPTC data. Load will load all the saved data and overwrite the existing data whereas
Merge will only fill in empty fields in the IPTC dialog. The "Save..." button can be used to save IPTC
data to file for future use.

Pressing the "< Prev" or "Next >" buttons will save the IPTC data for the current image and display the
previous or next image. You may also use the keyboard shortcuts Ctrl+[ or PageUp to move to the
previous image and Ctrl+] or PageDown to move to the next image.

A larger preview image can be displayed by clicking the mouse on the thumbnail image (click the
mouse in the window or use the close button in the top right hand corner to close the preview window).

IPTC/XMP Data - GR5F5598.CR2

Drescription iKe_l,lwu:urds Cateqgories | Contact I:Irigin' Image |

Diocument Title: ;tanun EOS-10 Mark 1l raw file

Athor; %Ehris Breeze

Authar Title: i_FTHDthrapher

Deszcription: i-"»-"iew of Boltorn Abbey near Skiptnn,_YDrkshire |

[ < Prew ] [ Mext » ]
Dezcription writer: Ilih_ns Breeze ! Image 3 of 39
Copyright Status: E_Enp_l,lrighted _vl [ Load... ] [ Save tofile... ]
Copyright Motice: %_This picture may not be repraduced in ary form without the 1 [ Merge... ] [Shuw tu:uken&...]

| expreszs written permizzion of the photographer.

Copyright [nfo LIRL: |

rgency: | 5 Mormal b

[ Apply to Selected ] [ Apply J [ Cancel ]

All the data fields under the Description tab are free text entries. The urgency is a number from 0,
meaning "None", through 1 (meaning "High") to 8 (meaning "Low").

The "Use EXIF comment" button can be used to copy the EXIF user comment to the description. If the
image does not contain an EXIF comment this button will be grayed out.

Note: If IPTC captions are selected in preference to EXIF comments the IPTC description will be
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shown in the comment display when viewing images.

IPTC/XMP Data - GR5F5598.CR2

Description | Fewwords |Eategu:uries Contact | Elrigin--i-lmage-i

Enter individual kewwords or a list of kewwords separated by |, or ;

| | Add
['WORLD REGIONS & COUNTRIES

England

Yorkzhire

[ ales

[ < Prew ][ Mext » ]

Image 9 of 39

[ Load... ] [Save tafile. . ]

[ Merge... ”Shuw tu:uken&...]

[ Apply to Selected ] [ Apply J [ Cancel

Click on the Keywords tab to display the keywords. The keywords are displayed in the order they were
entered (as opposed to alphabetical order) and each keyword must be unique and no more than 64
characters in length. To add a new keyword enter the keyword in the text edit area at the top and either

press the Enter key or the Add button. To delete keywords first select them from the list then press the
Delete button.

Press the "Catalog..." button to display a list of pre-defined keywords in the dialog below:
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Keyword Catalog E]
[=- animals e
laboratory animal {research animal, test animalk
[=)- livestock,
[#- cattle {cowst
goat

[+ horse {Equus caballus}
Ex8 pigs {hogs, pig, pigaies, piggy, swine)
[+ poultry
[+ sheep {lamb}
[+ pets {companion animals, domesticated anirmals, pet}
[#- wildlife fundomesticated animalsk
= [WORLD REGIONS & COUMTRIES]
[+ Africa
[+ Antarctica {Antarctick
Archic
Asia
|- Caribbean
|- Central America
Europe !
- Mediterranean I

[

Selected Kesvwords: [ ]include synonyms with selected ketwords
animals; livestock; pigs
Search skring: | swine . Exack match

[ Ok ] [ Cancel

The keyword catalog is read from a simple tab delimited file called keywords.txt in the BreezeBrowser
Pro installation folder (if keywords.txt can't be found BreezeBrowser Pro will try to load
sample_keywords.txt instead). The sample_keywords.txt file included with BreezeBrowser Pro is a
small extract from the controlled vocabulary created by David Riecks. Please visit
http://www.controlledvocabulary.com for details of the considerable benefits of using a controlled
vocabulary for keywords and to purchase the full keyword controlled vocabulary file.

Another source of keywords is the Hierarchical Keyword Catalog from Tim Makins at
http://www.photo-keywords.com. His keyword-catalog is carefully organized in an easy-to-use logical
structure designed so users can quickly 'drill down' through the hierarchical list to find not only the
keywords they are looking for, but also similar keywords to expand the definition, and associated
words to more fully describe the scene.

One other source is the Keyword Catalog written by Shangara Singh and available from
http://www.keyword-catalog.com It covers a broad sweep of subjects, divided into 40 convenient main
categories, subcategories, headings and subheadings. You can load all of the categories or on a
need-to-use basis in order to streamline the navigation. The full version contains over 30,000
keywords but you can pick-and-mix and purchase only the subjects that interest you.

Keywords can be selected by browsing the keyword tree or by entering a search string and pressing
the Find button. Then press the OK button or double click on the item in the tree to copy the selected
keywords to the IPTC/XMP keyword dialog.

Synonyms are shown in braces/curly brackets after the keyword and are included when searching.
Synonyms are only copied to the "Selected Keywords" with the main keyword when "Include synonyms
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with selected keywords" is selected.
In the screenshot above the user has searched for "swine" which is a synonym for "pigs" along with the

synonyms "hogs", "pig", "piggies" and "piggy".

Items enclosed in square brackets are headings to help organize the keywords and are not copied to
the "Selected Keywords" when you click on them.

IPTC/XMP Data - GR5F5598.CR2

Dezcription Ke_l,lwcurds.| Categories IEuntact I:Irigin' -Imagei
Categony [3 chars mas): :-"-"- |
Supplemental Cateqaries;
| ' | add |
Travel
o D]
[ < Prev ] [ et » ]
Image 9 of 39
[ Load... ] [Save to file... ]
[ Merge... ”Shuw tu:uken&...]
Apply to Selected ] [ Apply J [ Cancel ]

Click on the Categories tab to display categories. The main category is a free text entry. The
supplemental categories are displayed in the order they were entered (as opposed to alphabetical
order) and each one must be unique. To add a new supplemental category enter it in the text edit area
at the top and either press the Enter key or the Add button. To delete a supplemental category first
select it from the list then press the Delete button.
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IPTC/XMP Data - GR5F5598.CR2

Address:

Phaore[z):

E mail[=]:

“Wwiebsite[s]:

| Dezcription || K.emwards || Eategu:uries| Contact | Crigin || Imagei

by address

Ciby: |Winchester

State/Province; | Hampshire

Postal Code; |M_I,I postal code

Country: i (]

123456

[ < Prew ][ Mext » ]

Image 9 of 39

[ Load... J [Save tafile. . ]

zales(@breezesys. com

WWW.':IIE-'E-'ZE-'S}'S.CDI'I'I

[ Merge... ”Shuw tu:uken&...]

[ Apply to Selected ] L

Apply

_J [ Cancel

All the data fields under the Contact tab except for priority are free text entries and normally contact
information for the photographer.
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IPTC/XMP Data - GR5F5598.CR2

| Description || Kepwords | Categories | Euntact| Origin !-Image-i

[rate Created: rﬁﬁﬁﬂﬂ_i Time Created: I?EHETE@'IT:@ §

Ciby: i Skipton |

Lec:ation: i Bolton Abbey |

State/Province: |Yu:uurshire |

County: | United Kingdorn Country Code: |GER |
Credit: | Chris Breeze VL[ <Py [ Mews |
Source: | || Image o33
Headine: | Load. |[savetofie.. |
| Merge.. | [Show tokens...|
Instructions:

Tranzmizzion Ref:

[ Apply to Selected ] [ Apply J [ Cancel

All the data fields under the Origin tab are free text entries except for the "Date Created" field. This
must contain a date in the form YYYYMMDD where YYYY is the year including century (e.g. 2006),
MM is the month (e.g. 03 for March) and DD is the day (e.g. 26). An optional : or / character may also
be used to separate the year, month and date. Press the ">" button after "Date Created" to display a
menu to set the date/time to the EXIF shooting date, the file creation date, the current time, yesterday,
two days ago or select any date using the date/time dialog (shown below).
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Select DatefTime b__<|

Mon Tueed Thu Fri Satb Sun
cy ] 1
®l2 .3 4 5 5 7 8
29 10 11 12 12 K 15
4|16 17 18 19 20 21 22
w/(23 24 28 26 27 28 29
w130 H

[ |Today: 30/11/2004

Diate: | 14/08/2004 =

Time: | 120333 2 || Mow

ak. ][ Cancel ]

IPTC/XMP Data - GR5F5598.CR2

| Description || Keywords | Categories | Contact | I:Irigin.| Image |

Rightz zage Terms:

Intellectual Genre: | Hiztony b

IPTC Scene: | 011600

Catalog...

IPTC Subject Code: | 01018000; 10006000

Catalog...

Image 1 of 1

Multiple IPTC Scene and IPTC Subject Code walues may be zeparated by a comma, [ Load... ] [ Save tofile... ]
zemicolon or a new line. IPTC Scene and IPTC Subject Code values are defined at
hittp: / fenenn. newszcodes. org.

[ herge... ”Shuw tu:ukens...]

[. Apply H Cancel

The rights usage field is a free text entry field and is normally used to enter further information about
the image and how it may be used. The intellectual genre field specifies the genre of the image using
the list of genres defined by the IPTC. The IPTC scene and subject code fields should contain a list of
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numeric IPTC scene and subject code values classifying the image. These values use a controlled
vocabulary defined by the IPTC to standardize their usage. Click on the "Catalog..." button to display
the dialog below to select the codes:

IPTC Subject Code Editor [X]

[=I- arks, culture and entertainment A i Description:

anirnation | Areas containing commemorative objects for historical
archaealogy | people or events
| architecture
arts {general)
bullfighting
carkaon
[+ cinema [
[#- culture {general) L
customs and tradition Formal namefCode: | 010185000 i Add
dance |

enterkainment {general)

Current values:

[+ Fashion [ A -
Fective event fincluding carmival 101015000 - monument and hetitage site
| ; ( ? ; | 10006000 - bourism
internet
language

library and museum
[#- literature
[+ rass redia
monument and hetitage sike
[+ music
nightclub
painting
photography
radio
sculpkure
kelevision
[+ theatre et

Find |
[+] ratch whole waord I Ik, ] [ Cancel

[+

[ Remove ] [ Femowve All l

Search skring: | heritage

The IPTC subject code editor is shown above. On the left is a list of subject codes which can be
expanded by clicking on the + and - buttons. When you click on an item in the list its formal name or
code is displayed on the right together with a description of the item. The current values for the image
are displayed on the right and this list can be added to by pressing the "Add" button or by selecting an
item from the list on the left and pressing return. Items can be deleted by selecting the item from the
list on the right and pressing the "Remove" button or the delete key.

You can search for whole or partial words in the name or explanation by entering a search string in the
bottom left and clicking on the "Find" button.

The scene editor is very similar in appearance but only has a single level list of names on the left hand
side.

The values displayed in this dialog (and in the intellectual genre list in the IPTC editor Image section
above) are read from XML news code topicset files supplied by the IPTC. These are stored in the
topicset folder where BreezeBrowser Pro is installed (usually C:\Program
Files\BreezeSys\BreezeBrowserPro\topicset). The files are named as follows: topicset.iptc-genre.xml,
topicset.iptc-scene.xml and topicset.iptc-subjectcode.xml. At the time of writing the IPTC have
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translated topicset.iptc-genre.xml into Spanish ( topicset.iptc-genre_es.xml) and
topicset.iptc-subjectcode.xml into German (topicset.iptc-subjectcode_de.xml), Spanish
(topicset.iptc-subjectcode_es.xml) and French (topicset.iptc-subjectcode_fr.xml). The translated files
can be used in BreezeBrowser Pro's IPTC subject code editor by downloading the relevant file from
http://newscodes.org and renaming it e.g. to use the French translation of the subject codes download
topicset.iptc-subjectcode_fr.xml from http://newscodes.org, rename it to topicset.iptc-subjectcode.xml
and copy it into BreezeBrowser Pro's topicset folder.

The copyright of the XML topicset files belongs to the IPTC and are included with BreezeBrowser Pro
with the IPTC's permission.

2.10.2 Loading and Saving IPTC Data to file

The IPTC settings can be saved to file for future use. Press the "Save to file..." button to save the
current settings. Press the "Load..." button to replace the current IPTC settings with those previously
saved to file. BreezeBrowser Pro can read IPTC data from XMP text files, Adobe Photoshop file info
files (with a .ffo file extension) or Fotostation IPTC files (with an .ipt file extension).

Please note: Loading IPTC data from a file will replace the existing all the IPTC values for the current
image.

2.10.3 Batch Editing IPTC Data

BreezeBrowser Pro can edit IPTC data in individual files or apply changes to several files in one go.
When the IPTC editor is selected from BreezeBrowser Pro's main view all the images capable of
holding IPTC data are listed in the IPTC dialog. In thumbnail view only the selected images which can
hold IPTC data are loaded in the IPTC dialog. When two or more images are loaded in the IPTC dialog
the "< Prev" and "Next >" buttons are enabled and an extra button labeled "Apply to All* (or "Apply to
Selected in thumbnail mode) is displayed as shown below:
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IPTC/XMP Data - GR5F5576.CR2

Description IKE_I,Iwu:urds Cateqgories | Contact I:Irigin' -Imagei

Diocument Title: EEanu:un EOS-10 Mark 1l raw file |

Athor; EEhris Breeze

Authar Title: iF'hu:utu:ugrapher

Itz EXIF comment

Description: | The Stid near Bolton Abbey ‘

[ < Prey ] [ et » ]
Dezcription writer: iEhris Breeze | Image 6 of 39
Copyright Status: : Copyrighted w [ Load... ] [ Save tofile... ]

Copyright Motice: ‘ [ Merge... ”Shuw tu:uken&...]

Copyright [nfo LIRL: |

L]

==
Urgeney: | 5: Marmal

[ Apply to Selected ] [ Apply J [ Cancel

The filename of the current image is displayed in the dialog's title bar and the image number and total
number of images are displayed under the "< Prev"and "Next >" buttons. Use the previous and next
buttons or the mouse wheel to step through the images. Any changes made to the IPTC data for the
current image are saved before displaying the next image. Clicking on the "Apply" button will save the
IPTC data in the current image only and will not affect the other images.

Click on the "Apply to Selected" button to apply the IPTC data to all the selected images. The following
dialog will be displayed asking how the IPTC data should be added to the images:
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Batch IPTC Settings X

Y'ou are about to change the IPTC values for bwo or more files.
Pleaze zpecify how the new |IPTC values should be applied:
Femwords, supplemental categonies, scenes and subject codes
(%) Merge new values with existing values

) Beplace existing entries with new values

Uze EXIF date/time for 'Date Created'
Leave exzting enty if new entry iz empty
Only replace exizting figldz that are empty

(] 4 l [ Cancel

You can choose whether to merge or replace entries in the keyword, supplemental categories, IPTC
scene and IPTC subject code lists. For example suppose an image already contains the following
keywords: "one", "two" and the IPTC dialog contains the keywords: "three", "four". Merging will result in

the following keywords: "one", "two",

three", "four" whereas replacing results in: "three", "four".

Select the "Use EXIF date/time for 'Date Created™ checkbox to automatically use the EXIF date and
time the photo was taken for the "Date created" and "Time created" IPTC fields.

The "Leave existing entry if new entry is empty" checkbox controls whether empty fields in the IPTC
should delete existing entries in the selected images. Most of the time it is probably best to leave this
box checked. Uncheck it if you want to write the same IPTC data to all images and discard any existing
IPTC.

The "Do not replace existing fields unless they are empty" checkbox controls whether new data
entered in the IPTC dialog should overwrite existing IPTC data in the image. For example you may
have added individual captions for some of the images and want to add a generic caption to the
remaining images. You can do this by selecting this checkbox.

Click on "Cancel" if you do not wish to add the IPTC data to all the selected images.

2.10.4 Keyword Editor

The keyword editor can be used to add keywords to the IPTC/XMP data stored in the image without
affecting other data stored in the image. To display the keyword editor either right click on the image
and select "Edit keywords..." or type Shift+Ctrl+K. The dialog below will be displayed:
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Keywords g|

Enker individual keywords or a list of keswords separated by, ar ;

Keywords;

: Delete
Europe
England Delete Al
Yorkshire
Dales Catalog...

shortcuts, .,

(%) Merge new keywords with existing kevwords
() Replace existing kevwards with new keywords
) Delete keywords listed above From the image(s)

apply ko Selected ] [ apply l Cancel

Any keywords already stored in the XMP data for the selected image will be displayed in the keywords
list. If more than one image is selected the keywords list will show the keywords in the image that has
input focus.

Additional keywords can be added either by typing them in the text box at the top and pressing return
or by pressing the "Catalog..." button to select them from the controlled vocabulary catalog.

The way the keywords are added to images is controlled by the merge, replace and delete radio
buttons at the bottom of the dialog.

The merge option will keep the existing keywords stored in the image and add any new ones in the
keywords list.

The replace option removes any existing keywords in the image and replaces them with the keywords
in the keywords list.

The delete option will remove any keywords in the keywords list from the image.

Example:
If the keywords shown in the screenshot above are added to a number of images the results using the
replace, merge or delete options would be:

Existing keywords Results of using Results of using Results of using
in the image the replace option the merge option the delete option
Ruins Europe Ruins Ruins

England Europe

Yorkshire England
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Dales Yorkshire
Dales
Europe Europe Europe England
England England Yorkshire
Yorkshire Yorkshire Dales
Dales Dales
Ruins Europe Ruins Ruins
Abbey England Abbey Abbey
Europe Yorkshire Europe
Dales England
Yorkshire
Dales
Europe Europe
England England
Yorkshire Yorkshire
Dales Dales

If a single image is selected in BreezeBrowser Pro's thumbnail or filmstrip views the dialog will only
have an Apply and a Cancel button. If more than one image is selected in the thumbnail or filmstrip
views the dialog will also have an "Apply to Selected"” button. Pressing the Apply button will apply the
changes to the current image i.e. the one you right clicked on to select the keyword editor. Pressing
the "Apply to Selected" button will apply the changes to all of the selected images.

If the keyword editor is displayed from BreezeBrowser Pro's main window and the directory contains
more than one image the dialog will have an "Apply to All". Pressing this button will apply the changes
to all of the images in the directory. The merge option is disabled if only one image is selected as it
only makes sense to replace or delete keywords from a single file.

A warning message will be displayed when adding keywords to a selection that contains images which
do not support XMP data.

Keyword Shortcuts

Up to nine preset keywords or keyword combinations can be defined and applied to images in the
main and thumbnail views using the keyboard shortcuts Alt+1 through Alt+9. Press the "Shortcuts..."
button to define the preset keywords using the dialog below.
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Keyword Shortcuts E'

Enter the kevword or keywaords o be added to images when the keyboard shortcuts ALT+1 through
ALT+9 are pressed. Multiple kevwords maw be separated using , or ;

Keyword 1 (alt+1): | wvacation; holiday |

Kesword 2 (AlE+2); | birthday |

Keyword 3 (alt+3): | wedding |

Keyword 4 (alt+4): | landscape |

Keyword 5 (AlE+5): | porkrait |

Kesward & (Al4+a0; | Landon; England; Europe |

Keyword 7 (AE+7): | |

Keyword 3 (alt+8): | |

Kewword 9 (AlE+97: | |

(8] 4 ][ Cancel ]

With the settings shown above pressing the keyboard shortcut Alt+1 will add the two keywords
"vacation" and "holiday" to any existing keywords in the currently selected images in thumbnail view or
the currently displayed image in main view. Pressing Alt+2 will add the single keyword "birthday".
Pressing Alt+7 will have no effect as no keyword has been defined for this shortcut.
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2.11 HTML Page Generation

HIML Page Generation E|
Title: Yorkzhire D ales, August 2006
HTHL template: _dru:up shadow multi indes | Settings: .Wel:u Pages w

Images dizplayed on a white backaground with a drop zhadow. Thumbnailz are
dizplayed on multiple pages with uzer definable numbers of rows and columns.

M ain Image Thurmbnail Image
lax Size [pi:-:els]:: [ w 0| b ax Size [pixels): Wi
JPEG Quality [0-100): JPEG Guality [0-100);
Insharp M aszk Settings: Unzharp Mazk Seftings:

R adius: Amount: R adius: ) | Amount;
Threzhaold: . Threzhaold: _.

W atermark./ Caphioning

Add watermark./zcaption ta main image kain Image Settingz... ]

[ ] &dd watermark/zaption ta thumbnail image

[] Fast mode [faster HTML page generation but shightly reduced image quality)

Reusze existing images Correert BAYW images for highest quality
[] Delete unuzed files in directany Auta level images

[ ] Recursively zzan subfolders Save HTML zettings for this folder
MHurmber of u:u:ulumns:: 4 w [ Mumber of rows: | 3 : w
Cutput directony: '
H:200642006-08-145H T ML E]
[ Load... ] [ Save... ] Generate HTML l [ Cancel ]

Select "HTML..." from the Tools menu to view HTML pages of the images in the directory. If the HTML
pages do not exist the HTML page generation dialog will be displayed. Enter a title for the pages,
select a template from the drop down list and then press the "Generate HTML" button. The following
templates are shipped with BreezeBrowser Pro:

black - images displayed on a black background together with full EXIF information

simple - simple display on a white background

simple + settings window - same as the simple template with the addition of a "Details" link below
the main image which opens up a window showing the shooting details for the shot

proofs - similar to the 'black' template but with the filename appearing under the thumbnails on
the index page

frames - uses frames to display thumbnails across the top of the page with the main image

displayed below
¢ slideshow - Javascript slideshow with images displayed on a black background with EXIF
summary

non_english - shows how you can use a language other than English for the Next/Previous links
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thumbnails - shows thumbnails for the next and previous images above the main image

icons - an example of how to images can be used for buttons and logos

multi index - example of how to use Javascript to generate multiple index pages

multi-view - example of how create three parallel sets of HTML pages to give three different

gallery styles for one set of images

drop shadow - another example of using images stored in the template directory to produce an

attractive "drop shadow" effect

drop shadow multi index - combined "drop shadow" and "multi index" template

picture frame - similar to the "drop shadow" template but with a picture frame around each image

picture frame multi index - combined "picture frame" and "multi index" template

order - the bare bones of a simple online ordering system using Javascript and frames

paypal - a simple to use online ordering system which links in to PayPal's shopping cart system

for accepting payments online

e web images only - generates web size JPEG images without the accompanying HTML pages. Set
the thumbnail size to 0 to suppress thumbnail generation

e GPS - uses GPS data stored in the images to generate a map based index page using Google

maps and a conventional thumbnail index page

A copyright message or watermark can be superimposed on the main image and/or the thumbnail
image to discourage unauthorized copying and printing of images from web pages. This can take the
form of text or a GIF image. The copyright text can use the HTML tokens listed at the bottom of this
page to include data extracted from the image. To add a watermark to the main image select "Add
watermark/caption to main image" and click on the "Main Image Settings..." buttons to define how it
should appear. Select "Add watermark/caption to main image" to add a watermark to the thumbnail
image.

Please see Proofs for a complete description of the watermark options.

Select "Fast mode" for faster generation of images for HTML pages. This option uses faster but
slightly lower quality algorithms for resizing and sharpening images. The speed gain compared to
normal HTML generation varies with the source image type and is up to six times faster when the
source images are JPEGs.

Click on the "Reuse existing images" checkbox to reuse any existing JPEG images in the HTML
directory. This saves time if you are adding images to an existing gallery or wish to try out different
HTML templates.

When this option is selected BreezeBrowser Pro will reuse existing main images and thumbnail
images in the HTML directory provided the file modification timestamp of the source image is older
than the existing main image. This means that if the original image has been edited since the HTML
gallery was created the existing images in the gallery will be regenerated.

If the source image is a JPEG which is the same size or smaller than the main image size it is copied
to the HTML directory without modification when "Reuse existing images" is selected. This is useful if
you wish to prepare the image for your web page in an image editor rather than let BreezeBrowser Pro
create it.

The size, JPEG quality and amount of sharpening for both the main and thumbnail images is fully
user-definable. Select "Custom” from the "Settings" drop down list or one of the predefined settings.
The predefined settings are:

1. Web Pages - 550x450 main images and 125x125 thumbnails suitable for posting on web sites

2. CD-R Archive (small) - High quality 650x550 main images and 160x160 thumbnails for archiving
to CD

3. CD-R Archive (large) - High quality 950x800 main images and 160x160 thumbnails for archiving
to CD and viewing on high resolution screens.

The generation of thumbnail images can be suppressed by setting the width or height to 0 pixels. This
option should only be used with HTML templates that do not require thumbnails.
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Select "Delete unused files in directory” if you would like any unused files in the directory to be deleted
after generating the HTML pages. When this option is selected you will be prompted with a dialog
containing a list of all unused files and given the option to delete them. This feature is useful if you
want to upload the entire directory to your web site and don't want to include any unnecessary files.

Select "Auto level images" to apply auto levels when creating the HTML images. This is a contrast
enhancing technique which maps the darkest pixels in the image to black and the lightest pixels to
white.

By default BreezeBrowser Pro uses lower case filenames when generating HTML pages. This can be
disabled in Preferences.

The output directory defaults the image directory plus "HTML". Absolute or relative directory
pathnames may be used e.g. \HTML will have the same effect as the default output directory. There is
a setting in Preferences to make the HTML generator remember the last HTML output directory. This
setting should be used with care to avoid accidentally overwriting previously generated pages.

Select "Recursively scan subfolders" to have the HTML generator create web pages for every
subdirectory of the current directory which contains images. The HTML generator will skip subfolders
named "HTML" or with names starting with '_". It will generate web pages from each directory and
store them under the output directory specified in the HTML dialog. Please note that this option does
not create a master HTML index page to link to the pages in each folder.

Select "Save HTML settings for this folder" to save the settings so that they are available next time you
generate HTML pages in this folder. This saves the HTML settings in a file called
breezebrowserHTML.dat in the image directory. Please note: This feature is not available in read-only
folders e.g. CD drives.

Depending on the HTML template selected there may be one or two additional entry fields at the
bottom of the HTML dialog. In the example in the screenshot above these are used to specify the
number of rows and columns to use when laying out the pages.

The HTML settings can be loaded and saved to disk for later use. Use the "Load..." and "Save..."
buttons at the bottom of the dialog to do this. The data files are stored in a folder called "HTML
settings" in the templates folder.

2.11.1 Custom settings

Select the "Custom" setting to have complete control over the size and quality of the main and
thumbnail images.

The image is sized using high quality interpolation to fit the inside the box defined by the size
parameters while maintaining the same aspect ratio. e.g. an image 1024x768 pixels would be resized
to 512x384 if the size was specified as 512x512. Images are only reduced in size. If the requested size
is larger than the original image size the original image size is preserved.

The JPEG quality can be set from 0 (maximum compression, minimum quality, small file size) to 100
(maximum quality, minimum compression, large file size).

The unsharp mask settings control how the image is sharpened. The radius setting defines the radius
of the Gaussian in pixels (not counting the center pixel). Amount defines the percentage difference
between the original image and the blur image that is added back to the original. Threshold defines the
threshold in pixels needs to apply the difference amount.

The predefined settings use the following values:

Main Image Web | CD-R (small) || CD-R (large) |
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2.11.2

Image size 550x450 650x550 950x800
JPEG quality 80 90 90
USM radius 1.0 1.0 1.0
USM amount 1.3 1.2 1.2
USM threshold 0.0 0.0 0.0
Thumbnail Image Web CD-R (small) | CD-R (large)
Image size 125x125 160x160 160x160
JPEG quality 90 95 95
USM radius 1.0 1.0 1.0
USM amount 1.5 1.5 1.5
USM threshold 0.0 0.0 0.0
NOTES:

1. The source files for HTML images can be any of the file types supported by BreezeBrowser Pro
e.g. JPEGs, raw files, TIFFs.

Hint: If you prefer to prepare each fullsize image individually and only want BreezeBrowser Pro to
generate the HTML pages and the thumbnails you can do it as follows:

1. Edit and save each fullsize image as a JPEG at the desired size and quality

2. Select the "Reuse existing images" checkbox

3. Set "Custom" settings and set the main image size to a value larger than the fullsize images

4. Runthe HTML generator and BreezeBrowser Pro will copy any JPEG originals that are smaller
than the main image size settings into the HTML output directory instead of resizing and
sharpening them again.

Creating your own templates

HTML page templates are stored in the "templates" subdirectory from where the application is
installed. Probably the easiest way to create new templates is to copy an existing template directory
and then modify the template files. To be recognized by BreezeBrowser Pro a template directory must
contain at least the following files:

e index_template.{ext}- the main index page. After processing this becomes index.{ext}

o fullsize_template.{ext} - page to display the main image. After processing this becomes the
image filename with {ext} extension

e thumbnail_template.{ext} - template to build up a set of thumbnails. After processing the
thumbnails are concatenated and stored in the @body@ token so that they can be inserted
into the index page

NOTE: The template directory must contain the files listed above in order to be listed in the HTML
dialog. You can prevent the file appearing in the final output by making the template file zero length.
For example to create main and thumbnail images without any HTML pages you could create a null
template where index_template.htm, fullsize_template.htm and thumbnail_template.htm are all zero
length files in the template directory.

Optional additional index template files called index2_template.{ext} and index3_template.{ext} can be
included. After processing these become index2.{ext} and index2.{ext} respectively. This is useful if
you want to use frames (see the "frames" template for an example of how to do this).

Up to two optional additional fullsize and thumbnail template files can also be included. This is useful if
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you want to have more than one page to view the image (see the "Simple + settings window" template
for an example of how to do this). Another use is to create sets of pages in different languages or
using more than one layout style (see the "multi-view" template for an example of how this can be
used).

{ext} is normally "htm" but it can be any extension you choose provided all the template files in a given
directory have the same extension. If you want to use a server side scripting language such as PHP
the templates can be renamed to have the extension ".php" e.g. index_template.php,
fullsize_template.php, thumbnail_template.php.

Template file Destination name How to reference in web pages
index_template.{ext} jindex.{ext} e.g. index.htm index.{ext}
index2_template.{ext} ||index2.{ext} e.g. index2.htm index2.{ext}
index3_template.{ext} [index3.{ext} e.g. index3.htm index3.{ext}
fullsize_template.{ext} |<image_ name>.{ext} e.g. @url@, @nextUrl@, @next@,
img_0123.htm @nexticon@, @prev@, @previcon@
fullsize2_template.{ext}|2<image_name>.{ext} e.g. 2@url@, 2@nextURL@, @next2@,
2img_0123.htm @nexticon2@, @prev2@,
@previcon2@
fullsize3_template.{ext}|3<image_name>.{ext} e.g. 3@url@, 3@nextURL@, @next3@,
3img_0123.htm @nexticon3@, @prev3@,
@previcon3@
thumbnail_template.{ex|N/A - stored in @body@ token Use @body@ to add to index.{ext},
t} index2.{ext} or index3.{ext}
thumbnail2_template.{e]N/A - stored in @body2@ token Use @body2@ to add to index.{ext},
xt} index2.{ext} or index3.{ext}
thumbnail3_template.{e]N/A - stored in @body3@ token Use @body3@ to add to index.{ext},
xt} index2.{ext} or index3.{ext}

Any non-template files in the template directory are copied unmodified into the HTML output directory.
One possible use for this is to include images for logos, buttons or the window background (see the
"icons" template for an example of this).

BreezeBrowser Pro will preserve the end of line style used in the template when generating HTML
pages. If you wish to generate pages that use scripts (e.g. JSP or Perl) to run on a Unix server you can
avoid problems with PC-style LF-CR at the end of each line by saving your templates with Unix-style
LF end of lines.

Specifying the user defined fields

It is possible to define up to two additional fields for configuring the template by creating a file called
"config.dat" in a subdirectory called "config" in the template directory. The config.dat file specifies the
caption for the entry fields and their type: text entry, checkbox or dropdown list. If the config.dat file is
omitted the HTML dialog will display a text entry fields for the @user1l@ token (this is for compatibility
with versions of BreezeBrowser older than version 2.8).

The templates supplied with BreezeBrowser Pro all contain config.dat files and it is worth taking a look
at these to see how they work. The config.dat file can be used to define input fields for the @user2@
and @user3@ tokens and is best described using an example. The example below defines a
dropdown list for selecting the background color and a checkbox to select whether to display EXIF
data:

<?xml version="1.0" ?>
<breezebrowser version="2.8">
<html_config>
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<description>Enter a short description of your template
here</description> <user2 enabled="1">

<caption>Background color:</caption>

<select name="name" size=""1">
<option value="#000000">black</option>

<option>white</option>
<option value="gray" default>gray</option>

</select>
</user2>
<user3 enabled="1">

<caption>Show EXIF shooting data</caption>
<input type="'checkbox" value="@exif@">
</user3>
</html_config>

</breezebrowser>

The <description> tag defines a short description which is displayed in the HTML dialog below the
"HTML template:" drop down list. The description can be up to two lines long.

The <user2 enabled="1"> tag starts the definition of the input field for a dropdown list for the
@user2@ token. This can be disabled by setting enabled="0". The definition ends with the </user2>
closing tag.

The caption is for the input field is specified by <caption>Background color:</caption>. It is a good
idea to keep the caption short to allow space for the input area.

The dropdown list is specified by the <select> tag (the name and size attributes in the tag are
ignored). Each item in the list is specified by an <option> tag. The text between the <option> and
</option> tags will be displayed in the list. If a value attribute is defined in the <option> tag this will be
placed in the @user2@ token when the option is selected otherwise the text between the <option>
and </option> tags will be used. A default item can be specified by adding the default attribute in the
<option> tag. The dropdown list is set to the default value when the HTML dialog is displayed unless
the HTML generator has already been run in this folder in which case the previous setting is used.

In the example above the @user3@ input field is set to a checkbox with the caption "Show EXIF
shooting data". When the checkbox is checked @user3@ is set to "@exif@". When it is unchecked
@user3@ is an empty string. The value attribute in the <input> tag is optional and if it is omitted
@user3@ is set to 1 when the checkbox is checked and 0 when it is unchecked.

The example below shows how to specify a text entry field for @user2@ and to disable the second
input field:

<?xml version="1.0" ?>
<breezebrowser version="2.8">
<html_config>
<user2 enabled="1">
<caption>Subject:</caption>
<input type=""text">
</user2>
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<user3 enabled="0">

</user3>
</html_config>

</breezebrowser>

The <input type="text"> tag specifies the input field as a text entry box.

Please note: the config.dat file only controls the settings for the @user2@ and @user3@ tokens. If
either user2 or user3 are defined the input fields for @userl@ will be disabled. @user1@ is only
retained for backwards compatibility with templates from versions of BreezeBrowser before version
2.8.

2.11.3 HTML Tokens

Tokens enclosed by '@' characters are filled in when the HTML pages are generated e.g. @exif@ is
replaced with the full EXIF details for the image. The tables below give a list of the tokens used:

URLs and file information

@firstURL@ The URL of the first full size page e.g. img 0001.htm
@lastURL@ The URL of the last full size page e.g. img_0100.htm
@next@ The word "Next" with a hyperlink to the next fullsize page unless this is the last

page. e.g. <a href="img_0999.htm">Next</a> Notes: The word used defaults to
"Next" but can be edited in Preferences. Use @next2@ and @next3@ to
reference pages generated from fullsize2_template.{ext} and

fullsize3 template.{ext}

@nextURL@ The URL of the next fullsize page e.g. img_0100.htm (empty for the last image)

@nexticon@ Inserts an image called next.gif with a hyperlink to the next fullsize page unless
this is the last page. e.g. <a href="img_0999.htm"><img src="next.gif" alt="Next"
title="Next" border="0"></a> Notes: The word used in the img alt and title
properties is the same as used in @next@. Use @nextlcon2@ and
@nextlcon3@ to reference pages generated from fullsize2_template.{ext} and
fullsize3 template.{ext}

@nextimage@ The URL of the next fullsize image. This can be used to "pre-load" the next
image by including the line <img src=@nextimage@ width="1" height="1"> in
the fullsize template.

@previmage@ The URL of the previous fullsize image. This can be used to "pre-load" the
previous image by including the line <img src=@previmage@ width="1"
height="1"> in the fullsize template.

@firstimage@ The URL of the first fullsize image in the gallery

@prev@ The word "Prev" with a hyperlink to the previous fullsize page unless this is the
first page. e.g. <a href="img_0100.htm">Prev</a> Notes: The word used
defaults to "Prev" but can be edited in Preferences. Use @prev2@ and
@prev3@ to reference pages generated from fullsize2_template.{ext} and
fullsize3 template.{ext}

@prevURL@ The URL of the previous fullsize page e.g. img_0100.htm (empty for the first
image)
@previcon@ Inserts an image called prev.gif with a hyperlink to the previous fullsize page

unless this is the last page. e.g. <a href="img_0999.htm"><img src="prev.gif"
alt="Prev" titte="Prev" border="0"></a> Notes: The word used in the img alt and
title properties is the same as used in @prev@. Use @previcon2@ and
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@previcon3@ to reference pages generated from fullsize2_template.{ext} and
fullsize3_template.{ext}

@url@ The URL of the current fullsize page created from fullsize_template.{ext} (used
to link thumbnails to the fullsize page) Note: Use 2@url@ and 3@url@ to
reference pages generated from fullsize2_template.{ext} and
fullsize3_template.{ext}

@homeURL@ The value of "Home page" entered in Preferences e.g.
http://www.breezesys.com

@body@ Concatenation of all the thumbnail images from thumbnail_template.{ext} (used
in index pages)

@body2@ Concatenation of all the thumbnail images from thumbnail2_template.{ext}
(used in index pages)

@body3@ Concatenation of all the thumbnail images from thumbnail3_template.{ext}
(used in index pages)

@file@ The filename of the original image file e.g. CRW 0123.crw

@fileLower@ The filename of the original image file in lower case e.g. crw_0123.crw

@fileAsURL@ The filename of the original image file encoded so that it can be used in a URL
e.g. Strange name%.jpg becomes Strange%20name%25.jpg

@fileNoExt@ The filename of the original image file without its extension e.g. CRW 0123

@fileNoExtLower@

The filename of the original image file without its extension in lower case e.g.
crw_0123

@fileAsNumber@

Evaluates to the first group of humbers in the filename. Useful if filenames
contain a reference number for identification purposes. e.g.
CRW 012345 20020527.CRW would give 012345

@fileAsNumber2@

Evaluates to the last group of numbers in the filename. Useful if filenames
contain a reference number for identification purposes. e.g.
CRW 012345 20020527.CRW would give 20020527

@dirName@

The name of the directory where the original image file was when the HTML
pages were generated e.g. 2004_May for images stored in
D:\MyPhotos\2004 May\

@dir@

The full pathname of the directory where the original image file was when the
HTML pages were generated e.g. D:\MyPhotos\2004 May\

@dirEscaped@

The full pathname of the directory where the original image file was when the
HTML pages were generated with backslash characters escaped so that it can
be used for strings within Javascript and other scripting languages e.g.
D:\MyPhotos\2004 May\ becomes D:\\MyPhotos\\2004 May\\

@dirSlash@

The full pathname of the directory where the original image file was when the
HTML pages were generated with \ characters converted to / to avoid problems
with quoted strings in scripts e.g. D:/MyPhotos/2004 May/

@baseDirPath@

Relative path to the first HTML directory when recursively scanning subfolders
e.g..././.

@imageNumber@

Image number within the directory. Useful for displaying text like "Image 1 of 10"

@numberOflmages

@

The number of images in the directory. Useful for displaying text like "Image 1 of
10"

@fileSize@

File size of source image e.g. 3,689Kb

@fileSizelnBytes@

File size of source image in bytes e.g. 3,735,271

@fileSizePlain@

File size of source image in bytes without thousands separators e.g. 3735271

@mainFileSize@

File size of main gallery image e.g. 3,689Kb

@mainFileSizelnByt
es@

File size of main gallery image in bytes e.g. 3,735,271

@mainFileSizePlain

@

File size of main gallery image in bytes without thousands separators e.g.

3735271
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@tagged@ Set to 1 if the image is tagged, 0 if not. Note: @tagged@ is not set in sub
directories when using recursive HTML generation.
@numTagged@ The number of tagged images in the directory.
@numRanked1l@ [The number of images ranked 1 in the directory
@numRanked2@ The number of images ranked 2 in the directory
@numRanked3@ [The number of images ranked 3 in the directory
@numRanked4@ The number of images ranked 4 in the directory
@numRanked5@ [The number of images ranked 5 in the directory
@AdobeRating@ Adobe Bridge image rating as read from the XMP data
@AdobelLabel@ Adobe Bridge image label as read from the XMP data
@tableRow@ A special set of tokens to help construct HTML tables without having to use
@tableRow2@ Javascript (please see the proofs template for an example of how to use this
token). @tableRow<n>@ evaluates to </tr><tr> every n thumbnail images and
@tableRow10@ to an empty string otherwise.
e.g. @tableRow2@ evaluates to:
1st image:
2nd image: </tr><tr>
3rd image:
4Ath image: </tr><tr>
@tableRow@ is treated the same as @tableRow4@.
@lastUpdatedDate [Today's date formatted according to your locale e.g. 14 November 2008
@
@empty@ Always returns an empty string

Image properties and page title

@image@ URL of the JPEG image e.g. img_0001_std.jpg in fullsize_template and
img 0001 tn.jpg in thumbnail template

@width@ Width of the JPEG image in pixels

@height@ Height of the JPEG image in pixels

@aspectRatio@ Aspect ratio of the image calculated by dividing the height by the width and
normalizing so that the value is always greater than or equal to one e.g. a 6x4
and a 4x6 image will both give a value of 1.5. The value is displayed to a
precision of two decimal places with trailing 0's removed.

@aspectRatio2@ Same as @aspectRatio@ above but without the trailing O's removed e.g. 1.50
for a 6x4 image

@orientation@ Image orientation based on image width and height e.g. "Landscape" if width >=
height, "Portrait" if width < height

@main_image@ URL of the JPEG used for the main image e.g. img_0001_std.jpg

@main_ width@ Width of the main JPEG image in pixels

@main_height@

Height of the main JPEG image in pixels

@thumbnail_image

@

URL of the JPEG used for the thumbnail image e.g. img_0001_tn.jpg

@thumbnail width@

Width of the thumbnail JPEG image in pixels

@thumbnail_height
@

Height of the thumbnail JPEG image in pixels

@src_width@ Width of the original image in pixels
@src_height@ Height of the original image in pixels
@maxWidth@ The maximum width of the main image entered in the HTML dialog
@maxHeight@ The maximum height of the main image entered in the HTML dialog
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@maxThumbWidth |The maximum width of the thumbnail image entered in the HTML dialog

@

@maxThumbHeight |[The maximum height of the thumbnail image entered in the HTML dialog

@

@title@ The title you entered in the HTML dialog. You may use a token here e.g. if you
enter @caption@ the value of @caption@ from the last image processed will
be used for the title.

@rawTitle@ The title you entered in the HTML dialog without modification. Use this instead
of @title@ if you want to embed HTML formatting in your title.

@strippedTitle@ The title you entered in the HTML dialog with any HTML tags removed and and
special HTML characters escaped where necessary.

@userl@, The value entered in the @userl@ user defined field in the HTML dialog.

@user2@ and @userl@ is processed first and can be used to hold information for other

@user3@ tokens. e.g. Adding @tableRow@userl@@ to a template allows the number of
thumbnails per row to be defined by the user in the HTML dialog

@encodedUserl@, |As @userl@ except characters like ", < and > are quoted (i.e. " becomes

@encodedUser2@ |&quot; < becomes &lt; and > becomes &gt;).

and

@encodedUser3@

@strippedUserl@, |As @userl@ except any HTML tags are removed and special HTML

@strippedUser2@ |characters are escaped where necessary

and

@strippedUser3@

EXIF information

@exif@ Full EXIF details for the image. Note: line breaks are converted to <br />

@exifSummary@ Abbreviated EXIF details for the image. Note: line breaks are converted to
<br />

@caption@ The comments stored with the image. Note: line breaks in the comment are
converted to <br /> Note: This is the IPTC caption if "Use IPTC caption in
preference to EXIF comments" is set in preferences

@rawCaption@ [The comments stored in the image without modification. Use this instead of
@caption@ if you want to embed HTML formatting in your comments.
Note: This is the IPTC caption if "Use IPTC caption in preference to EXIF
comments" is set in preferences

@strippedCaption@ The comments stored in the image with any HTML tags removed and
special HTML characters escaped where necessary. Note: This is the IPTC
caption if "Use IPTC caption in preference to EXIF comments" is set in
preferences

@exifComments@ The comments stored with the image. Note: line breaks in the comment are
converted to <br />

@rawExifComments@ [The comments stored in the image without modification.

@strippedExifComments [The comments stored in the image with any HTML tags removed and

@ special HTML characters escaped where necessary.

@owner@ [The owner string stored in the EXIF data

@strippedOwner@ [The owner string stored in the EXIF data with any HTML tags removed

@copyright@ Copyright string

@imageCounter@ Image sequence number (only available with some Canon 1D series DSLRs
and Nikon DSLRs from the D70 onwards)

@imageCounter5@ Same as @imageCounter@ but padded with leading zeroes to give a 5-digit
number e.g. 00123

@imageCounter6 @ Same as @imageCounter@ but padded with leading zeroes to give a 6-digit
number e.g. 000123
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@model@ Camera model name e.g. Canon EOS 20D

@iso@ ISO setting e.g. 100

@shutter@ Shutter speed e.g. 1/125

@aperture@ Aperture e.g. 11

@EV@ Exposure value calculated using the shutter speed, aperture and 1SO to
nearest integer

@EV1@ Same as @EV@ except returns the value to one decimal place

@exposureMode@ Exposure mode e.g. Manual

@meteringMode @ Metering mode e.qg. "Evaluative"

@flash@ Flash setting e.g. "External E-TTL"

@whiteBalance @ \White balance setting e.g "Auto"

@exposureCompensatio [Exposure compensation e.g. "+1/3"

n@

@flashCompensation@ |Flash exposure compensation e.g. "-1 2/3"

@aebExpCompensation JAuto exposure bracketing exposure compensation e.g. "+1/3"

@

@aebShotNumber@ IAuto exposure bracketing sequence shot number

@totalExposureCompens
ation@

Total exposure compensation i.e. exposure compensation + AEB
compensation

@lens@ Lens focal length range in mm e.qg. 24 to 85

@lens2@ Alternative form for lens focal length range r.g. 24-85
@focalLength@ Focal length used for the photo e.g. 50.0

@digitalZoom@ Digital zoom (empty if no digital zoom was applied) e.g. 3x

@microAdjust@

Lens AF micro adjustment value (recent, mid to high end Canon DSLRs
only)

@focusPoint@ IAF focus point used e.g. "[Center]"

@focusMode@ IAF focus mode e.g. "One-shot AF"

@driveMode@ Drive mode e.g. "Continuous"

@quality@ Image quality e.g. "Raw"

@colorProfile@ Name of the color profile embedded in the image.

@saturation@ Saturation setting e.g. "Normal"

@contrast@ Contrast setting e.g. "Low"

@sharpness@ Sharpness setting e.g. "Low"

@subjectDistance@ Subject distance in meters. Note: This is not always available or particularly
accurate

@year@ [The year the photo was taken e.g. 2005

@month@ [The month the photo was taken e.g. 06 for June

@monthName@ [The name of the month the photo was taken e.g. June

@day@ [The day of the month the photo was taken e.g. 07

@weekday@ [The day of the week the photo was taken e.g. Monday

@time@ [The time the photo was taken e.q. 10:23:35

@hour@ The hour the photo was taken (00 to 23) e.g. 13 for a photo taken at
1:23:35pm

@hourl2@ The hour the photo was taken (12 hour clock) e.g. 01 for a photo taken at
1:23:35pm

@hourl2a@ [The hour the photo was taken (12 hour clock with leading zeroes removed)
e.g. 1 for a photo taken at 1:23:35pm

@ampm@ IAM for photos taken between 00:00:00 and 11:59:59 or PM for photos taken
between 12:00:00 and 23:59:59

@minute@ The minute the photo was taken (00 to 59) e.g. 23 for a photo taken at
10:23:35

@second@ The second the photo was taken (00 to 59) e.g. 35 for a photo taken at
10:23:35

@date@ The date the photo was taken formatted to your locale e.g. 15 June 2005

@dateTime@ The date and time the photo was taken formatted as YYYY.MM.DD
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hh:mm:ss

@subsecTime@ Sub-second time the photo was taken. This is the time the photo was taken
to 1/100th sec and is only currently stored in the EXIF shooting data by
Nikon DSLRs. Returns "00" if not defined in the shooting data.

@segNumber@ Canon 7-digit sequence number in the form dddnnnn where ddd is the
original image folder number and dddd is the image number (only valid for
PowerShot cameras and some EOS cameras)

@bodyID@ ICamera body id or serial number (Canon EOS cameras only)

@firmware@ Camera firmware version

@EFguideNumber@ Measure of flash power (only valid for Canon PowerShot cameras)

@selfTimer@ Number of seconds the self-timer was set for (Canon cameras only)

@macro@ Lens macro setting (only valid for some camera models)

@latitude @ GPS latitude expressed in degrees, minutes and seconds

@longitude @ GPS longitude expressed in degrees, minutes and seconds

@altitude @ GPS altitude

@latitudeAsDecimal@ |GPS latitude expressed as a decimal number as opposed to degrees,
minutes and seconds

@longitudeAsDecimal@ |GPS longitude expressed as a decimal number as opposed to degrees,
minutes and seconds

IPTC Data

@IPTC@ Summary of IPTC data

@IPTC_documentTitle@

Document title (IIM name: object name)

@IPTC_ objectName@

same as @IPTC documentTitle@

@IPTC_category@

category

@IPTC_supplementalCate

gories@

Comma separated list of supplemental categories

@IPTC_keywords@

Comma separated list of IPTC keywords

@IPTC_scenes@

Comma separated list of IPTC scenes

@IPTC_subjectCodes@

Comma separated list of IPTC subject codes

@IPTC instructions@

instructions (IIM name: special instructions)

@IPTC_speciallnstructions

@

same as @IPTC _instructions@

@IPTC_dateCreated@

date created

@IPTC_timeCreated@

time created

@IPTC releaseDate @

release date

@IPTC releaseTime@

release time

@IPTC author@

Author (IIM name: byline)

@IPTC byline@

same as @IPTC author@

@IPTC authorTitle@

Author title (IIM name: byline title)

@IPTC_bylineTitle@

same as @IPTC_authorTitle@

@IPTC city@

city

@IPTC_location@

location (IIM name: location)

@IPTC_sublocation@

same as @IPTC location@

@IPTC_ state@

State

@IPTC_ country@

country

@IPTC_countryCode@

3-letter country code

@IPTC_ contactAddress@

contact address

@IPTC_contactCity@

contact city
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@IPTC_contactState@

contact state

@IPTC_contactPostalCode
@

contact postal code

@IPTC_contactCountry@

contact country

@IPTC_contactPhones@

contact phones

@IPTC_contactEmails@

contact emails

@IPTC_contactWebsites@

contact websites

@IPTC transmissionRef@

transmission reference (IIM name: original transmission reference)

@IPTC_origTransRef@

same as @IPTC_transmissionRef@

@IPTC_headline@

headline

@IPTC_provider@

provider (IIM name: credit)

@IPTC_ credit@

same as @IPTC_provider@

@IPTC_source@

source

@IPTC_copyrightStatus@

copyright status - Unknown, Copyrighted or Public Domain

@IPTC_copyrightURL@

copyright info URL

@IPTC_copyrightNotice@

copyright notice (IIM name: copyright)

@IPTC_copyright@

same as @IPTC_copyrightNotice@

@IPTC rightsUsage@

rights usage terms

@IPTC_description@

description (IIM name: caption)

@IPTC_caption@

same as @IPTC_description@

@IPTC_descriptionWriter@

description writer (IIM name: caption writer)

@IPTC_ captionWriter@

same as @IPTC descriptionWriter@

@IPTC_editStatus@

edit status

@IPTC_originatingProgram
@

originating program

@IPTC joblD@

job identifier

@IPTC_objectCycle@

object cycle

@IPTC_genre@

intellectual genre

@IPTC_urgency@

urgency (IIM name: priority)

@IPTC_priority@

same as @IPTC_urgency@

"stripped"” versions of the IPTC tokens are available by prefixing "IPTC" with "stripped" e.g. the stripped
version of @IPTC_caption@ is @strippedIPTC_caption@. The stripped versions have any HTML tags
removed and special HTML characters escaped where necessary. "raw" versions of the IPTC tokens
are available by prefixing "IPTC" with "raw" and these copy the IPTC data without modifying it in any
way. This is useful if you wish to include URLs or HTML formatting in the IPTC data.

Legacy IPTC IIM data

Note: These tokens are provided for backwards compatibility with the older IPTC 1IM standard and will
be empty if the image does not contain IPTC IIM data

@IPTC_IIM_objectName@

object name

@IPTC _IIM_category@

category

@IPTC_IIM_supplementalCat
egories@

Comma separated list of supplemental categories

@IPTC IIM keywords@

Comma separated list of IPTC keywords

s@

@IPTC_IIM_speciallnstruction

special instructions

@IPTC IIM_dateCreated@

date created

@IPTC_IIM_timeCreated@

time created
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@IPTC_IIM_releaseDate@

||release date

@IPTC _IIM releaseTime@

Irelease time

@IPTC_IIM_byline@ lbyline
@IPTC_IIM_bylineTitle@ loyline title
@IPTC_IIM_city@ city
@IPTC_IIM_sublocation@ sublocation
@IPTC_IIM_country@ country

@IPTC_IIM_countryCode@

3-letter country code

@IPTC_IIM_origTransRef@

original transmission reference

@IPTC_IIM_headline@ headline
@IPTC_IIM_credit@ credit

@IPTC _IIM_source@ source
@IPTC_IIM copyright@ copyright
@IPTC_IIM_caption@ caption
@IPTC_IIM_captionWriter@ [caption writer
@IPTC _IIM_editStatus@ edit status

@IPTC_IIM_originatingProgra
m@

originating program

@IPTC_IIM_joblD@

@IPTC_IIM_objectCycle@

ob identifier
n!object cycle

@IPTC_IIM_priority@

lurgency

Tokens for modifying strings

The tokens below can be used to modify tokens or strings:

Token Description

Example

{left,n,str}

Extracts the first n characters from str
(which can be a string or token).

{left, 4, @model@} for an image taken
with a Nikon D300 will give: Niko

{mid,n,m,str}

Extracts m characters starting from the n'th
character from str (which can be a string or
token).

{right,1,4,@model@} for an image taken
with a Nikon D300 will give: ikon

{right,n,str}

Extracts the last n characters from str (which
can be a string or token).

{right,3,@model@} for an image taken
with a Nikon D300 will give: 300

{first,str} Extracts the first word from str (which can bel{first,@model@} for an image taken with
a string or token). a Nikon D300 will give: Nikon
{last,str} Extracts the last word from str (which can be |{last,@model@} for an image taken with

a string or token).

a Nikon D300 will give: D300

{default,strl,s
tr2}

Returns strl unless it is an empty string in
which case it returns str2 (strl and str2 can
be strings or tokens)

{default,1,2} returns 1
{default,,2} returns 2

{if test,strl,str
2}

Returns strl if test is not an empty string
else returns str2 (test, strl and str2 can be
strings or tokens)

{if,1,2,3} returns 2
{if,,2,3} returns 3

{upper,str} Converts str to upper case {upper,@monthName@} for a photo
taken in June gives: JUNE
{lower,str} Converts str to lower case {upper,@monthName@} for a photo

taken in June gives: june
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{capitalize,str}|Converts str to lower case and capitalizes |{capitalize,john} gives John
the first letter

Tokens for country codes and names

The tokens below can be used to convert between 1SO-3166 two character and three character codes
and to lookup country names using the two character or three character country code:

Token Description Example
{ccl,str} |Lookup the country name where 'str'is a two or |{cc1,GB} gives "United Kingdom",
three character ISO-3166 country code {cc1,DEU} gives "Germany", {cc1l,USA}

gives "United States"

{cc2,str} |Lookup the 1ISO-3166 two character code where|{cc2,GBR} gives GB, {cc2,DEU} gives
'str' is a three character ISO-3166 country code |DE, {cc2,USA} gives US

{cc3,str} |Lookup the ISO-3166 three character code {cc3,GB} gives GBR, {cc2,DE} gives
where 'str' is a two character ISO-3166 country |DEU, {cc3,US} gives USA
code

Notes

1. The sequence (c) is converted to ©.

2. Page and image filenames are all converted to lower case so that they don't confuse MS
Front Page (unless this option is disabled in Preferences).

3. IPTC XMP fields which are the same as legacy IPTC IIM fields but have different names are
listed with the IIM name in brackets e.g. @IPTC_urgency@, XMP name: urgency, IIM name:
priority

2.11.4 Show Tokens Window

Right click on an image and select "Show Tokens..." to display the values of the main tokens used for
the HTML page generator.
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FUHTML Tokens, file: IMG_9856.JPG

Type Ctrl+C ko copy the walue of the selected ikem to the clipboard or double click ko copy and exit,

Token Yalue Description s
(Downerim Chris Breeze Owner skring
| Zanon EQS 50 Zamera model
@make@ Zanon Camera make
[Disa@ 1000 150 setting
@shukten@ 1/25 Shutter speed (Tv)
Dapertured 5.6 Aperture (oY)
mEYD f Exposure Yalue calculated using Aw, Tv and IS0
DEY1D 6,3 Exposure Yalue to one decimal place
@exposUreModed@ Manual Exposure mode
@mekeringiodem Evaluative Metering mode
@flashim OFF Flash setting
mwhiteBalancem Auko White balance
@DexposUreCompensakionia ] Exposure compensation
@kotalExposureCompensationd@ 0 Exposure compensation + AEE compensation
@flashCampensation@ 0 Flash expasure compensation
@aebExpCompensationi@ ] Auko exposure bracketing exposure compensation b

The value of a token can be copied to the Windows clipboard for pasting into other applications by first
selecting it from the list and then typing Ctrl+V or by double clicking on the entry. Double clicking on
the entry will also close the dialog

2.12 Proofs

Click on the "Tools" menu and select "Proofs..." to display the Proofs dialog. This is a flexible tool for
producing high quality proofs of your images ready for printing. Source images can be JPEGs, JPEG
2000 images, Canon, Nikon, Minolta, Olympus or Fuji raw images, Photoshop images, PNG images or
TIFFs. In the main view "Proofs" will generate proofs for all the images in the current directory. In the
thumbnail view "Proofs" will only generate proofs for the currently selected images.
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Proofs E'

Image Size
[¢] Resize Image Urits: |inches | DFL | 240

Max size fwH) 12 |16 (2820 « 3340 pinels]
Image rotation; .nDnE v_'
[ ] Crop Image, crop ratio [w ; hi; iz
Border, zize [pixelz): |15 - Colar: l_ [3 j.fuII border v
Image Enhancement
[ ] Comect faor lens distartion
[ ] Smart Moize Beduction Filter, strength:;
[ 5aturation, walue [0 = B+, 100 = unchanged);
[ Gamma (1 = unchanged]: |
[7] st level, black point (%) |0.05 | white point (%] 0.05
Sharpen Image, Method: gngh-_a_r!:u_!'nask &
R adius: 'I _. Armnount: 15 _' Threshold: :_.EI.
[ ] atermark 1 [ ] atermark 2
Output 5 ettings
[ ] Colorspace conversion
Format: | JPEG [noEXIF) v |  Dualiy (0-100); |88

EIL_Jtput_Direct_u:ur_!,l:_ e
[ I:%phiotos\200442004-08-1 4\proofs :E]

[Lu:uau:l...] [Save...] [F'ru:u:ufSeIeu:ted] [ Proof |[ Cancel ]

2.12.1 Image size, cropping, borders and frames

Image Size

Click on the "Resize image" checkbox to resize the image and enter the new dimensions. The image
can be enlarged or reduced as required. BreezeBrowser Pro uses high quality interpolation to preserve
as much image information as possible when resizing. The size of the image can be defined in pixels,
inches or cm. When using inches or cm the image size in pixels is calculated using the specified
output DPI.

Use the "Image Rotation" dropdown list to rotate all images to landscape or portrait rotation. This is
useful if several images are to be printed in a batch.

Cropping

Select "Crop Image” if you want to crop the image so that it matches the aspect ratio of your prints.
e.g. D30 raw images are 2160x1440 pixels and have an aspect ratio of 3:2. This means that they can
be printed full frame on 6"x4" paper without cropping. However to print on 10"x8" paper some of the
picture needs to be cropped from the left and the right. "Crop Image" will crop the minimum amount
necessary to match the selected aspect ratio by taking an equal amount from the left and right (or top
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2.12.2

and bottom).

Borders

A border may be added to the image by selecting the "Border" checkbox. The border color is
user-definable and can be changed by clicking on the "..." button. Use the dropdown list to select a full
border all around the image or a border placed at the top or bottom of the image (this is useful if you
want to add a caption but don't want it placed over the image).

Picture frames

Select the "image" option and press the "..." to select an picture frame image for the border. There are
a number of predefined images in the "frames" folder where BreezeBrowser Pro is installed. Please
the Guidelines for creating picture frames section for details on how to create your own picture frame
images.

Picture frame example using drop shadow 50.png

Image Enhancement

Click on Smart Noise Reduction Filter and select the filter strength to apply smart noise filtering to the
image. Smart noise reduction uses sophisticated image processing techniques to remove noise from
digital images with virtually no loss of detail. It is particularly effective at removing noise from shadow
detail and in high ISO images. Please see the Smart Noise Reduction page for more information on
this filter.
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The saturation of the image can be increased or reduced by changing the value in the Saturation edit
box. A value of 100 represents no change in saturation. A value less than 100 reduces the saturation
and a value of 0 gives a black and white image. A value greater than 100 increases the saturation.

Use the gamma setting to change the gamma of the output image. This is useful if printed images are
lighter or darker than they appear on the screen. e.qg. if printed images look a bit dark try increasing the
gammato 1.1 or 1.2. A gamma setting of 1 leaves the image unchanged.

Select "Auto level" to automatically adjust the black and white points of the image. This is a contrast
enhancement technique which stretches the image's histogram so that it contains the full range of
tones from black through to white. The white and black points are expressed as a percentage. This
percentage represents the amount of the picture data that is at or below the threshold. e.g. a black
point value of 0% means that the darkest pixel in the image is set to black. Higher values result in a
higher contrast image but may cause some of the highlight and shadow detail to be lost e.g. a white
point value of 5% would set the brightest 5% of pixels in the image to white and would lose much of
the highlight detail. A good starting point is to set the black point to 0.2% and the white point to 0.1%.

Select sharpen image to sharpen and then select the sharpening method from the drop down list.
Unsharp mask sharpening is similar to the sharpening method found in most image editors. The
sharpening amount is expressed as a percentage in some editors (e.g. 0.7 would be expressed as
70%). The amount of sharpening required depends on the image but a good starting point is
radius=0.5, amount =0.7 and threshold=0. Generally speaking images need more sharpening when
printed than they do for displaying on a computer screen. Sharpening is usually applied as the last step
when editing images and so if you intend to edit the image after raw conversion it is probably best to
turn sharpening off and apply it after the image has been edited.

HQ style sharpening uses the same sharpening method as BreezeBrowser Pro's HQ display mode.
The amount of sharpening applied is expressed as a percentage and a value between 75% and 90%
will produce similar results to the HQ display mode.

2.12.3 Lens Distortion Correction
Most camera lenses distort the image and this can be corrected for using the lens distortion correction

option which is available in proofs. The before and after images below are from a picture taken with a
Canon EOS 20D and Canon EF 15mm /2.8 Fisheye lens (a lens popular for taking panoramas):
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Uncorrected shot from Canon EOS 20D + EF 15mm The same shot after lens distortion correction with
Fisheye lens BreezeBrowser Pro

Photo copyright www.GlenfallHouse.org. Photo by www.BigGreenFurryThings.com

BreezeBrowser Pro uses the same lens calibration files as PTLens which was developed by Thomas
Niemann (please visit http://epaperpress.com/ptlens for details). The profiles are stored in the
PTLensProfiles folder where BreezeBrowser Pro is installed. Thomas Niemann is constantly adding to
the database of lenses and the latest profiles can be downloaded from his site. The profiles are
included with BreezeBrowser Pro with Thomas Niemann's kind permission.

The lens correction uses the shooting data in the file to automatically select the lens correction
parameters. The first time you use lens distortion correction you need to setup a list of lenses and
cameras. You can do this by enabling lens distortion correction and then pressing the setup button.
The dialog below will be displayed:
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Lens Correction Setup §|
Available lens definitions: Selected lens definitions:

[#- Canon DIGITAL IXUS 410 A = Canan

[#- Canon DIGITAL IxUS S00 [+ Canan EQS 10D

[+ Canon DIGITAL IXUS I [+ Canan EQS 20D

[#]- Canon DIGITAL IXUS IT [+ Canon EDS 3000 DIGITAL

[+ Canon EOS 10D [+ Canon EDS 3500 DIGITAL

[#- Canon EQS 200 [=]- Canon EQS 50

[+ Canon EDS 3000 DIGITAL EF 17-0rmm Fi4L USM

[+ Canon EDS 3500 DIGITAL EF Z4-70mm 2, 8L LS

[=)- Canon EDS 50 EF #58-135mm f/3.5-5.6 I35 USM
EF 100mm ff2.5 USM Macro EF S0mm F'1.4
EF 15mm f}Z.5 Fisheye EF 70-200mm Ff2.5L 15 1J5M
EF 16-35mm Ff2.8L 115M [+ Canan EQS D30
EF 17-35mm Ff2.8L 1J5M [+ Canan EQS Del
EF 17-40mm Fi4L 1J5M [#- Canon EQ3-10 Mark, 1T
EF z0mm FjZ.5 SM [=)- NIKOM CORPORATION
EF z4-70mm Ff2.8L 115M [#- MIKOM D2x

EF Z4mm Ff1.4L LISM

EF 24mm F12.5

EF z8-105mm FI'3.5-4.5 IT LISM

EF 28-135mm FI'3.5-5.6 15 LUSM

EF z&-300mm FI'3.5-5.6L 15 J5M

EF 35mm Fi1.4L LISM

EF 35mm 2.0

EF S0mm Fi1.4 w |

£ *

Double click on a lens From the list of available lenses (left hand lisk) to add it to the list of selected lenses (right hand
list}. Double click on a lens in the right hand lisk ko remowve it,

Please note; it isn't possible to distinguish between a lens with a converter and the same lens without a converker
because this infarmation is not skared in the shooting data,

Ik l [ Cancel

Click on the list on the left to find your combination of camera body and lens and then double click on
the entry to copy it to the list of selected lens definitions on the right. If you have digital cameras with
different crop factors e.g. Canon EOS 350D (1.6 crop factor), Canon EOS-1D Mark Il (1.3 crop factor)
and Canon EOS 5D (1.0 crop factor), you will need to select the lenses for each camera model. The
settings are saved when you exit BreezeBrowser Pro and so you only need to do this once.

The shooting data stores the lens focal length and the zoom range of the lens and BreezeBrowser Pro
uses this to select the right lens correction factors. This means it isn't possible to distinguish between
similar lenses such as the Canon EF 24mm f/1.4L USM and the EF 24mm f/2.8. Please only select the
lenses you use to avoid confusion. BreezeBrowser Pro won't be able to apply the lens distortion
correction if the image does not contain shooting data. Some image editors discard or damage the
shooting data when saving images and so it may be necessary to use the EXIF copy tool to copy the
shooting data from the original unedited file.

2.12.4 Watermark/Captioning

Up to two watermarks or captions can be added to images. This is useful for adding a caption to
images for easy identification or for adding a watermarked copyright message to prevent unauthorized
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copying of images. The watermark can take the form of one or more lines of text or an image. The two
watermark settings are completely independent and possible uses include using one to place the word
"Proof" in the center of the image and using the other to caption the image for easy identification or to

display the copyright information.

Select the "Watermark 1" or "Watermark 2" checkboxes and click on the "Settings" button to display

the "Watermark Settings" dialog:

Watermark Settings ﬁl

W atermark, Type
) Test [uze S for line breaks)

(%) Image [GIF. PHG or JPEG)

D:-Mimageshcopyright. png E]
Appearance
Fant:
Alignment;
Foreground colar; . Transparency: | Opaque w |
B ackground colar; Tranzparency:
Flacement
Flacement: : Bottarn, right v |

Harizontal offzet [piselz]: {10

Wertical offzet [pivelsz): 10

Cancel

x|

First select the watermark type as text or an image.

The watermark/caption text can contain any of the HTML tokens (see HTML page generation) to
include EXIF or IPTC data from the image e.g. use @year@ for the year in which the image was
taken. The text can be broken down into separate lines by inserting \n for the line breaks. Use the
"Alignment" drop down list to select the text alignment for multi-line watermarks.

Click on the "..." button to the right of the font display to select the font type, size and appearance. The
watermark text will be anti-aliased (a technique to smooth jagged edges) if a TrueType font is used
e.g. Arial. The size of the font in pixels is determined by the point size specified in the font settings
dialog and output DPI of the proofed image. If the image is being resized using a DPI and size in
inches or cm this will be the DPI that is used to calculate the font size otherwise the vertical DPI of the
screen will be used (this is usually 96 DPI).

NOTE: To include the copyright symbol, ©, hold the ALT key down and enter 0169 on the numeric
keypad.
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The image can be a JPEG, GIF or PNG. GIF and 8-bit PNG images can contain single level
transparency (i.e. pixels are either fully opaque or fully transparent). 24-bit PNG images support
multi-level transparency making it possible to blend the edges of a logo with the underlying image and
avoid the sharp edges you get with single level transparency.

For obvious reasons it isn't possible to use an animated GIF image.

Click on the "..." buttons after the foreground and background color displays to change the colors (this
is disabled for image watermarks). The transparency dropdown lists define how the watermark is
combined with the image. The transparency can be set from opaque through to 100% transparent in
25% steps.

Use the "Watermark placement" dropdown list to specify where the watermark should appear. The
horizontal and vertical offsets can be used to adjust the position of the watermark. e.g. a vertical offset
of 5 pixels with top, centered placement would position the top of the watermark 5 pixels from the top
of the image. With bottom centered placement the bottom of the watermark would be 5 pixels from the
bottom of the image.

Here are some examples to show some of the different settings:

Black 75% transparent foreground
White 75% transparent background transparent background Bottom,
Repeating strips at 1/5 & 4/5 height center placement

._.!'

=
=T T N
1ﬂmm1An= _
\ iyl © 2002 Chris Breeze
Black, opaque foreground White 50% Transparent GIF image Bottom,
transparent background Top, center center placement with 4 pixel vertical
placement offset

2.12.5 Output settings

Use the "Format:" drop down list to select the output format as JPEG, JPEG 2000, JPEG 2000 16-bit,
8-bit PNG, 16-bit PNG, 8-bit TIFF, 16-bit TIFF, 8-bit PSD, 16-bit PSD or JPEG (no EXIF). The JPEG
quality can be set between 0 (very poor quality, high compression) to 100 (high quality, large file size).
JPEG 2000 files use lossless compression if the quality is set at 100, and lossy compression for other
values. Use the "JPEG (no EXIF)" option to output the image as a JPEG without EXIF shooting data,
IPTC/XMP data or an embedded thumbnail image to reduce the file size. Note: The writing of
IPCT/XMP data to "JPEG (no EXIF)" images can be enabled using BBUil.

Images are only saved as 16-bit TIFF, PNG, PSD or JPEG 2000 files if the source image contains
16-bit data (e.g. a 16-bit TIFF or a raw file from a Canon EOS 30D, Nikon D200 etc.). If the source
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2.12.6

data is 8-bit the final images will be saved as 8-bit files even if a 16-bit format has been selected.

For maximum quality all processing is carried out in 16-bit mode if the source image contains 16-bit
data. The image is only converted back to 8-bits as the final operation when the output format is 8-bit.

Enter the output directory in the edit box provided or click on the "..." button to display the directory
browser to select a directory. The output directory defaults to "proofs".

DPI value saved in JPEGs and TIFFs

JPEG and TIFF files can store the resolution of the image in DPI. The DPI value does not affect the
image data stored in the image - it will contain the same number of pixels whatever the DPI is set to.
Some applications such as Adobe Photoshop use the DPI setting and the number of pixels in an
image to determine the print size e.g. an image which is 3000 x 2000 pixels with a DPI of 200 will give
a print size of 15 inches by 10 inches.

The DPI value that BreezeBrowser Pro writes to JPEG and TIFF images when running the proofs tool
depends on which resize option is selected. If the image is resized using a size specified in inches or
cm together with a DPI value then it is the specified DPI value that is written to the JPEG or TIFF.

Renaming of output files

The default setting for output filenames is the same filename as the source file being proofed. Images
can also be renamed using similar tokens to batch rename. To enable this select the "Rename output
files" checkbox and enter the rename template in the text box. Only the filename part without the file
extension should be entered (the file extension is added automatically).

e.g. to prefix the original filename with the time the photo was taken use: %t_%0

Colorspace conversion

By default the proofs function copies the embedded color profile of the source image to the
output image without modifying the colorspace. Select the "Colorspace conversion™ checkbox
and then click on the "Settings..." button to convert between colorspaces. The dialog below
will be displayed:

Colorspace Conversion Settings @

Output Profile;
:RGE Calar Space Prafile D

Embed profile in output image

Rendering intent: | Perceptual b

[ Ok ][ Cancel ]

Press on the "..." button to browse for the color profile you wish to convert to. Select the
rendering intent to use from the drop down list (the rendering intent controls how "out of
gamut” colors are handled and is usually set to "perceptual” for photographs). It is only
possible to convert the color space of images that contain an embedded profile describing
their color space.
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Color management and the use of color profiles is a complex subject and a detailed
description of how to use them is beyond the scope of this manual.

2.12.7 Guidelines for creating picture frames

The picture frame image should be six times the width and height of the required border width e.g. for
a border 10 pixels wide the image needs to be 60 x 60 pixels in size. It is a good idea to include the
border width in the filename to make identification easier and to save it in a lossless format such as
PNG.

The easiest way to explain how the picture frame image should be created is to look at the example
image "test 20.png" which can be found in the frames folder. This image defines a frame 20 pixels
wide using an image 120 x 120 pixels in size (6 times the border width) and is shown below:

A B B i
G H
1 N
g P S

The frame is defined by the 20 pixel wide border around the image (blocks A to T). The central white
and gray chequer board area is not used and so you could add descriptive text or notes here to help
identify the border.

When the frame is added to the image (as shown below) the green corners (ABG, EFH, MOP and
NST) are copied to the corners of the destination image. Then the blue edges are copied repeatedly
along the edges of destination image until they meet the corners.

Note how the edge CD butts up against the corner B and is repeated along the top edge (CDCDCD
etc.) until it reaches the corner E. The actual point at which the edge finishes depends on the size of
the destination image - in the example above approximately half of block D is copied before it meets
block E. Care is required to make sure the the boundaries (B/C, D/C etc.) blend well when designing to
a border image.

Note: The width and height of the border image do not need to be the same. The "black H22 x V44"
example in the frames folder shows how a border can be defined which is 22 pixels thick down the left
and right sides and 44 pixels thick along the top and bottom.

Here are some more examples of different picture frame images and how they appear when applied to
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2.13

a photo:

black matte 30.png

example using drop shadow 50.png

drop shadow 50.png

Image Ranking

Image ranking assigns a numeric rank to an image from 1 to 5 where 5 is the highest and 1 is the
lowest. The ranking order can be changed in preferences so that 1 is the highest and 5 is the lowest.

The image ranking is displayed as a number in the top right corner of thumbnails and in the Window
title bar in the main view. The ranking is also available using the token @ranking@ and this can be
used to access the ranking in web galleries, batch rename and in the shooting data and status line
displays. The image ranking is stored in a simple text file called ranked_files.txt which is stored in the
same folder as the images. This means that it is not possible to use image ranking on read only drives
e.g. CDs.

The ranking of an image can be set by right clicking on the image and selecting "Image ranking" from
the popup menu or by holding the Ctrl key down and pressing 1 to 5 or 0 to remove the ranking. Image
rankings can be set in the main, thumbnail and filmstrip views plus slideshow and the image
comparison window. In slideshow the ranking can be set by pressing the number keys 0 to 5 (without
pressing the Ctrl key). The slideshow caption text needs to be edited to include something like
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"Ranking=@ranking@" in order to display the ranking.

Images can be sorted according to their ranking by clicking on the "View" menu followed by "Image
Order" and selecting "Sort by Ranking". The image ranking is retained if images are copied or moved
to other folders using BreezeBrowser Pro.

Images can be added to the current selection according to their ranking in thumbnail and filmstrip view
by typing Ctrl+Alt+1 through to Ctrl+Alt+5. This gives great flexibility in selecting ranked images when
combined with the other keyboard shortcuts.

e.g.

Select only images ranked 1: Type Ctrl+N (select none) followed by Ctrl+Alt+1 (add images ranked 1
to selection)

Add images ranked 3 to the current selection: Type Ctrl+Alt+3 (add images ranked 3 to selection)
Remove images ranked 2 from current selection: Type Ctrl+l (invert selection) followed by Ctrl+Alt+2
(add images ranked 2 to selection) then Ctrl+l (invert selection)

BreezeBrowser Pro stores the ranking information in a simple text file called ranked_files.txt in the
same directory as the images. It can also optionally store the ranking information in the IPTC Urgency
field of image files that support IPTC data (please see preferences for details).

Compatibility with Adobe Ratings (used by Adobe Lightroom and Bridge/Photoshop)

Adobe Bridge image ratings can be copied into BreezeBrowser Pro by selecting
File->Rankings->Import Adobe Ratings.

BreezeBrowser Pro rankings can also be copied to the XMP data in images where they can be read by
Adobe Bridge. To do this select File->Image Rankings->Export Rankings to Adobe Ratings. Please
note that it may take several minutes for Adobe Bridge to update its display after the rankings have
been copied.

BreezeBrowser Pro can also automatically update the Adobe rating when changing the image ranking.
To enable this select the option to "Also store ranking as Adobe rating if image supports XMP data" in
preferences. The Adobe rating and label information can be displayed in BreezeBrowser Pro's
thumbnail views by setting the thumbnail shooting data display settings.

2.14 Smart Noise Reduction Filter

It's a fact that all digital images contain noise even at low ISO settings. Often this noise can be seen in
the details in shadows and in blue skies. As the 1ISO sensitivity is increased this noise becomes more
and more pronounced to the extent that the highest ISO settings for most digital cameras are barely
usable. With BreezeBrowser Pro's Smart Noise Reduction technology, SmNR for short, you can now
do something about it. SmNR filters out the noise in images and, unlike other noise filters, there is
virtually no loss of detail.

To get an idea of what SmMNR can do, take a look at the speedway shot below taken with a Canon
EOS-1D at ISO 1000.
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Photo: Copyright © 2002, Keith Curtis http://photo-art.co.uk

Image Details

Camera Model: Canon EOS-1D
Firmware Version 1.3.0

Shutter speed: 1/400 sec
Aperture: 5.6

Exposure mode: Manual

ISO: 1000

Focal length: 400.0 mm

AF mode: Al Servo AF

The two pictures below show the effects of SmNR on part of this image. Both images are unsharpened
and were converted using identical settings in BreezeBrowser Pro - the one on the left has SmMNR

turned OFF and the one on the right has it set to High.
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Converted with no noise reduction Converted with Smart Noise Reduction set to High

Notice how the noise in the area behind the rider and on his goggles has been filtered out in the right
shot with virtually no loss of detail.

SmMNR has been carefully designed and optimized using a large number of images from different
digital cameras. Unlike other methods, it is optimized for each camera model. Because noise from
different camera models is actually quite different SmNR uses shooting data from the image to
determine the best settings to use. It then carefully analyzes your image and decides which areas
contain important details and which contain undesirable noise, removing the noise and leaving the
details untouched.

SmNR can dramatically reduce the noise in shadow areas and this effectively increases the usable
dynamic range of the image. So techniques like Contrast Masking are more effective and more detail
can be rescued from underexposed images.

BreezeBrowser Pro uses noise reduction technology developed by Kevin Dobson. Click here for more
information.

Please Note: When SmNR is used in an unregistered version of BreezeBrowser Pro a watermark is
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added to the image. This watermark is disabled when BreezeBrowser Pro is registered.

SmNR is available when using proofs.

BreezeBrowser Pro Utility App

The BreezeBrowser Pro utility app allows you to change some of the less commonly used

configuration settings and to reset BreezeBrowser Pro to its default settings if you are having problems
running it.

The app can be run by double clicking on the BButil icon in the BreezeBrowser Pro installation folder:

=

BEUkl, gxe

ﬁ BEButil for BreezeBrowser Pro .

Please dose any copies of BreezeBrowser Pro before running this utility.
Additional Configuration settings

IJse bold border when highlighting tagged images in thumbnail view

Allow Delete key to delete folders in thumbnail view

Show confirmation dialog when deleting multiple files

(] specify processor affinity if you are having problems on a dual CPU system
Affinity (0 to 30): 0

[ ]uze old style toolbar

[ wirite IPTC/XMP data to "JFEG (no EXIF)" proofs

] wirite legacy IPTC IIM data to Nikon NEF raw files

Do not cancel magnifier when moving to the next or previous image

[ | Display GPS icon in thumbnail view (WARNING: slows down thumbnail display)

[ ]Use Canon SDK to read EXIF data from Canon files (slower but more detailed)

Width of dropdown image list in the toolbar (default=170 pixels):
Toolbar percentage scale factor {100=normal size):

Font size in points (0= use system default): IZI

If you are having problems running BreezeBrowser Pro: | Reset settings. ..

QK Cancel

The "Use bolder border when highlighting tagged images in thumbnail view" setting draws a two pixel
wide border around tagged images to make them easier to see,

By default the Delete key does not delete folders to avoid the accidental deletion of folders. It can be
enabled by selecting "Allow Delete key to delete folders in thumbnail view".

Normally a confirmation dialog is displayed when deleting more than one image at a time. This dialog
can be suppressed by unchecking "Show confirmation dialog when deleting multiple files".
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BreezeBrowser Pro should run without any problems on dual processor PCs and ones using Pentium
HT (Hyper threading) processors. If you are having problems with running BreezeBrowser Pro on
these systems you can set the processor affinity so that BreezeBrowser Pro will only run on one
processor. (Normally this value would be set to 0 or 1 to run on the first or second CPU only).

By default IPTC/XMP data is not written to images generated by proofs using the "JPEG (no EXIF)"
output option. Select 'Write IPTC/XMP data to "JPEG (no EXIF)" proofs' if you wish any IPTC/XMP
data in the source image to be copied to the proofed image.

Select "Write legacy IPTC IIM data to Nikon NEF raw files" if you want IPTC IIM data to be stored in
the Nikon NEF raw file for compatibility with apps which do not support IPTC XMP data.
WARNING: Some raw conversion applications may have problems converting Nikon NEF raw files
containing IPTC |IM data.

The "Use Canon SDK to read EXIF data from Canon files" setting results in slightly slower display of
images from Canon cameras but may give more accurate shooting data display for some attributes.
Disable this option for maximum speed e.g. when batch renaming a large number of images from a
Canon camera.

When BreezeBrowser Pro is run on a high DPI display the toolbar icons may be too small. They can
be made larger by setting the "Toolbar percentage scale factor" to a larger value e.g. setting it to 200
will double the size of the icons.

Previous versions of BreezeBrowser Pro used different icons in the toolbar which were smaller than
the default icons. You can select these by setting "use old style toolbar".

The default setting is for BreezeBrowser Pro to cancel the image magnifier when displaying the next or
previous image. Select the "Do not cancel magnifier when moving to the next or previous image" if you
wish the magnifier to continue to be displayed.

Sometimes a corrupted or unusual image can cause BreezeBrowser Pro problems when it starts up. If
your preference settings are set to load the last viewed folder each time BreezeBrowser Pro starts up
this can be a problem. You can reset the startup folder and other settings by pressing the "Reset
setting..." button. A dialog will be displayed giving you various options to reset the configuration values
saved in the Windows registry.

If the toolbar appears too small on high resolution displays it can be made larger using the "Toolbar
percentage scale factor" setting e.g. set this to 200 to double the size of the toolbar.

By default the font size used in the main window is the same as the default Windows system font. This
can be changed using the "Font size in points" setting.

2.16 Transferring images from your camera

BreezeBrowser Pro cannot read images directly from your camera and so it is necessary to transfer
them to your computer's hard disk first. This can be done either by downloading the images from the
camera via the USB cable or by using a card reader (either USB or FireWire). Our Downloader Pro
application has been designed to download images quickly and simply from Canon cameras or using a
card reader with any DCF compliant camera.

Downloader Pro and BreezeBrowser Pro have been designed to work together but you don't need
Downloader Pro in order to run BreezeBrowser Pro. When Downloader Pro is installed on your system
the "File" menu in BreezeBrowser Pro has the option "Download files..." added. When this option is
selected Downloader Pro is refreshed if it is already running or started up if it is not running.
Downloader Pro can be set up to automatically download files from your camera or card reader, delete
them from the CF card and then launch BreezeBrowser Pro to view them. If BreezeBrowser Pro is
already running Downloader Pro will make the BreezeBrowser Pro window visible and display the
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downloaded files. If BreezeBrowser Pro is busy Downloader Pro will ask you whether you want to run
another copy of BreezeBrowser Pro to view the files.

Downloader Pro can be downloaded from www.breezesys.com.

Breeze Viewer

Breeze Viewer is a simple standalone utility for monitoring the contents of a folder and displaying
JPEG images and animated GIFs in a slideshow. New images added to the folder are automatically
added to the slideshow after a preset "stable time". Breeze Viewer displays the images as a full screen
slideshow with a black background and an optional caption showing the image filename. It can be
setup to display the newest image only or to run a slideshow of all the images in the folder being
monitored.

Breeze Viewer is aimed primarily at event photographers who want to display a rolling slideshow of
images added to a folder. Here are a few suggestions of how it might be used:

1. To display images as they are downloaded from a camera or memory card using our Downloader
Pro software. Simply select the download folder as the folder to monitor and Breeze Viewer will
display the images as they are downloaded. Set the stable time to at least 2 seconds to allow
enough time for the images to be downloaded before attempting to display them.

2. The same as above but use BreezeBrowser Pro to select which images are to be displayed.
Downloader Pro could be setup to download the images to the incoming folder, e.g. C:\Incoming,
and Breeze Viewer setup to view the selects folder, e.g. C:\Incoming\Selects. Then use
BreezeBrowser Pro to view the images and copy the best shots to the selects folder for display. This
setup could be used on a single PC with two monitors: one monitor would be visible to the guests/
clients with Breeze Viewer running on it and the other would used by the operator to select the
images with BreezeBrowser Pro.

3. In conjunction with our photo booth software (NKRemote for Nikon digital SLRs, DSLR Remote Pro
for Canon EOS cameras, Webcam Photobooth for webcams or PSRemote for Canon PowerShot
cameras). The main photo booth screens would be displayed to the users in the photo booth using
one monitor and a second monitor could be placed outside the booth running Breeze Viewer to
display the images. The individual shots could be displayed by monitoring the main images folder for
the photo booth or, if the "print and JPEG copy" output option is selected in the photo booth
software, it could display the finished strips.

The following dialog is displayed when Breeze Viewer is run:
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€%, Breeze Viewer v1.5.7 (BreezeBrowser Pro) by Breeze Systermns >

Folder to maonitor for images:
| C:WUsers\Chris\Documents PhotoboothImages\20 17-01-04

[ ]5can subfolders for images [ ] auto run slideshow on startup

Stable time (secs): {time during which image file size should remain unchanged
before new images are displayed)

Transition: | Flip b Background calar: .

Optional background image:

Mosaic layout settings

Rows: 3 Columns: | 3 Random filing  Full size display time {ms): | 5000
Horizontal spacing: 0 Vertical spacing: 0 Background fade (0 to 255): 170
[ ]cropimage, Left: O Top: (0O Width: | 1000 Height: | 1000

Max percentage upscaling:
Sharpen image, amount (0 to 100); {default setting=75)
Enable slideshow, interval (secs):

Show caption Caption settings... [ ]5how tilesfads | Titles/Ads settings. ..

Double dick to exit, password: | breeze |

Display images in random order

[ | Display new files next

[ | Display images in black and white

Auto rotate JPEGs using EXIF Orientation data

Run

Copyright 2009 to 2017, Breeze Systems Litd

www. breezesys.com Help Exit

First select the folder to be monitored for images. When new images are found in the folder being
monitored they are added to the slideshow and images deleted from the folder are removed from the
slideshow. If the "Scan subfolders for images" option is selected BreezeViewer will also scan
subfolders for JPEG images to include in the slideshow.

Tokens for the date can be used when specifying the folder to be monitored for images e.g. C:
\Users\Chris\Documents\Photoboothimages\%Y-%m-%D. The following date based tokens can be

used:
%a Abbreviated weekday name e.g. Fri
%A Full weekday name e.g. Friday
%b Abbreviated month name e.g. Jun
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%B
%d

%D
%H
%l
%

%l

%L
%m
%M
%p
%S

Yot

%W
%X
%X
%y
%Y
%z
%Z

%1

%2
%3

Full month name e.g.

Date in the form YYMMDD
(equivalent to %y%m%D)

Day of the month (01 to 31)
Hour (00 to 23)
Hour (01 to 12)
Day of the year (001 to 366)

Long date/time representation of
locale

Long date representation for locale |e.g.

Month (01 to 12) e.g.
Minutes (00 to 59)
am/pm indicator e.g.
Seconds (00 to 59)

Time in the form HHMMSS
(equivalent to %H%M%S)

Week number (00 to 53)

Date representation for locale e.g.
Time representation for locale e.g.
Year without century e.g.
Year with century e.g.
Time zone name e.g.
Time zone offset wrt UTC e.g.

Year 'now - 8 hours' in the form
YYYY.

The 8 hour offset is to allow date
tokens to remain the same for
events which continue after
midnight

Month 'now - 8 hours' (01 to 12)
Day 'now - 8 hours' (01 to 31)

e.g.

June

. 030615 for June 11, 2015

. Wednesday, June 17, 2015 19:03:47

Wednesday, June 17, 2015
06 for June

PM

06/10/11 for June 10, 2015
14:39:29

10

2015

GMT Standard Time

+0100 for GMT during DST

2015

Select the "Auto run slideshow on startup" if you would like the slideshow to start automatically when
Breeze Viewer is run.

The normal way to exit the slideshow is to press the escape key on the keyboard, but this can be a
problem if the slideshow is running on a tablet PC which doesn't have a keyboard. If this is a problem,
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you can select the "Double click to exit" option to exit the slideshow by double clicking in the bottom
right corner of the screen. Enter a password in the "password:" edit box to prevent users from being
able to exit the slideshow. When a password is defined a touchscreen keyboard asking for the
password will be displayed when double clicking in the bottom right corner of the screen.

The "stable time" is the number of seconds the file size must stay the same before the image is
displayed by Breeze Viewer. This can be set to a low value such as 2 seconds if the images are simply
being copied into the folder from another folder on the disk. A longer value is useful if the images are
being transferred by FTP from a remote computer where network delays may cause the transfer to
pause for several seconds. This will prevent Breeze Viewer from trying to display an image which has
only been partially transferred from the remote computer.

The transition between images can be set to one of the following:

"None" - images are displayed instantly

"Vertical slide" - the next image slides down from the top of the screen and pushes the current image
off the bottom

"Diagonal slide" - the next image slides down from the top, right of the screen and pushes the current
image off the bottom, left

"Horizontal slide" - the next image slides down from the right of the screen and pushes the current
image off the left

"Fade to black” - the current image fades to black then the screen fades from black to the next image
"Dissolve" - the current image dissolves into the next image

"Flip" - the screen flips like turning a playing card to hide the current image and reveal the next image
"Cube" - the screen rotates like a cube to hide the current image and reveal the next image

"Random slides" - randomly uses a vertical, horizontal or diagonal slide for each transition

"Random " - randomly uses one of the above transitions

"Mosaic" - displays a mosaic of images on the screen using the specified number of rows and columns
"Mosaic with fade" - same as mosaic, uses fade to black when switching images

"Mosaic with dissolve" - same as mosaic, uses dissolve when switching images

"Mosaic with zoom" - same as mosaic, but displays each image full screen first then zooms it down to
its mosaic display position. The "Full size display time (ms)" setting specifies how long in milliseconds
the image should be displayed full size before zooming down to its mosaic display position.

"Mosaic with zoom + bg fade" - same as ""mosaic with zoom", but fades the mosaic background when
displaying the zoomed image. The "Background fade" setting specifies the amount by which the
background is faded (0=no fade, 255=fade to black)

Please note: some graphics cards my have limited support for the graphics acceleration required for
some of the slideshow transitions and the slideshow may run very slow. Please use the "None" or
"Mosaic" slideshow transitions if you experience performance problems.

The background color used for the slideshow can be changed by clicking on the "..." button to the right
of the "Background color:" display.

The slideshow can be displayed on an optional JPEG background image by entering the full pathname
of image in the "Optional background image:" text box or by clicking on the "..." button and selecting
the background file. When the slideshow runs the background image will be resized to fit the screen. If
the background image doesn't have the same aspect ratio as the screen the background color will be
visible above and below or to the left and right of the background image.

When one of the mosaic layout transitions is selected the "Mosaic layout settings" can be used to
adjust the layout. Use the "Rows" and "Columns" settings to specify the number of rows and columns
of photos to show. When the "Random tiling" option is selected the photos are updated in random
positions on the display. When it is not selected the photos are placed in order from the left to right and
top to bottom. The horizontal and vertical spacing options allow the spacing between photos to be
adjusted.

Images can be cropped before they are displayed by selecting the "Crop image" checkbox and
specifying the crop area using the "left", "top", "width" and "height" settings. This option is useful if you
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are running a slideshow of photos from a photo booth setup to print double strips of 4. You can use the
crop option to crop the double strip of 4 into a single strip for display and then maybe use the mosaic
display option to display several strips at a time. For example suppose the photo booth is printing
double strips of 4 photos on 6"x4" paper @ 300 dpi. The print layout will be 1228 x 1864 pixels in size,
including the printer margins, and this can be cropped into a single strip by setting left=14, top=16,
width=600 and height=1800.

The "Max percentage upscaling;" setting controls how small images are enlarged to fill the display. If
the percentage upscaling is set to 100 the images will not be enlarged. Setting the percentage to 200
will allow small images to be enlarged up to a factor of 2.

Select "Sharpen image" and the sharpening amount to sharpen the displayed images. This uses the
same HQ sharpening method as BreezeBrowser Pro. The default setting is 75.

Select "Enable slideshow" and a suitable interval to display all the images in the folder in a continuous
loop. The interval in seconds can be specified in the "Interval (secs):" text box. Use a negative value to
specify the interval in milliseconds e.g. -200 to display a slide every 200ms (or 5 slides per second).
Please note that minimum slideshow interval may be limited by the speed of the computer.

Select "Show caption" to display the full pathname of each image in the top left corner of the screen.
Click on the "Caption settings..." button to specify the caption text, font, color and placement:

Capticn Settings [é]

Caption text:

{fileMoExt}

Font: Arial, 22 point | o

Foreground color; l_ [:|
Background color; . D

Alignment: | Centered -

Offset in pixels from left of sareen: 360

Offsetin pixels from top of screen: 1047

oK ] [ Cancel

The caption text can use the following tokens to display information about the currently displayed
image:

{pathname} - the full pathname of the image including drive letter, folder and filename e.g. C:
\photobooth\2012-12-16\IMG_0001.JPG

{dir} - the pathname of the folder being monitored for images e.g. C:\photobooth\2012-12-16
{file} - the filename of the image including the file extension e.g. IMG_0001.JPG

{fileNoExt} - the filename of the image without the file extension e.g. IMG_0001

{time} - the file creation time of the image in 12 hour format e.g. 9:45:07

{time24} - the file creation time of the image in 24 hour format e.g. 21:45:07

%a to %z - various formatting codes to display the date and time using the file creation time (Google
strftime for details) e.g. %a gives the abbreviated weekday name
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{left,n,str} - Extracts the first n characters from str (which can be a string or token) e.qg. {left,4,{file}}
gives the first 4 characters of the filename

{mid,n,m,str} - Extracts m characters starting from the n'th character from str (which can be a string or
token) e.g. {mid,1,2,{file}} gives the 2nd and 3rd characters of the filename

{right,n,str} - Extracts the last n characters from str (which can be a string or token) e.g.

{right,4 {fileNoExt}} gives the last 4 characters of the filename

Click on the "..." button to the right of the font display to select the font type, size and style. Then click
on "..." buttons to the right of the foreground and background colors to select the colors.

Use the alignment dropdown list to select the text alignment (left justified, centered or right justified).
Then define the placement of the text using the left and top offset values.

When captions are not selected the image is displayed on a plain black background.

Select "Show titles/ads" to display title pages or adverts every few images during the slideshow. Click
on the "Titles/Ads settings..." button to display the titles/ads settings page:

Titles/Ads Settings e

Folder containing tittes/ad JPEG images:
C:\photobooth'\title pages

Mumber of images to display between titlesfads: 4

Display time in secs (0=same as photos): ]

|_ Ok ] [ Cancel

The title pages/adverts need to be in a different folder to the folder that is being monitored for
slideshow images and can be selected by clicking on the "..." browse button on the right. The
frequency with which the titles/ads are displayed is set using the "Number of images to display
between titles/ads" field. When the slideshow is started it scans the folder containing titles/ad JPEG
images and sorts them so that they are displayed in alphabetical order.

By default the display time of the title page/advert is the same as the display time as the other photos
in the slideshow. To change the display time for title pages/adverts set "Display time in secs (0O=same
as photos)" to a non-zero value.

Select "Display images in random order" to display each image in a random order. To ensure each
image is displayed this works in a similar way to shuffling a deck of cards then dealing each card in
turn before shuffling again and repeating the process. You can also select the option to "Display new
files next" when "Display images in random order" is selected. This will ensure that new files added to
the folder are displayed as the next image rather than in random order.

Normally images are automatically rotated using the rotation value read from the EXIF Orientation tag
in the image shooting data. Uncheck the "Auto rotate JPEGs using EXIF Oirentation data" option to
display images without rotation.

Press the "Run" button to start the viewer using the current settings. On a dual monitor system drag
the settings dialog to the monitor you wish to display the images on before pressing the "Run” button. If
the "Auto run" option is selected Breeze Viewer will automatically start running the slideshow using the
saved settings when it starts up.

Press the "Esc" key to exit the slideshow and return to the settings dialog.

© 2004 to 2023 Breeze Systems Ltd



114

BreezeBrowser Pro Help

2.18

Preference Settings

Select the 'File->Preferences..." menu item to display the 'Preferences' dialog.

2.18.1 General

Preferences .

Gereral Caption Image Display Editor HTML Generation
Deleting Images
Confirm before deleting images
{® Send deleted images to the Recycle Bin
i) Move deleted images to "DELETED" subdirectory

Load most recent directory when starting BreezeBrowser Pro

IUse IPTC description/caption in preference to EXIF comments

[ ] Ranking 1=highest, S<lowest {5=highest when not set)

Enable spacebar and 0 to 5 keyboard shortcuts for taggingranking
Also store ranking as Adobe Rating if image supports XMFP data

[] Store ranking in IPTC urgency field i image supportz IPTC data

[ ] Alsa store IPTC data in legacy IPTC 1M format

[ ] Wraparound when using next/previous to step through images

[ ] Do nat write Breeze Browser.dat file to store thumbnail order

[ ] Preserve file modfication time when rotating and annotating images
] Show hidden folders and images

Manitor folder for changes and update display automatically

Enable high DPI mode for high DP| displays

Double-click on image action: | main view <-= thumbnail view b

Cancs

The General Preferences dialog allows you to specify what happens to images when they are deleted.
They can either be moved to the "DELETED" subdirectory or moved to the standard Windows Recycle
Bin. The move to "DELETED" subdirectory option is useful for moving "second-rate" shots to a
subdirectory without actually deleting them. By default a confirmation dialog will be displayed before
deleting images. Uncheck the 'Confirm before deleting images' checkbox if you do not wish to be
prompted when deleting images.

When BreezeBrowser Pro starts up it normally loads the most recently viewed directory. Uncheck
"Load most recent directory when starting BreezeBrowser Pro" if you prefer BreezeBrowser Pro to
start up without loading a directory.

Select "Use IPTC caption in preference to EXIF comments" to store comments as IPTC data. This
allows comments of almost any length to be added to any TIFF, JPEG or Canon raw file and avoids
the limitations of EXIF comments. EXIF comments can only be edited using BreezeBrowser Pro if the
file already contains an EXIF UserComment field and comments are limited to length of that field.
When IPTC captions are selected BreezeBrowser Pro will display the IPTC caption unless it is empty
in which case it will display the EXIF comment instead. When editing comments with IPTC captions
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enabled the comment is saved to both the EXIF UserComment and the IPTC caption.

The default setting for image ranking is for a rank of 5 to be the highest value and 1 the lowest value.
Check the "Rank 1=highest..." checkbox to reverse this so that a rank of 1 is the highest value and 5 is
the lowest.

Select the option to "Also store ranking as Adobe rating if image supports XMP data" to update the
Adobe Rating when changing the ranking so that this information is available to other applications such
as Adobe Lightroom or Photoshop. This option will also enable the writing of Adobe labels to image
formats that support XMP data. The Adobe rating and label information can be displayed in
BreezeBrowser Pro's thumbnail views by setting the thumbnail shooting data display settings.

BreezeBrowser Pro stores IPTC information using Adobe XMP format which replaces the older IPTC
[IM format. Select "Also store IPTC data in legacy IPTC IIM format" if you want BreezeBrowser Pro to
write IPTC data in both XMP and IIM formats to support legacy applications which can only read IPTC
IIM format. please see the section on IPTC data for more information about XMP and I[IM formats.

Some applications use the IPTC urgency field to store ranking information with the image. Select
"Store ranking in IPTC urgency field if image supports IPTC data" to get BreezeBrowser Pro to store
the ranking information in the IPTC urgency field. BreezeBrowser Pro will only copy ranking
information to the IPTC urgency field. It doesn't read the IPTC data to determine the ranking of an
image (this is stored in the ranked_files.txt file with the images).

The BreezeBrowser Pro rankings are mapped to IPTC urgency values as follows:

Ranking IPTC Urgency Value
None 0

Highest
High
Medium
Low
Lowest

b wWNPEF

Please note that changing the ranking for an image may take longer when this option is selected
because the IPTC data has to updated.

Select the wraparound check box if you would like BreezeBrowser Pro to wraparound to the first image
when pressing "Next" with the last image displayed. BreezeBrowser Pro will also wraparound to the
last image if "Previous" is pressed when the first image is displayed.

BreezeBrowser Pro writes a small text file called BreezeBrowser.dat in each folder containing images
that views. This file contains information about the thumbnail sort order. Check the "Do not write
BreezeBrowser.dat..." checkbox if you do not wish this file to be written.

Normally the modification time of an image file is updated when it is modified by being rotated or the
comments are edited. This can be annoying when viewing images in software which displays them in
chronological order using the modification time. To avoid this select "Preserve file modification time
when rotating and annotating images".

This is not a problem when viewing images in timestamp order in BreezeBrowser Pro because it uses
the EXIF date and time and file creation time to sort images.

Note: BreezeBrowser Pro will still set the file's archive bit so that backup software will know that the
image has changed since the last backup.

By default BreezeBrowser Pro does not display hidden folders but this can be enabled by selecting
"Show hidden folders".

Select "Enable spacebar and 0 to 5 keyboard shortcuts for tagging/ranking” to use the spacebar to tag
images and the keys 0 to 5 to rank images in the main, thumbnail and filmstrip views. Normally
Windows keyboard shortcuts require a keyboard modifier like the Ctrl or Alt keys to be pressed to
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avoid the shortcuts being confused with normal typing. This option allows you to rank or tag images
without having to press the Ctrl key.

Note: These shortcuts won't work in main view if the image drop down list has input focus.

When the "Monitor folder for changes and update display automatically”" checkbox is selected
BreezeBrowser Pro will monitor the current folder for new, modified or deleted images and update its

main and thumbnail displays to show the changes. Images displayed in the slideshow will also be
updated.

Select "Enable high DPI mode for high DPI displays" to use the full display resolution when running
BreezeBrowser Pro on a computer with a high DPI display. If this option is disabled on a high DPI
computer Windows will display BreezeBrowser Pro at a lower resolution than the full screen resolution
and scale the window to the screen resolution which may give lower quality results. Please note that
changes to this setting won't take effect until next time BreezeBrowser Pro is run.

The toolbar icons may appear too small when BreezeBrowser Pro is run on a high DPI screen. If this is
a problem the icon size can be adjusted using the BBULil utility.

Use the "Double-click on image action" drop down list to select what happens when you double-click
on an image in main view, thumbnail view or filmstrip view. The default action is to switch from main
view to thumbnail view and back again. The various options are:

Option Description

main view <-> thumbnail view Switch between main view and thumbnail view

View actual image View the image fullsize in a separate window

Edit image Edit the image in the currently defined image editor

main view <-> filmstrip + EXIF Switch between main view and filmstrip view with EXIF data
main view <-> filmstrip + folders Switch between main view and filmstrip view with folder display

thumbnail view <-> filmstrip + EXIF |Switch between thumbnail view and filmstrip view with EXIF data

thumbnail view <-> filmstrip + folders|Switch between thumbnail view and filmstrip view with folder
display

magnifier on/off Switches the magnifier on or off (in thumbnail view the display is

switched to main view before displaying the magnifier)

Pressing the Esc key also has the same effect as double clicking on an image.
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2.18.2 Caption

Preferences *

General Caption  |mage Display Editor HTML Generation

Enter format strings below to customize the captions displayed by
BreezeBrowser Pro. Shooting data can be displayed by using tokens like
@date@ for the date and @model @ for the camera model.

|se “n toinser line breaks e.g. @date @ \n@model @
Press the "Reset” buttons to restore the settings to their default values.

Status line format string:
|@_.-ear@f@1mnth@f@da:.'@ @time@, @lens@mm @ @fDCé| Reset

Main view EXIF summary format string:

| [Eexif Summary @ | Feset

Film strip view EXIF summary format string:
|@ex'rf@ | Reset

Enable thumbnail tooltips
Thumbnail tooltip format string:

|@fie@ | Reset

URL for viewing maps from images containing GPS data:

|I‘rtt|:|s -//maps.google com/maps Tq=@attudefs Decimal@.+(§-"|ong| )

Cancel

The EXIF summary displayed in the status bar at the bottom of the screen can be customized by
editing the status line format string. This format string uses the same tokens to specify the settings to
be displayed as the HTML generator (see HTML Generation). Pressing the "Reset" button will restore
the string to the system default which is:

"@year@/@month@/@day@ @time@, @lens@mm @ @focalLength@mm, @shutter@sec
fl@aperture@, Exp:@exposureMode@, 1ISO @iso@, AF:@focusMode@, WB:@whiteBalance@,
Flash:@flash@"

Please note that Windows can only display the first 128 characters in the status line.

The main view EXIF summary (displayed on the right hand side of the main view window when "Show
controls" is enabled) may be customized by editing the format string. The default value is
"@exifSummary@".

New lines can be entered using "\n" e.g. use the following format string to add separate lines with the
camera model name and IPTC copyright field to the EXIF summary:
"@model@\nCopyright: @IPTC_copyight@\n@exifSummary@"

The filmstrip view EXIF summary may be customized by editing the format string. The default value is
"@exif@"

Select "Enable thumbnail tooltips" to display a popup window showing shooting data when the mouse
hovers over thumbnails in the thumbnail and filmstrip views. The shooting data that is displayed may
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be customized by editing the format string. The default value is "@file@"
Use "\n" to break up the tooltip text into multiple lines

e.g. "@model@\n@shutter@sec, f/@aperture@\nISO @iso@\n@lens@mm @ @focalLength@mm”

The locations where images containing GPS data were taken can be displayed in a web browser by
right clicking on the image in BreezeBrowser Pro's main view and selecting "View map".

The URL used for viewing the map is user definable and defaults to Google maps:
http://maps.google.com/maps?q=@latitudeAsDecimal@,+@IlongitudeAsDecimal @

The following URL displays GPS location in Google Maps zoomed in to zoom level 15:
http://maps.google.com/maps?q=@latitudeAsDecimal@,+@longitudeAsDecimal@&z=15

The following URL can be used to link to Microsoft Live Search Maps zoomed in to level 14:
http://maps.live.com/default.aspx?cp=@IatitudeAsDecimal@~@longitudeAsDecimal @ &lvi=14&style=r

&v=2

The following URL can be used to link to Yahoo! Maps zoomed in to magnification 3:
http://maps.yahoo.com/index.php#lon=@IlongitudeAsDecimal@&lat=@latitudeAsDecimal@&mag=3

Click on the ">" button to select different preset map URLSs.

The "View map" menu option can be disabled by setting the URL to an empty string.

Other Map URLs

Topographic maps in the US can be displayed using the URL:

http://www.topozone.com/map.asp?lat=@IatitudeAsDecimal@&lon=@IlongitudeAsDecimal @ &datum=

NAD83&u=5&layer=DRG&size=1&s=24

© 2004 to 2023 Breeze Systems Ltd



Reference section 119

2.18.3 Image display

Preferences *

General Caption Image Display | Editor HTML Generation

Thumbnail display background color: | Gray w

Main view image cache: Slideshow cache:
Extra large thumbnail size: Magnifier size:

|Ise EXIF orentation for display and rotation of JPEGs
] lgnore embedded thumbnails in JPEGs

Highlight method: | Luminosity | Threshold:
RAW-=JPEG Settings... HQ Strength:

Color Management
[ ] Enable monitor color profile |se default manitar profile
Profile: |sRGE Color Space Profile
Dion' color manage thumbnails for faster thumbnail display
Read color space from shooting data f no profile is embedded
Enable default color profile for images with no embedded profile
Profile:

[ ] Enable printer color prafile
Profile:

Cancel

The background color used for the thumbnail display can be set to white, black or gray.

BreezeBrowser Pro caches the last few images displayed in main view and when running the
slideshow to speed up viewing. The cache size can be specified in the image display preferences
depending on how much memory (RAM) your PC has.

BreezeBrowser Pro can display three different sizes of thumbnails: small, large and extra large. Small
thumbnails are a maximum of 80x80 pixels and large thumbnails are 160x160 pixels. The size of extra
large thumbnails is user definable and can be set to any value between 200x200 pixels and
1000x1000 pixels. Larger thumbnail sizes are slower to generate and use more memory than smaller
sizes and should be avoided unless your system has plenty of RAM (e.g. 512Mb or more).

The size of the image magnifier window can be set to any value between 100 and 500 pixels.

BreezeBrowser Pro has two methods of rotating JPEG images both of which are lossless and don't
affect the image quality:

1) rearranging image data to rotate the image

2) editing the EXIF orientation variable stored in the shooting data

The first method is not as fast as the second method and can result in small strips of the image being
wrapped around if the image size is not an exact multiple of the JPEG tile size (this isn't a problem with
unedited images straight from a digital camera). The second method is very fast but not many
applications read this value resulting in the image being displayed in its original unrotated orientation.
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At the time of writing Windows Explorer, Internet Explorer, Photoshop, Photoshop Elements and Paint
Shop Pro all ignore the EXIF orientation.

Click on "Ignore embedded thumbnails in JPEGs" if you want BreezeBrowser Pro to generate
thumbnail images from the main JPEG image rather than the embedded thumbnail. This is slower than
using the embedded thumbnail but avoids problems when the thumbnail becomes out of sync with the
main image. One common example of this is when you edit a JPEG using Photoshop 6.0. Photoshop
takes a copy of the EXIF data of the JPEG and writes it back to the JPEG when it is saved. Normally
this is useful because the EXIF data is preserved, but because the EXIF data also includes the
embedded thumbnail this will show the original file and not the edited image.

Note: The "Regenerate JPEG thumbnails" function (under the "Tools" menu) can be used to update
the thumbnails if they have become out of sync with the main image data.

The "Highlight method" drop down list specifies how highlight values are calculated when displaying
flashing highlights in main view. Set this to "luminosity" to use the luminosity value from the image to
calculate the highlight values. Alternatively this can be set to "Max RGB" and the maximum value from
the red, green and blue channels will be used to calculate the highlight value. The threshold value sets
the threshold above which the highlight is shown blinking. A value of 250 is probably a good starting
point.

The "HQ Strength" setting specifies how much sharpening to apply to images viewed in main view in
HQ mode. The default setting is 75.

Click on the "RAW+JPEG settings..." button to specify how BreezeBrowser Pro should display raw and
JPEG files from Canon Nikon cameras. The following dialog will be displayed:

RAW+ JPEG Display Settings X

Link RaM+IPEG files 2o that they are handled az a pair. The
thumbnail iz displayed with a "Raw+IPEG" icon in the top left
hand corner and operations such az rename, copy, move and
delete are performed on bath the Ra file and the JPEG file.

Link RéMw+IPEG files
[Canon EQS-10, 105, 10 Mark: || and Mikon raw files anly]

Canon EOS-10/105 Settings
[ ] Corvert raw images when dizplaying in main views
Auto create JPEG when preview JPEG doesn't exist
(%) Create small preview JPEG [1232 » 824)
i) Create large preview JPEG [2464 » 1648

ok ] [ Cancel ]

Certain Canon and Nikon cameras can store RAW and JPEG images and these can be handled as a
pair in BreezeBrowser Pro by selecting "Link RAW+JPEG files". When this option is selected
operations such as image rename, copy, move, delete and IPTC editing will be applied to both the
RAW file and the JPEG file.

If you shoot in Raw + JPEG mode select "Link JPEG to EOS 1D/1Ds raw image when available" to
display the JPEG when available. When this option is selected rename, move, copy and delete
options are automatically performed on both the 1D raw file and the associated JPEG image.
Images are displayed much faster with this option than the first option provided the JPEG is
available.
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BreezeBrowser Pro can use color profiles to help display images with accurate colors. In order use
color profiles for display a suitable display monitor profile should be selected and enabled. Color
profiles are normally stored in C:\Windows\System32\spool\drivers\color. When the monitor profile is
enabled BreezeBrowser Pro will read color profiles embedded in JPEG and TIFF image files and
convert the colors for display on the monitor. You may also specify a default profile to be used for
images that don't contain a color profile.

If "Use default monitor profile" is selected BreezeBrowser Pro will use the default profile defined for
your monitor. Most color profiling systems will automatically set the default profile when calibrating your
system. The default profile can also be set by right clicking on the Windows desktop and selecting
Properties. Then click on the Settings tab and click on the Advanced button followed by the "Color
Management" tab.

Some cameras allow you to specify the colorspace they should use (e.g. the Canon EOS 10D, 1D and
1DS output in SRGB or Adobe RGB 1998 colorspaces). Unfortunately these cameras don't embed a
color profile in the image making it difficult to use color management to display images correctly.
BreezeBrowser Pro can read the colorspace information from the shooting data in Canon EOS 10D,
1D and 1DS images and then automatically use the SRGB or Adobe RGB 1998 color profile to display
the image. Select "Read color space from shooting data if no profile is embedded" to enable this
feature. Please note: this feature only works for images displayed in main view (applying it to thumbnail
images would be too slow).

You may also specify a color profile to use for printing and print preview.

Tip: Color management can slow down the display of images and can be quickly toggled on and off by
typing Shift+Ctrl+K. Please press F5 to refresh the displayed image to reflect the new settings.

2.18.4 Image editor

Use this to specify how BreezeBrowser Pro should edit images.
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Preferences .

General Caption Image Display Editor  HTML Generation

Primary Editor
() Use the Windows Explorer CUpen’ command
(®) sze the command line below:

|C:'-.F‘n:ugram Files\Adobe Adobe Photoshop 2021 '-.F'hntl:ushup.e|

Menu caption: |&Ed'rt Image |

Editor supports raw files
Allow editing of multiple files in thumbnail mode

Secondary Editor
Command line:
|C:'-.F‘n:ugram Files"\Affinity*PhotoPhoto exe |

Menu caption: |E|:|'rt Image - Affinity |

Editor supports raw files
Allow editing of multiple files in thumbnail mode

Mote: no entry will be added to the right click context menu if either
the command line or the menu caption is emphy.

Cancs

You may specify two different editors - the primary editor and the secondary editor. The primary editor
can be configured to use the Windows "Open" command or may be specified using the pathname of
the editor e.g. C:\Program Files\Adobe\Photoshop CS\Photoshop.exe. The secondary editor may only
be specified using a command line. Press on the "..." browse button on the right to select the editor.

The Windows "Open" command option will attempt to open the file using the application that Windows
has associated with the image's file extension. This will have the same effect as double-clicking on the
image in Windows Explorer.

Most image editors are unable to read raw files directly and so they need to be converted to another
format first e.g. TIFF or JPEG. If your editor does support the reading of raw files you can select
"Editor supports raw files". When this option is set and you select "Edit Image" for a raw file the file is
passed directly to your image editor. If it is not set the dialog below will be displayed asking whether
you wish to convert the raw file before editing or send a previously converted image to the editor.
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Edit Image X

Fleasze select the corwverted image to edit from the list below:

H:42004'2004-08-14\Converted\GREF5585¢.
H:%2004%2004-08-1 4 Converted\GREFS535.|pg

Or press the "Convert” button to carvvert the raw file again.

)4 ] [ Cancel

2.18.5 HTML

Preferences *

General Caption Image Display Editor HTML Generation

Template base directory:
|C:'&F‘mgram Files (x86)"\BreezeSys\Breeze BrowserPro“templates

Convert images with embedded color profiles to sRGEB
Conver filenames to lower case

[ ] Remember HTML output directany name

] Copy IPTC data to main JPES image

Home page: |hﬁps:ffwww.breezes'_.rs com |

EpreviE text: |F'I‘E="-f | Enext @ text: |NE?¢ |
Main Images Thumbnail Images
Prefix: | | Suffic:| std | Prefic: | | Suffix: |_thm |
Directory: | | Directory: | |
@owner@ Token

(®) Use owner name or author from EXIF data
() Use name speciied below

|CI'||'is Breeze |

Map key:|GFHG1H3124HNBLIX12NM213GSW.IKAA] |

Cancel

The default location for storing HTML templates is in the templates folder of the BreezeBrowser Pro
installation directory. If you plan to edit the existing templates or create your own you may prefer to
store the templates elsewhere so that they are easier to backup e.g. in "My Documents". To do this
either type in the new location for the templates or click on the "..." to use the folder browser to select
the location. Please note that no templates will be listed in the HTML dialog if the template base
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2.19

directory is set incorrectly.

Web browsers use sRGB color space for displaying images and this can give incorrect colors if you
use a different color space for your images (e.g. AdobeRGB). To avoid this problem select "Convert
images with embedded color profiles to SRGB" to instruct the HTML generator to convert images to
SRGB color space. This will only affect TIFF and JPEG images containing embedded color profiles.

The Windows filing system is case insensitive (e.g. the filenames "BreezeBrowser.htm" and
"breezebrowser.htm" represent the same file) and this can cause problems when publishing HTML
pages on the web which is case sensitive. This can be very frustrating when pages are displayed
correctly when tested locally but have broken links when uploaded to the web. To avoid this problem
select "Convert filenames to lower case" to get the HTML generator to use lower case filenames for
images and pages.

The default output directory for HTML pages is a directory called HTML created in the same directory
as the images. Sometimes it is convenient to use a different output directory and for BreezeBrowser
Pro to remember the location of this directory. Select "Remember HTML output directory name" to get
the HTML generator to use the same HTML directory each time. Please take care not to overwrite
existing HTML pages when using this option.

By default IPTC data is not copied to images created by the HTML generator. Select "Copy IPTC data
to main image" if you want IPTC data to be copied to the main image.

Use the home page edit box to specify the location of your home page. The HTML generator will
replace the @homeURL@ token in the templates with the value entered here.

The @next@ and @prev@ tokens in HTML templates generate hypertext links with the default text
"Next" and "Prev". Use the "@prev@ text" and "@next@ text" to replace this with text of your own
choosing.

The default behavior of the HTML generator is to create the HTML pages and images in the same
directory and use "_std" as a suffix for main images and "_thm" for thumbnails. A separate sub
directory can be specified for both main images and thumbnails. It is also possible to change the suffix
used for the main and thumbnail images. The suffix can be empty in which case the images will have
the same name as the original images. If the main and thumbnail image suffixes are the same (or both
empty) they must be stored in different directories.

Several of the HTML templates shipped with BreezeBrowser Pro use the @owner@ token for the
copyright text. @owner@ is used to extract the owner name from the EXIF data in Canon images and
the artist EXIF field in non-Canon images. You may override this by selecting "Use name specified
below" in the "@owner@ Token" section and entering the text to be used in the edit box.

Some online mapping systems (e.g. Google Maps) require a key to be entered in order to display web

pages containing maps. The key can be entered in the "Map key:" field and can be accessed in the
HTML templates using the token @mapKey@.

Summary of Keyboard Shortcuts

Main View

Ctrl+A Toggle the display of the histogram window

Ctrl+B View actual image (uses JPEG preview image for raw files)
Ctrl+Shift+B  Batch rename images

Ctrl+C Copy image to another folder

Ctrl+Shift+C Create shortcut in another folder

Ctrl+D Edit image using external image editor (primary editor)

Ctrl+Shift+D  Edit image using the secondary image editor
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Ctrl+E
Ctrl+Shift+F
Ctrli+G
Ctrl+H
Ctrl+Shift+H
Ctrl+Shift+l
Ctrl+Shift+K
Ctrl+Alt+K
Ctrl+L
Ctrl+M
Ctrl+Alt+M
Ctrl+O
Ctrl+P
Shift+Ctrl+P
Ctrl+Q
Ctrl+R
Ctrl+Shift+R
Ctrl+S
Ctrl+T
Ctrl+Vv
Ctrl+Shift+V

Ctrl+W
Ctrl+X
Ctrl+Shift+X

Ctrl+1
Ctrl+2
Ctrl+3
Ctrl+4
Ctrl+5
Ctrl+0

Del
Shift+Del

F1

F2

F5

Cursor Left
Cursor Right
Ctrl+Cursor
Left
Ctrl+Cursor
Right

Cursor Up
Cursor Down
Ctrl+Cursor
Up
Ctrl+Cursor
Down
Ctrl+TAB
Escape

Shift+Escape
Insert
PageUp
PageDown

Edit comments

Toggle focus point overlay display for images from Canon EOS cameras
Toggle image tag

Display the HTML dialog

Toggle flashing highlight display

Edit IPTC data

Edit keywords

Toggle color management on and off

Switch to large thumbnail display

Switch to thumbnail display (using current thumbnail size)

View map in web browser if current image contains GPS data
Open a directory

Print image

Print image (Same as Ctrl+P)

Toggle high quality mode

Rename image

Toggle the linking of raw+JPEG files

Display slideshow of all images

Switch to small thumbnail display

Move image to a new folder (always prompts for destination folder)
Move image to a new folder (only prompts for destination folder if not previously
specified)

Toggle between color and black and white display

Switch to extra large thumbnail display

Extract embedded JPEGs from Canon CRW raw files

Set image ranking to 1
Set image ranking to 2
Set image ranking to 3
Set image ranking to 4
Set image ranking to 5
Set image ranking to none

Delete image by sending to "Deleted" directory or Recycle bin
Delete image permanently

Display help

Rename image

Refresh directory

Previous image

Next image

Left Rotate image left (counter-clockwise)

Right Rotate image right (clockwise)

Tag image
Untag image
Zoom magnifier window (if displayed)

Unzoom magnifier window (if displayed)

Toggle between full window display and display with controls and image info
Switch to thumbnail view or filmstrip view depending on the double click settings in
preferences

Switch to filmstrip view

Toggle image tag

Previous image

Next image
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Mouse wheel next/previous image
Ctrl+Mouse Rotate image left/right

wheel

Thumbnail View

Ctrl+A
Ctrl+B
Ctrl+Shift+B
Ctrl+C
Ctrl+Shift+C
Ctrl+D
Ctrl+Shift+D
Ctrl+E
Ctrl+F
CtrlI+G
Ctrl+H

Ctrl+l
Ctrl+Shift+l
Ctrl+Shift+K
Ctrl+Alt+K
Ctrl+L

Ctrl+M
Ctrl+Alt+m
Ctrl+N
Ctrl+Shift+N
Ctrl+O
Ctrl+P
Ctrl+Shift+P
Ctrl+R
Ctrl+Shift+R
Ctrl+S
Ctrl+Shift+S
Ctrl+T

Ctrl+Shift+T
Ctrl+Shift+U
Ctrl+Vv

Ctrl+Shift+V

Ctrl+X
Ctrl+Shift+X

Ctrl+1
Ctrl+2
Ctrl+3
Ctrl+4
Ctrl+5
Ctrl+0

Ctrl+Alt+1
Ctrl+Alt+2
Ctrl+Alt+3
Ctrl+Alt+4
Ctrl+Alt+5

Select all

View actual image (uses JPEG preview image for raw files)

Batch rename images

Copy selected images to another folder

Create shortcut in another folder

Edit image using external image editor (primary editor)

Edit image using the secondary image editor

Edit comments

Select custom thumbnail order and move tagged images to the start
Toggle image tag for the focused image

Display HTML dialog

Invert selection

Edit IPTC data

Edit keywords

Toggle color management on and off

Switch to large thumbnail display (or return to main view if large thumbnails
already displayed)

Switch to main view

View map in web browser if current image contains GPS data
Select none

Untag all images

Open a directory

Print contact sheet of currently selected images

Print currently selected images full size

Rename the single image that has focus

Toggle the linking of raw+JPEG files

Display slideshow of currently selected images

Select tagged images

Switch to small thumbnail display (or return to main view if small thumbnails
already displayed)

Tag selected images

Untag selected images

Move selected images to a new folder (always prompts for destination folder)

Move selected images to a new folder (only prompts for destination folder if not

previously specified)

Switch to extra large thumbnail display (or return to main view if extra large
thumbnails already displayed)

Extract embedded JPEGs from Canon CRW raw files

Set image ranking to 1
Set image ranking to 2
Set image ranking to 3
Set image ranking to 3
Set image ranking to 5
Set image ranking to none

Add images ranked 1 to current selection
Add images ranked 2 to current selection
Add images ranked 3 to current selection
Add images ranked 4 to current selection
Add images ranked 5 to current selection
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Shift+Ctrl+1
Shift+Ctrl+2
Shift+Ctrl+3
Shift+Ctrl+4
Shift+Ctrl+5
Shift+Ctrl+6

Del
Shift+Del
F1

F2

F5

F6

F7
Escape

Shift+Escape
Mouse wheel
Ctrl+Cursor Left
Ctrl+Cursor Right
Ctrl+TAB

Filmstrip View

Sort images alphabetically
Sort images numerically
Sort images by file type
Sort images by timestamp
Sort images by ranking
Reverse sort order

Delete selected images by sending to "Deleted" directory or Recycle bin
Delete selected images permanently

Display help

Rename image or folder that has focus

Refresh directory

Only select tagged images (and unselect images that are not tagged)

Only tag selected images (and untag images that are not currently selected)
Switch to main view or filmstrip view depending on the double click settings in
preferences

Switch to filmstrip view

Scroll thumbnail display up and down

Rotate selected images left (counter-clockwise)

Rotate selected images right (clockwise)

Toggles directory tree display on and off

Most keyboard shortcuts are the same as for thumbnail view with the following exceptions:

Ctrl+TAB
Shift+Escape
Ctrl+Shift+F
Ctrl+Shift+H

Slideshow

Ctrl+B
Ctrl+F
Ctrl+G
Ctrl+M

Ctrl+P
Ctrl+Q
Ctrl+S
Ctrl+T
Ctrl+W
Ctrl+Z

SQUlhwWNE

Cursor Left
Cursor Right

Toggles the EXIF or directory tree display on and off

Switch between filmstrip + EXIF and filmstrip + folders views

Toggle focus point overlay display for images from Canon EOS cameras
Toggle flashing highlight display

View actual image (uses JPEG preview image for raw files)

Set slideshow interval to minimum

Toggle image tag

Toggle two-button mouse operation on and off. (Use Shift+right click to display
the slideshow menu when two-button mouse operation is enabled)
Play slideshow

Toggle high quality display mode

Stop slideshow

Toggle between normal view and "View tagged images only" view
Toggle between color and black and white display

Undo the last untag operation in "View tagged images only" view

Set image ranking to 1
Set image ranking to 2
Set image ranking to 3
Set image ranking to 4
Set image ranking to 5
Set image ranking to none

Pause slideshow and display previous image
Pause slideshow and display next image
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Shift+Cursor Left
Shift+Cursor Right
Ctrl+Cursor Left
Ctrl+Cursor Right
Cursor Up

Cursor Down
Ctrl+Cursor Up
Ctrl+Cursor Down
Shift+Cursor Up
Shift+Cursor Down
Mouse Wheel
Ctrl+Mouse Wheel
Ctrl+1

Ctrl+2

E:.trl+9
Ctrl+0
Escape

Pause slideshow and display previous image
Pause slideshow and display next image
Rotate image left (counter-clockwise)

Rotate image right (clockwise)

Tag image

Untag image

Increase image ranking

Decrease image ranking

Increase image ranking

Decrease image ranking

Pause slideshow and display next/previous image
Rotate image left/right

Set slideshow interval to 1 sec

Set slideshow interval to 2 sec

Set slideshow interval to 9 sec
Set slideshow interval to 10 sec
Exit slideshow

View Actual Image

F6

F7

F8/Number pad -
F9/Number pad +
Home

Escape or Enter

Fit image to window
View actual size
Zoom out

Zoom in

Center image

Close window

Image Comparison Window

Cursor left/right
Cursor up/down
Keypad -
KeyPad +
F7

F8

F9

Home
Ctrl+A
Ctrl+N
Ctrl+P
Ctrl+T
PageDown
PageUp
F1

F2

F3

F4

Ctrl+F1
Ctrl+F2
Ctrl+F3
Ctrl+F4
TAB

IPTC Editor

Pan the images horizontally

Pan the images vertically

Zoom out

Zoom in

Zoom to actual size

Zoom out

Zoom in

Center images

Arrange images so that held images are displayed first
Next image (when displaying more than 4 images)
Previous image (when displaying more than 4 images)

Tag held images (doesn't untag images which are not held)
Next page of images (when displaying more than 4 images)
Previous page of images (when displaying more than 4 images)
Tag/untag the first image

Tag/untag the second image

Tag/untag the third image

Tag/untag the fourth image

Hold/release first image

Hold/release second image

Hold/release third image

Hold/release fourth image

Toggle between side by side and one above the other display (when comparing two
images)
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Ctrl+[ Previous image
Ctrl+] Next image
PageUp Previous image
PageDown Next image

2.20 Release Notes

Changes in BreezeBrowser Pro v1.12.4.1, 13 April 2023
1. Fixed an issue with blank images when running proofs on Canon CR2 raw files

Changes in BreezeBrowser Pro v1.12.4, 24 March 2023

2. Added support for displaying video previews and thumbnails

3. Added support for the display of focus points from the Canon EOS R3, Canon EOS R6 Mark I,
Canon EOS R7, Canon EOS R8, Canon EOS R10 and Canon EOS R50

4. Fixed an issue displaying portrait orientation images when linking raw+JPEGs

Changes in BreezeBrowser Pro v1.12.3, 27 June 2022
1. Added support for viewing OM Systems OM1 raw files using the embedded JPEG preview image
2. Fixed an issue reading color temperature of kelvin white balance for the Canon EOS 5D MARK IV

Changes in BreezeBrowser Pro v1.12.2, 1 March 2022

1. Added support for displaying thumbnail images from Nikon Z9 raw files

2. Added support for displaying Canon EOS-1D X Mark Il focus points

3. Fixed an issue displaying images with filenames containing % characters in slideshows

Changes in BreezeBrowser Pro v1.12.1, 17 March 2021

1. Added support for HEIC images from iPhones, iPads and other mobile devices
2. Fixed an issue displaying thumbnails of Olympus E-M1X raw files

3. Removed references to raw conversion as it is no longer supported

Changes in BreezeBrowser Pro v1.12, 23 October 2020

1. Added support for the display of focus points from the Canon EOS R5 and Canon EOS R6

2. Fixed an issue with extracting the embedded JPEG preview images from some Canon CR3 raw
files

Changes in BreezeBrowser Pro v1.11, 4 June 2018

1. Added support for displaying full size previews from Nikon Z6 and Z7 raw files

2. Added focus point overlay display for Canon EOS R, Canon EOS RP, Canon EOS M50, Canon
EOS 250D/Rebel SL3

3. Improved display of Canon CR3 raw files: now shows higher resolution preview

Changes in BreezeBrowser Pro v1.10, 19 December 2018

1. Added support for the new Canon CR3 raw file format

2. Added support for Canon EOS R raw conversion and shooting data display

3. Added support for Canon EOS M50 raw conversion and shooting data display

4. Added support for Canon EOS 1500D/2000D/Rebel T7 and Canon EOS 3000D/4000D raw
conversion, shooting data and focus point overlay display

Changes in BreezeBrowser Pro v1.9.8.11, 11 December 2017

1. Added support for Canon EOS 6D Mark Il raw conversion, shooting data and focus point overlay
display

2. Performance enhancements reading shooting data from some Canon DSLR models

3. Fixed a problem displaying focus points from some Canon cameras that affected v1.9.8.10
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4. Fixed a problem printing photos that caused v1.9.8.10 to crash

Changes in BreezeBrowser Pro v1.9.8.10, 21 August 2017

1. Added support for Canon EOS 77D, Canon EOS 200D/Rebel SL2 and Canon EOS 800D/Rebel T7i
raw conversion, shooting data and focus point overlay display

2. Added optional scaling of the toolbar when running on high DPI displays (available using BBUTil)

3. Fixed a problem viewing raw files from Olympus Tough TG-5

4. Removed menu items for interacting with Google Earth because the Google Earth API service is no
longer available

Changes in BreezeBrowser Pro v1.9.8.9, 10 January 2017

1. Added support for Canon EOS 5D Mark IV raw conversion, shooting data and focus point overlay
display

2. Fixed a problem viewing large JPEG previews from Olympus OM-D E-M1 Mark Il raw files

3. Added support for viewing animated GIFs to BreezeViewer slideshow utility

4. Fixed a problem installing BreezeBrowser Pro on computers with large hard drives

Changes in BreezeBrowser Pro v1.9.8.8, 25 July 2016

1. Added support for Canon EOS 1300D/Rebel T6 and Canon EOS 80D raw conversion, shooting data
and focus point overlay display

. Added support for Canon EOS-1D X Mark Il raw conversion and focus point overlay display

. Added upscaling option to Breeze Viewer

. Uses the latest Canon raw conversion libraries and color profiles for high quality raw conversion of
Canon EOS raw files

5. Fixed a raw conversion performance issue in folders containing large numbers of raw files

AOWN

Changes in BreezeBrowser Pro v1.9.8.7, 30 October 2015
1. Added support for Canon EOS 750D/Rebel T6i, Canon EOS 760D/Rebel T6s, Canon EOS 5DS and

Canon EOS 5DS R raw conversion, shooting data and focus point overlay display

2. Added support for Nikon D5500 and Nikon D7200 focus point overlay display

3. Added "High DPI aware" option in preferences to allow the use of the full screen resolution on high
DPI computer displays

4. Breeze Viewer now accepts tokens for the date when specifying the folder to monitor

5. Added "Mosaic with zoom + bg fade" slideshow transition to Breeze Viewer

Changes in BreezeBrowser Pro v1.9.8.6, 27 November 2014

1. Added support for Canon EOS 7D Mark Il raw conversion, shooting data and focus point overlay
display

2. Added support for Nikon D750 focus point overlay display

3. Added the option to specify an additional raw file sidecar file type to be included when copying,
moving, renaming and deleting raw files

4. Added the option to leave a space between images when using the mosaic layout option in Breeze
Viewer

Changes in BreezeBrowser Pro v1.9.8.5, 8 August 2014

1. Added support for Canon EOS 1200D raw conversion, shooting data and focus point overlay display

2. Added support for Nikon D4s, Nikon D810, Nikon D610 and Nikon D5300 focus point overlay
display

3. Added captions in the mosaic transitions to BreezeViewer slideshow utility

4. Added separately configurable title page/advert duration to BreezeViewer slideshow utility

Changes in BreezeBrowser Pro v1.9.8.4, 24 September 2013
1. Added support for Canon EOS 70D raw conversion, shooting data and focus point overlay display
2. Added the option to scan subfolders for images to BreezeViewer slideshow utility
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Changes in BreezeBrowser Pro v1.9.8.3, 5 June 2013
1. Added support for Canon EOS 700D/Rebel T5i raw conversion, shooting data and focus point

overlay display

2. Added support for Canon EOS 100D/Rebel SL1 raw conversion, shooting data and focus point
overlay display

3. Added support for Nikon D7100 focus point overlay display

4. Added support for Nikon D5200 focus point overlay display

5. Added "mosaic", "mosaic with fade" and "mosaic with dissolve" slideshow transitions to
BreezeViewer slideshow utility

6. "None" and "mosaic" slideshow transitions in BreezeViewer optimized to run faster on graphics
cards without graphics acceleration

7. Improved support for writing accented characters with ASCII codes in the range 128 to 255 to XMP
data

Changes in BreezeBrowser Pro v1.9.8.2, 15 January 2013
1. Added support for Canon EOS 6D raw conversion, shooting data and focus point overlay display

2. Added support for Canon EOS M raw conversion

3. Added the ability to specify the caption text, font, color and placement in the BreezeViewer
slideshow utility

4. Fixed a problem with the zoom settings in the compare images window

5. Fixed a problem with long delays when loading JPEG images from Nikon cameras when show focus
points is selected and the EXIF MakerNote data is corrupted.

Changes in BreezeBrowser Pro v1.9.8.1, 6 November 2012

1. Added support for Canon EOS-1D X raw conversion, shooting data and focus point overlay display

2. Added support for Canon EOS M shooting data display (raw conversion will be added in the next
release)

3. Proofs now uses embedded JPEG preview image when processing Nikon NEF raw files from
cameras for which raw conversion is not supported

Changes in BreezeBrowser Pro v1.9.8, 19 July 2012
1. Added support for EXIF 2.3 tags (OwnerName, SerialNumber, LensModel)
2. Added support for Canon EOS 5D Mark Il raw conversion, focus point display and shooting data
3. Added support for Canon EOS 650D/Rebel T4i raw conversion, focus point display and shooting
data
4. Added support for Nikon D4, Nikon D800 and Nikon D800E focus point display
5. Fixed problems caused by some MTS video files
6. Improved performance when displaying JPEG images

Changes in BreezeBrowser Pro v1.9.7.1, 26 January 2012
1. Added optional title or ad images when running slideshows using BreezeViewer
2. Fixed a problem creating proofs from Canon PowerShot G12 raw images
3. Fixed problems with "Print to file..." intermittently generating pages with a blue background and no
images
4. Added support for displaying Phase One raw files with IIQ file extensions
5. Added optional checkboxes when using the touchscreen keyboard option in kiosk mode

Changes in BreezeBrowser Pro v1.9.7, 25 May 2011

1. Added support for Canon EOS 600D/Rebel T3i and Canon EOS 1100D/Rebel T3 raw conversion,
shooting data and focus point overlay display

2. Added new "kiosk mode" to allow users to select photos for printing or emailing using a touchscreen
monitor

Changes in BreezeBrowser Pro v1.9.6.1, 12 January 2011
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1. Added focus point overlay display for Nikon D7000 images

2. Added the ability to write Adobe labels and to edit the label names associated with the label color
display in thumbnail view

3. Fixed problems with Canon PowerShot G11 raw conversion not working and incorrect colors for
Canon PowerShot S90 and Canon PowerShot S95 raw conversion

4. Added automatic fallback for fade and dissolve slideshow transitions for graphics cards which are
too slow for the method used in BreezeBrowser Pro v1.9.6

Changes in BreezeBrowser Pro v1.9.6, 6 December 2010

1. Added support for Canon EOS 60D raw conversion, shooting data and focus point overlay display

2. Added support for Nikon D7000, Nikon D3100, Sony Alpha A55, Sony DSLR-A580, Olympus E-5,
Canon PowerShot G12 and Canon PowerShot S95 raw conversion

3. Now supports video files with MP4 file extension including the display of thumbnails if a THM
thumbnail file is available

4. Now supports the display of MPO files (commonly used for 3D images)

5. Fixed a problem reading EXIF GPS data written by Photoshop CS5

6. Added "move selected images to start" (keyboard shortcut: Alt+Ctrl+F) and "only select tagged
within selection” (keyboard shortcut: Ctrl+F6) options in thumbnail and filmstrip views

7. Added fade and dissolve transitions to BreezeBrowser Pro's built in slideshow and fade, dissolve,
cube, flip, vertical slide, diagonal slide and horizontal slide transitions to BreezeViewer. Also added a
black and white display option to BreezeViewer.

8. Added an option to display Adobe ratings and label data graphically in BreezeBrowser Pro's
thumbnail view and to automatically update the Adobe rating when changing image rankings

Changes in BreezeBrowser Pro v1.9.5.4, 5 July 2010
1. Added the following tokens for modifying tokens and strings: {upper,str}, {lower,str}, {capitalize,str}.

Also improved the handling of these tokens to allow them to be nested.

2. Improved the way images are displayed in random order using BreezeBrowser Pro's slideshow so
that it works like shuffling a deck of cards and dealing each card in turn.

3. Updated the handling of XMP data to fix compatibility problems with Photoshop caused by
namespace changes from xap to xmp

4. Added an option to select whether images are auto rotated when displayed using BreezeViewer

Changes in BreezeBrowser Pro v1.9.5.3, 4 June 2010

1. Now adds GPS data to JPEG file as well as the raw file when geo- codlng raw+JPEG files

. Added support for Sony DSLR-A550 and Sony DSLR-A850 raw conversion

. Added support for displaying Samsung SRW raw files

. Now converts both DNG and PEF raw files from supported Pentax cameras

. Improved hiding of the mouse cursor when displaying slideshows in BreezeBrowser Pro and Breeze
Viewer. New images added to the folder are displayed next when running a slideshow with random
order selected.

6. Updated the handling for ratings, copyright and labels in XMP data in line with Adobe's latest

standards.

GO WNBEF

Changes in BreezeBrowser Pro v1.9.5.2, 20 April 2010

1. Added support for Canon EOS 550D/Rebel T2i raw conversion, shooting data and focus point
overlay display

2. Added an option to sort images by color profile name/colorspace to View->Image order->Sort by
shooting data...

3. Added the ability to extract embedded JPEGs from Panasonic RW2 raw files

Changes in BreezeBrowser Pro v1.9.5.1, 1 March 2010

1. Added raw conversion support for Canon PowerShot S90 and Panasonic DMC-GF1

2. Improved the quality of Canon PowerShot G11 raw conversion

3. Fixed a problem in BreezeBrowser Pro v1.9.5 when copying EXIF data to JPEGs which affected
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EXIF copy and the extract embedded JPEG option
4. Various bug fixes and improvements to folder monitoring

Changes in BreezeBrowser Pro v1.9.5, 18 February 2010
1. Added raw conversion support for the following camera models:
Nikon D3000, Nikon D5000, Nikon D300s, Nikon D3X, Nikon D3s,
Canon EOS-1D Mark IV, Canon PowerShot SX1 IS, Canon PowerShot G11,
Panasonic DMC-FZ38, Panasonic DMC-G1, Panasonic DMC-GH1,
Sony DSLR-A330,
Pentax K-7,
Olympus E-450, Olympus E-620
2. Now monitors the current folder for new, deleted or modified files and updates the main view,
thumbnail display and slideshow accordingly
3. Fixed a problem where indexing software on some computers could cause BreezeBrowser Pro to
crash when proofing images to JPEG
4. Now reads color temperature from the shooting data of recent Canon EOS cameras when using
Kelvin white balance

Changes in BreezeBrowser Pro v1.9.4.3, 8 January 2010

1. Installer now includes Microsoft Visual C++ 2005 redistributable libraries to prevent "application
configuration incorrect”" and "side by side configuration is incorrect" errors on some computers

2. Fixed a problem converting raw files from older Canon PowerShot cameras (G1, G2, G3, G5,
Pro90l1s, S30, S40, S45, S50) on Windows Vista and Windows 7

Changes in BreezeBrowser Pro v1.9.4.2, 7 January 2010

1. Added support for Canon EOS 7D raw conversion, shooting data and focus point overlay display

2. Add workaround for problems caused by Comodo Firewall when running on Windows Vista SP2

3. Fixed a problem displaying thumbnails for Nikon Coolpix P6000 raw files

4. BreezeViewer now displays 8-bit monochrome JPEGs correctly

5. Google Earth display now zooms to 400m if camera altitude is greater than 500Km (e.g when GE
starts up)

Changes in BreezeBrowser Pro v1.9.4.1, 6 July 2009
1. Added support for Pentax K200D raw conversion

2. Fixed a problem converting Canon Rebel T1i raw files

3. Added an option to rename output files when raw converting

Changes in BreezeBrowser Pro v1.9.4, 21 May 2009

1. Thumbnails now have optional shooting data display and GPS icon

2. Added support for Canon EOS 500D/Rebel T1i raw conversion

3. Added support for Panasonic DMC-FZ28 raw conversion

4. Now displays lens AF micro adjustment information for images from recent Canon EOS cameras

Changes in BreezeBrowser Pro v1.9.3, 20 February 2009

1. Added "Breeze Viewer" standalone utility for monitoring the contents of a folder and displaying
JPEG images as a slideshow

2. Added support for Sony DSLR-A350 raw conversion

3. Canon raw conversion libraries updated to fix problems converting Canon CR2 raw files containing
IPTC IIM data

4. More robust handling of damaged EXIF shooting data

Changes in BreezeBrowser Pro v1.9.2, 22 December 2008
1. Added support for Canon EOS 50D, Canon EOS 5D Mark Il, Canon PowerShot G10 and
Panasonic DMC-LX3 raw conversion
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Changes in BreezeBrowser Pro v1.9.1, 26 November 2008

1. Added Canon EOS 50D and Canon EOS 5D Mark Il shooting data and focus point overlay display
2. Added support for Sony DSLR-A700, Nikon D90 and Olympus E-520 raw conversion

3. Added support for viewing Nikon Coolpix P6000, Panasonic DMC-LX3 and Leica Digilux 4 raw
files using the embedded JPEG preview image

Adjusted settings to fix problems on some PCs running Windows Vista

Now supports adding of GPS data to JPEG images which don't already contain shooting data
Added an option to crop the image to fit the printable area when printing full size images

Added image sort by latitude or longitude options to View->Image order->Sort by shooting data...

No oA

Changes in BreezeBrowser Pro v1.9, 2 October 2008
. Added Nikon D700, Nikon D60 and Canon EOS 1000D/Rebel XS support: raw conversion,

shooting data display and focus point overlay

2. Added geo-tagging of images using GPS track logs or manually using Google Earth

3. Added auto display of image locations in Google Earth while browsing images

4. Added "Copy Actual Images to Folder..." right click option in thumbnail view to allow the actual
images to be copied rather than shortcuts when the selection contains one or more shortcuts

5. Magnifier window now supports 1x, 2x, 3x and 4x zoom (use Ctrl+cursor up/Ctrl+cursor down to
zoom in and out)

6. Added the following new tokens for extracting parts of strings: {left,n,str}, {mid,n,m,str},
{right,n,str}, {first,str}, {last,str}

7. Added image sort by file created or file modified date options to View->Image order->Sort by
shooting data...

8. Raw conversion window can now be resized to allow larger previews

Changes in BreezeBrowser Pro v1.8.1, 26 June 2008

1. Added "Allow partial file name matches" option to EXIF copy

2. Improved the reading of unusually formatted XMP data

3. Fixed a problem when running on a system with Network Magic installed when not connected to
the internet

4. Fixed a problem with proofs and "view actual image" with Canon PowerShot G9 raw files

Changes in BreezeBrowser Pro v1.8, 7 May 2008

1. Added Nikon D3, Nikon D300, Canon PowerShot G9, Canon EOS 450D/Rebel XSi, Olympus E-3,
Sony Alpha DSLR-A700, Pentax K10D and Pentax K20D raw conversion

2. Added PicLens HTML template (see http://www.piclens.com for details on PicLens).

3. Improved shooting data display for Nikon DSLR cameras including focus point overlay for D3,
D300, D200, D2X, D2Xs, D2H, D2Hs and D80

4. Tags can now be imported by dragging a .txt file containing a list of image filenames and dropping
it on to the BreezeBrowser Pro window

Changes in BreezeBrowser Pro v1.7.3.1, 1 February 2008
Added %![n-m] batch renaming options to match all except the specified characters in the original
filename

2. Now displays thumbnails for compressed raw files as well as uncompressed raw files from the
Sony Alpha DSLR-A700

3. More robust handling of badly formatted EXIF data in JPEG images e.g. Nikon images with mixed
Il and MM alignment

4. Fixed a problem reading Canon EOS-1D Mark Il and Canon EOS-1Ds Mark Il focus point data
and custom functions from DNG files converted from CR2 raw files

5. Removed debug code which was writing BreezeBrowserPro.log files in version 1.7.3

Changes in BreezeBrowser Pro v1.7.3, 11 January 2008
1. Added the ability to print multiple full size images from thumbnail and filmstrip views
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Added support for Canon EOS-1Ds Mark Il raw conversion

Now displays full size images using the embedded JPEGs for Nikon D3, Nikon D300, Olympus
E-3 and Sony Alpha DSLR-A700 raw files

4. Faster display of raw files from recent Nikon DSLR cameras

5. Added an option to rename output files when running proofs

6. Fixed a problem copying maximum size EXIF data blocks to JPEGs

7. Fixed a problem when clicking white balance when converting Canon EOS 40D sRAW files

8

9.

1

w

Fixed a performance problem reading information from some color profiles embedded in images
Fixed a problem browsing network shares via "My Network Places" on Windows XP
0. Fixed a problem updating XMP data in .XMP sidecar files written by Lightroom

Changes in BreezeBrowser Pro v1.7.2, 7 September 2007

1. Now supports Canon EOS 40D raw conversion

2. Added 9 preset keyword shortcuts to allow common keywords to be added to images by pressing
Alt+1 through Alt+9

Changes in BreezeBrowser Pro v1.7.1, 21 July 2007

Now displays detailed shooting data and focus point information for the Canon EOS-1D Mark Il
Added word wrapping of captions when printing contact sheets

Added logarithmic scale option for histogram display

Added workarounds to prevent interoperability problems with Adobe Photoshop CS3

Added support for displaying Mamiya ZD raw files

agrwdE

Changes in BreezeBrowser Pro v1.7, 21 June 2007
. Added support for images containing GPS location data:

- New "GPS" HTML template for generating online galleries with standard thumbnail display and
map with thumbnail display.
- New "View map" right click menu option in main view to display a map in a web browser showing
the location where images containing GPS data were taken. The URL used to display the map is
definable in Caption preferences.

2. Added new GPS latitude and longitude tokens (@latitudeAsDecimal@ and
@longitudeAsDecimal @) to facilitate the linking of web galleries to online maps.

3. Added Canon EOS-1D Mark Il raw conversion

4. Added Nikon D40 and D40X raw conversion

5. Keyword editor now supports keyword synonyms

6. Improved the layout of thumbnails when printing contact sheets

7

8

9

Added option to select read-only (e.g. protected in camera) images
Added a "Jump to Source Folder" right click menu option when viewing shortcuts to images
. Added raw+JPEG linking of Pentax PEF raw files
10. Fully supports Windows Vista (including data execution prevention)
11. HTML generator now suppresses thumbnail image generation if thumbnail size is set to 0
12. HTML window now displays a short description of the template which can be defined in the
config.dat file
13. Added option to add IPTC/XMP or EXIF and IPTC/XMP data to JPEGs when emailing
14. Changes to XMP metadata handling to avoid XMP structs being written incorrectly
15. Fixed a problem color managing images referenced using shortcuts

Changes in BreezeBrowser Pro v1.6.3, 22 December 2006

1. Added linking of DNG + JPEG files

2. Now reads detailed shooting data from Canon and Nikon raw files that have been converted to
DNG using Adobe's DNG converter

3. Fixed a number of crashes caused by corrupted or invalid shooting data in JPEG images

4. Fixed a crash when viewing NEF files that have been updated by Nikon Capture NX

5. Fixed LP5 error at startup on some systems
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Changes in BreezeBrowser Pro v1.6.2, 30 October 2006
1. Fixed batch rename error when some, but not all images are selected in a folder
2. Now detects grayscale images and outputs them as 8-bit TIFFs when using proofs

Changes in BreezeBrowser Pro v1.6.1, 17 October 2006
Added Nikon D2Xs and D80 raw conversion

2. Canon EOS 400D/Rebel XTi/Kiss Digital X raw conversion no longer requires Canon
ZoomBrowser EX 5.7 to be installed

3. Improved loading of multiple images into editors such as Adobe Photoshop CS2

4. Added options to copy Adobe ratings to and from BreezeBrowser Pro rankings

5. Tooltips in thumbnail view now support multiple lines

Changes in BreezeBrowser Pro v1.6, 15 September 2006

1. Added support for Canon EOS 400D/Rebel XTi/Kiss Digital X raw conversion (requires Canon
ZoomBrowser EX 5.7 or later)

2. Added full support for Canon EOS 400D/Rebel XTi/Kiss Digital X shooting data and focus point
overlay display

Changes in BreezeBrowser Pro v1.5.2.3, 1 September 2006

1. Added initial support for displaying Canon EOS 400D/Rebel XTi/Kiss Digital X shooting data and
focus point overlay

Enhanced the keyword editor to allow keywords to be deleted from batches of images

Added "Advance on ranking" option in slideshow for fast ranking of images

Added tabs for shooting data and IPTC data display to the image properties window

Fixed a problem with smart noise reduction when applied to 8-bit images in proofs

Fixed a problem using PNG images with alpha channels for watermarks when the PNG is larger
than the image

Fixed a problem writing legacy IPTC IIM data to Canon CR2 raw files
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Changes in BreezeBrowser Pro v1.5.2.2, 3 August 2006
Fixed a problem writing IPTC/XMP data to TIFF files which already contain IPTC IIM data but
don't contain XMP data

2. Fixed a problem converting Canon EOS 1D Mark II N, 5D and 30D raw files using user defined
picture styles

3. Recursive HTML generation now includes shortcuts to images when processing subfolders

Changes in BreezeBrowser Pro v1.5.2.1, 2 August 2006
1. Fixed a problem in BBPro v1.5.2 which could cause it to crash when writing TIFF or JPEG 2000
files

Changes in BreezeBrowser Pro v1.5.2, 1 August 2006

1. Added legacy IPTC IIM tab to IPTC/XMP editor to allow editing of legacy IPTC IIM fields which
have no XMP equivalents

2. Added @EV@ and @EV1@ tokens which return the exposure value calculated from the picture's
Av, Tv and ISO values

3. Added @IPTC@ token which returns a summary of IPTC/XMP data

4. Added @AdobeRating@ and @AdobelLabel@ tokens which return the Adobe Bridge image rating
and label respectively as read from the XMP data in the image

5. Improved the display of tokens in the "Show tokens" window and added the ability to copy values
to the Windows clipboard

6. Fixed a possible problem in proofs and raw conversion when writing XMP data and legacy IPTC
IIM data to JPEGs

Changes in BreezeBrowser Pro v1.5.1, 18 July 2006
1. Added new |IPTC subject code and scene editor which uses XML NewsCodes topicsets defined by

© 2004 to 2023 Breeze Systems Ltd



Reference section 137

the IPTC

2. Copy EXIF data now copies IPTC/XMP data as well as shooting data

3. Legacy IPTC IIM data now stored in Canon CR2 raw files and optionally in Nikon NEF raw files

4. Contact sheet printing now uses main image data from TIFFs for improved quality if thumbnail
data is too small

5. Fixed a problem reading UTF-8 international characters from XMP data

6. Fixed a problem displaying raw+JPEG images from Canon EOS-1D and 1Ds cameras (original
models, not the Mark Il models).

7. Fixed a rounding error when resizing images in proofs which could result in the size being one
pixel too small

Changes in BreezeBrowser Pro v1.5, 30 June 2006

1. Added support for reading and writing Adobe XMP data for raw files (using XMP sidecar files) and
JPEG, TIFF, DNG, PNG, PSD and JPEG2000 image formats

Added picture frame from image option to proofs and slideshow

Added Adobe Photoshop PSD 8-bit and 16-bit file output options to proofs and raw conversion
Added new keyword editor

Updated lens distortion correction to use the new PTLens.dat definition file (Note: requires
purchase of a license from epaperpress.com to use lens distortion correction with some newer
cameras and lenses)

Improved color for Nikon D200 raw conversion

Fixed problems converting non-Canon raw files to JPEG

Fixed problem with passing multiple files to image editors

No longer requires Canon ZoomBrowser for Canon EOS 30D raw conversion

10. Improved storage of shooting data when converting Canon EOS 30D raw files

11. Slideshow now hides the mouse cursor automatically if it is not moved
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Changes in BreezeBrowser Pro v1.4.2, 23 March 2006

1. Added support for Canon EOS 30D raw conversion (requires Canon ZoomBrowser EX 5.6 or later)
2. Improved the quality of color managed printed output

3. Fixed problems displaying PSD and NEF thumbnails

Changes in BreezeBrowser Pro v1.4.1, 10th February 2006
1. Minor update to fix a problem with dragging and dropping images to change the thumbnail display
order and to fix problems displaying the embedded JPEGs from raw files from some cameras.

Changes in BreezeBrowser Pro v1.4, 8th February 2006
1. Added slideshow transitions

2. Added support for the Nikon D200

3. Improved reading of shooting data from Nikon digital SLR cameras including the number of shots
taken (shutter activation count)

4. Fixed a problem where color profiles embedded incorrectly in JPEGs by some apps cause BBPro to
crash

5. Fixed a problem reading large profiles from PSD files which could cause BBPro to crash

6. Batch rename dialog is now resizeable

7. Rewritten interface to the PolylmagePro.dll library to avoid problems with other (badly written) apps
preventing BBPro from being installed and run

8. Added new PTLens profiles for lens distortion correction

9. The size of the file dropdown list in main view can be adjusted using the BBUIil utility

Changes in BreezeBrowser Pro v1.3.2, 14th November 2005

1. Fixed problem with lens distortion correction in locales which use comma for the decimal point
2. Corrected Canon EOS 5D custom function display

3. Fixed a problem with color managed raw previews

4. Fixed error using proofs on non-Canon raw files

5. Fixed a crash with empty PNG files
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6. Fixed problem with Canon raw conversion sharpening defaulting to "High2" after converting with it
set to "No sharpening”. Also fixed a problem with Canon EOS 5D and Canon EOS-1D Mark II N raw
conversion saturation settings.

Changes in BreezeBrowser Pro v1.3, 14th October 2005

1. Added lens distortion correction option in proofs and raw conversion

2. Improved_IPTC keyword selection using controlled vocabularies

3. Added Canon EOS 5D and Canon EOS-1D Mark Il N raw conversion

4. Improved support for Windows shortcuts

5. New tooltip display showing shooting data when the mouse pointer hovers over thumbnails

Changes in BreezeBrowser Pro v1.2.2, 3rd August 2005
Fixed problem displaying large images with the magnifier on Windows 98 and Windows ME
2. Proofs now converts Canon EOS 350D/Digital Rebel raw files instead of using the embedded
JPEG
3. Minor changes to the reading of EXIF shooting data

Changes in BreezeBrowser Pro v1.2.1, 9th July 2005

1. Minor update to fix problems reading shooting data from Canon CRW raw files which don't have
an associated THM file. This also had the effect of preventing the raw files from being converted
and rotated.

Changes in BreezeBrowser Pro v1.2, 7th July 2005

1. Cropplng added to raw conversion

2. New image magnifier added

3. Improved raw conversion for non-Canon images (Nikon, Olympus, Fuji, Pentax and Konica
Minolta)

4. Added image crop size option to grid overlay display

5. Added custom sort using image shooting data

6. Added HTML tokens to access image sizes defined in the HTML generation dialog

7. Now displays larger preview image when displaying Nikon D2Hs raw files

8. Improved handling of shortcuts: better support for relative links; "Ignore file extensions" option
when loading and merging tags and rankings now ignores the .Ink file extension

9. Fixed the problem where updating to Canon's ZoomBrowser EX 5.2 breaks BBPro's EOS

350D/Rebel XT raw conversion

10. Reads IPTC data from the XMP section of JPEG files if it isn't present in the IIM section (e.g. from
JPEGs written by Photoshop CS2)

11. Fixed a problem which caused BBPro to run very slowly when reading shooting data from some
JPEG files

Changes in BreezeBrowser Pro v1.1.3, 20th April 2005
Added B&W filter effect settings for Canon EOS 20D and 350D/Rebel XT raw conversion

2. Added "Hold" option in image comparison window

3. Ranking information can optionally be stored in the IPTC urgency field of images that support
IPTC data

4. Shortcuts to images can now be used when generating web pages

5. Fixed a problem saving ranking and tagged image values in BBPro v1.1.1

6. Fixed @ranking@ token when used in HTML pages

Changes in BreezeBrowser Pro v1.1.1, 24th March 2005
Fixed bug in BBPro v1.1 where only partial IPTC data was read from JPEG images

2. Added menu items and keyboard shortcuts for adding ranked images to a selection in thumbnail
and filmstrip views

3. Added tokens @numRanked1@ to @numRanked5@ to allow the number of images of a
particular ranking to be displayed
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1.
2.
3
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10.

11.

Added Shift+Cursor up/down keyboard shortcut in slideshow to increase/decrease an image's
ranking

Fixed image sizing problem when viewing Fuji FinePix S2Pro raw files in main and filmstrip views
Fixed problem where the file open dialog was not displayed on Windows 98

Fixed problem displaying images from Nikon DSLRs when hue adjustment is set

hanges in BreezeBrowser Pro v1.1, 17th March 2005

Added Image Ranking
Added Shortcuts/links to files

Added Canon EOS 350D/Digital Rebel XT raw conversion

Added ability to add a list of keywords separated by , or ; characters in IPTC editor

Now displays the larger preview JPEG image stored in DNG files created by Adobe's DNG
converter v2.4

Added option to use the default color profile for the monitor in color management

Added option to specify a secondary editor for editing images

Added workaround for invalid JPEG images from some apps which caused BBPro to hang
Added ability to specify the amount of sharpening when using the custom settings in the email
images dialog

Fixed a problem reading shooting data from images saved by Photoshop Elements 3 which could
cause BBPro to crash

Fixed problem with custom white balance when converting non-Canon raw files

Changes in BreezeBrowser Pro v1.0.2, 21st January 2005
Minor update which fixes the following problems:

ocoukrwpbpE

Converting Canon raw files with UNC pathnames (e.g. \CYCLONE\Photos\CRW_1234.CRW)
Corrected rotation of JPEGs rotated using EXIF orientation when using proofs

Fixed problem where new tags were lost if Downloader Pro refreshed the folder

Corrected histogram display when PC's display is set to 16-bit color

Fixed the reading of comments from Canon PowerShot raw files

Installer now adds an entry to the Start menu

New in this release:
1

pwn

Includes sample color profiles for Canon EOS 20D and Canon EOS-1D Mark Il kindly supplied by
AboutDigicam.com

Now displays Leica Digilux 2 and Panasonic DMC-LC1 raw files

New @numTagged@ token added

No longer requires Canon's Zoombrowser EX software to be installed in order to convert Canon
PowerShot G6 and S70 raw files

Changes in BreezeBrowser Pro v1.0.1, 22nd December 2004

=

2.
3.
4
5.
6.
7.

8.
9

10.
11.
12.
13.

Support for viewing Kodak PhotoCD images added

Now displays Epson R-D1 raw files (thumbnails only)

Improved caching of images in main and filmstrip views when color management is enabled
New "Show Tokens" window added to display the values of the HTML tokens for the selected
image

Option to regenerate thumbnails for 16-bit TIFF files added to repair black thumbnails written by
some third party raw converters

Now supports Canon PowerShot G6 and S70 raw conversion without requiring Canon's
ZoomBrowser software

Linear raw conversion now available when running proofs on Canon CR2 raw files

Spacing and color of the grid overlay is now user definable

Fixed screen flicker when flashing highlights is selected

Ctrl+left/right cursor now rotates images in main and filmstrip views

Fixed possible crash when selecting next image in image comparison window

Fixed a problem sharpening images when using "Fast mode" in the HTML generator

Fixed problem where the red and blue channels were swapped when copying EXIF data to TIFF
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